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Introduction
3 Introduction

This section introduces the Micus Alarm And Control System (MACS) and its compo-
nents and briefly describes their major functions. The following sections address these
topics in much greater detail.

The remaining part of this document is structured as follows:

• Section 4: Overview presents the MACS system and describes its architecture, key
components and features.

• Section 5: Getting Started introduces some basic concepts on how to use the
MACS system.

• Section 6: Commands describes each available command in detail.

• Section 7: Configuration explains the MACS configuration process.

• Section 8: Creating Custom Screens shows how to use the optional MACS Display
Editor to create your own custom monitor and control windows.

3.1 What is MACS?

Micus Alarm And Control System (MACS) is a computer based system which
configures, controls and monitors various pieces of equipment, and collects and
processes alarms generated by the equipment. The system is used to monitor and
control communications equipment, the building security and building environment.
The equipment supported by the system ranges from telephone switches, satellite
transmitters, receivers, modulators, demodulators, waveguides, electrical power
monitoring, to environment and security sensors.

The equipment operational status and controls are presented using user-definable
graphical images, such as geographical maps, building layouts, equipment diagrams,
and equipment front panels. In addition, all changes in the equipment status are
reported in textual form and saved in the event log files.

Each individual status change reported by the equipment may be configured to send
pager, e-mail or fax messages to a list of personnel responsible for that equipment.

Each status change can also be configured to automatically create a trouble ticket, an
automatically created form that contains details on the equipment failure. Trouble
tickets allow operators to select the suggested course of action to repair the
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equipment, to assign a technician responsible for the repair, to enter notes on the
action taken and, once the repairs are done, to close the ticket.

MACS is a multi-user system, implemented as a distributed client/server application,
which runs either on a single computer or on a local or wide area TCP/IP network,
under the Windows XP, Windows 2000 and Windows NT operating systems. When
more than one MACS runs on the network, the systems can exchange peer-to-peer
information, or they can be organized in a hierarchical tree structure, in which a
central MACS server controls regional MACS servers.

The system is highly modular, thus allowing for rapid and easy customization,
according to the specific application requirements.

3.2 Why MACS?

Most equipment vendors offer some software to control their equipment. In some
cases, the software might be quite costly. In other cases the software is shipped with
the equipment for free. So, why choose MACS?

Here are some of the key reasons to use MACS:

System Integration In most cases, end-users have equipment from more than one
vendor. If the equipment specific software is used for each kind of
equipment, the operators must deal with a number of programs,
with different user interfaces, functions, installation procedures,
and so on. All of this imposes an additional burden on installation,
configuration, training and day-to-day use. MACS provides a uni-
form and consistent user interface, a standard set of features for
all equipment, and a common installation procedure and configu-
ration process.

Multi-user access Most equipment-specific software programs are built as mono-
lithic, single user programs. MACS is a multi-user system that
allows a number of operators to work concurrently and indepen-
dently on the equipment.

Networking MACS is a distributed client/server application that may run on a
single computer, on a local area network (LAN) or a wide area
network (WAN). Thus, the operators can access the equipment
locally or remotely from geographically distant locations. MACS
supports a variety of communication media, ranging from simple
telephone lines to advanced LAN and satellite connections.
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Industry Standards Many networking and telecommunications devices support the
industry standard Simple Network Management Protocol (SNMP).
MACS SNMP manager features allow for SNMP devices monitor-
ing and control without using any equipment-specific software.
MACS SNMP agent allows MACS to act a s a proxy agent for
other SNMP managers.

Cost effectiveness Compared to most of the competitive products, MACS provides a
highly cost-effective solution. Highly modular design concepts
allow for rapid and easy customization, and simplify support for
the newly added equipment.

3.3 What can you do with MACS?

The key MACS features are:

• Support is available for variety of equipment, connected to one or more computers,
using either serial lines or network connections.

• Support for the equipment that uses SNMP protocol.

• Built-in opto isolated digital inputs for monitoring contact closures.

• Built-in relays for controlling external devices.

• Simple, friendly and intuitive Graphical User Interface (GUI).

• Monitor and control screens implemented as graphical images, which can be
added to the system by the end-user.

• Field-configurable status or alarm points allow end-users to define point name,
text, severity, and color for each status or alarm point state.

• Field-configurable control points allow end-users to define point name, text,
severity, and color for each control point state. Control points can be set, reset,
pulsed or toggled from the user-defined control screens.

• Command line mode of operation is provided for the equipment, which supports
commands from the terminal.

• The system always shows up to 100 most recent events in a scrollable window.

• All reported events are saved in the text and/or binary files created on a daily basis.
The system provides means to view, search, copy and print the event log.
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• Paging system automatically calls all personnel responsible for the equipment.

• The system automatically sends e-mail or fax messages to the predefined list of
users.

• The system automatically creates trouble tickets when equipment failure is
detected.

• Multi-user support allows operators on the network to access the system indepen-
dently and simultaneously.

• Equipment locking prevents conflicting commands in the multi-user environment.

• Access is available over the LAN, dial-up and ISDN networking, using the TCP/IP
protocol.

• On-line MACS documentation.

• On-line equipment documentation.

3.4 How does it work?

Your MACS is a distributed client/server application. This means that it may use more
than one computer and that it runs more than one program to perform its functions.
Your equipment and sensors that you wish to monitor communicate with the server.
You and other operators use the Graphical User Interface (GUI) programs to access
the MACS. Your GUI program is referred to as the client.

The server is a dedicated computer, which is attached to the equipment via the serial
lines, network connections, and via built-in digital inputs and relays. It monitors alarms
from the equipment and periodically polls the equipment to gather additional informa-
tion on your equipment operational status. Usually, the server is also connected to
your in-house computer network.

Each type of equipment connected to the system is supported by an equipment-spe-
cific program, which runs on your server. The server communicates with the equip-
ment and executes equipment specific commands. Some equipment may be attached
to the computer via a serial line, which can be either a direct or a modem connection.
Other equipment supports Ethernet connections which provide faster and more reli-
able communication. In addition, you can use built-in digital inputs to monitor contact
closures, and built-in relays to control external devices.
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When a client sends a request to operate the equipment to the server, the server exe-
cutes the request, and sends a response back to the client.

From your workstation, you connect to the server via a LAN or WAN network. Once
you are connected to the server, you get all the alarms and you can use any other
command to monitor and to control your equipment. The GUI program that you run on
your workstation is referred to as the client. Clients can run on either Windows XP,
Windows 2000 or Windows NT workstations, which may be located anywhere on your
TCP/IP network. They can connect to the server using either a local or wide area net-
work, including dial-up and Point-to-Point Protocol (PPP) connections and Remote
Access Service (RAS). You can also run your client program on the server itself. In
such a case, you need only one computer for your entire alarm system.

In addition to equipment monitoring and control, the clients also provide a set of com-
mands to view, print, analyze and manage the event log.

Finally, the clients encompass a set of utilities, which are used to configure the system.

3.5 Configuration

All key system parameters are field configurable. The system configuration is done
using a set of configuration utilities, all of which are based on a consistent, user friendly
GUI. All configuration parameters are stored in the configuration database. Although
the configuration database contains many parameters, most of them are set automati-
cally and you must enter only those parameters where the system allows choices.

In addition, MACS provides means to configure and initialize various pieces of equip-
ment. Depending on the equipment, configuration can be done using the command
line mode interface or equipment specific configuration utilities.

3.6 Event Log Management

Each MACS event report is stored into a log file. This feature allows static analysis of
the recorded alarm conditions. The system automatically creates and maintains log
files on a daily basis. Since all event reports are stored into the files, the simplest way
of analyzing events is to view the log files. While viewing any given file, you can search
for specific keywords or text strings, selectively print relevant portions of the file, or the
entire file.
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3.7 Equipment Files Management

In addition to its own event reports, the system may be configured to save the entire
output received from the equipment in a separate set of log files. This feature is appli-
cable only to some equipment. In such cases, each set of equipment files contains
only messages from the equipment received through one of the serial ports.

3.8 Trouble Tickets

As an option, your MACS may come equipped with additional trouble ticketing system
components. When an alarm condition is detected, the trouble ticketing system auto-
matically opens a trouble ticket. Trouble tickets are predefined in its configuration
database and associated with the detected alarm conditions. A ticket is opened when
the system detects equipment failure and closed explicitly by the operator. Once the
ticket is open, you can select the appropriate repair procedure from a predefined list
and assign a technician responsible for the repair. The technician can enter his com-
ments related to the repair and, upon completing the task, close the ticket.

You can view and print individual tickets, a list of open tickets, or a list of closed tick-
ets. You can also create a number of trouble ticket reports. In addition, obsolete tickets
can be deleted from the list of closed tickets.

3.9 Multiuser Support

MACS is a multi-user system. A number of users can monitor alarms or perform vari-
ous control and configuration tasks concurrently and independently from any other
user on the system.

3.10 Remote Access

You can access the system remotely either via the serial line connections or the local
area network. Remote access via serial lines can be used as long as at least one com-
puter on the local area network is configured to support a dial-in modem line.

Similarly, serial ports used by the system to communicate with the equipment can be
configured to connect either directly to the equipment, or to use dial-up modem con-
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nections.

3.11 Networking

MACS fully supports LAN and WAN connections, as well as dial-in modem connec-
tions. The system may be configured to use any physical network topology as long as
the TCP/IP protocol is available for that network. Therefore, the system may run on the
token ring and Ethernet networks, and across wide area networks, using bridges and
routers. To communicate over the dial-up serial lines, your server and your clients can
use the Point To Point Protocol (PPP) and Remote Access Service (RAS).

3.12 Online Diagnostics

All server programs have powerful built-in real time online diagnostics that can be used
in the field to verify system configuration and to monitor operation of the external sys-
tem interfaces.

Online diagnostics can be accessed remotely by our customer support personnel to
assist you in configuring and running the system.
11Micus Alarm and Control System
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4 Overview

This section briefly describes MACS architecture and provides some details on the
system internals. This information is provided for those who want to learn more about
MACS operation. In particular, it will be a useful reference for the system administra-
tors. If your goal is only to learn how to use the system, you can proceed to the next
section.

4.1 MACS Architecture

MACS is a distributed application, which consists of one or more MACS servers and
clients. MACS servers are responsible for data acquisition and equipment control,
while clients provide the user interface to the system.
13Micus Alarm and Control System
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The MACS server typically interfaces more than one type of equipment. Each type of
equipment is supported by a dedicated computer program, implemented as a
Windows NT service. The service, also referred to as the Equipment Module, commu-
nicates with the equipment and executes the equipment-specific commands. Usually,
the equipment is attached to the computer via the serial lines, but equipment modules
also support TCP/IP network connections to the equipment. The MACS server can
run under the Windows XP Professional operating system, Windows 2000
Workstation operating system or Windows NT Workstation 4.0 operating system. Note
that the MACS server does not require a server operating system.

MACS clients provide a user interface to the system. The clients run on any MS
Windows workstations that may be located anywhere on the TCP/IP network,
including dial-up and point-to-point connections using the Point-To-Point (PPP)
protocol and Remote Access Service (RAS). A client can also run on the MACS
server itself.

4.1.1 MACS Servers

MACS servers are responsible for the data acquisition and equipment control. A
MACS server is a dedicated computer that runs one or more MACS Windows NT
services, also referred to as the equipment modules.

Each type of equipment connected to the MACS server is supported by a Windows
NT service, which communicates with the equipment and executes the equipment
specific commands. Usually, the equipment is attached to the computer either via a
serial line, or via TCP/IP network connections. In addition, MACS servers may be
equipped with built-in digital inputs and relays. Digital inputs may be used to monitor
contact closures and sensors, while relays may be used as electrical switches to
control external devices.

Equipment modules communicate with the equipment using the equipment-specific
communication protocol. Depending on the equipment capabilities, one or more units
can be attached to the computer via the same serial line. The equipment module can
be configured to use one or more serial ports, depending on the number of equipment
units attached to it.

MACS equipment modules detect status changes and alarm conditions in two ways:
by passively monitoring the equipment, or by actively polling the equipment status.
Unsolicited messages from the equipment or responses to the polls are then trans-
lated into user-defined status and alarm messages and sent to the clients.

When a client sends a request to operate the equipment, the equipment module
executes the request and sends a response back to the client.
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4.1.2 MACS Clients

MACS clients are MS Windows applications that provide a user interface to the
system. A client connects to one or more servers using the TCP/IP protocol. The
connections can be established through local or wide area network, or using the RAS
connections over telephone lines. Once connected to the system, the client receives
all event reports from the servers. The client can also connect to a particular server
and operate the attached equipment.

MACS clients also provide a set of commands to view, print, analyze and manage the
event log.

Finally, MACS clients encompass a set of utilities, fully integrated into the user
interface, that are used to configure the system.
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4.2 Status And Control Points

MACS defines any equipment in terms of units, slots and points. Points represent
equipment parameters which can be controlled, or parameters that can be read to
determine equipment status. The MACS supports several point types: digital inputs,
digital outputs, analog inputs, analog outputs and summary points. Typically, MACS
status points represent equipment status and alarms, environmental alarms, security
alarms, power system status and alarms, communications alarms, and other alarms.
MACS control points are used to control the environment. For example, they can
switch heating and cooling on and off or they can tune equipment parameters such as
frequency and gain and change equipment parameters. For example they can switch
TV channels.

MACS equipment modules support digital inputs, digital outputs, analog inputs and
analog outputs. These inputs and outputs can be either on the plug-in boards installed
into the computer itself, or in the external equipment attached to the computer via the
serial lines or through the network connections. Plug-in boards or the external
equipment monitor contact closures, TTL levels, and other hardware signals. In
addition, servers use either ASCII or binary communication protocols to interrogate
and control more complex external equipment.

Digital inputs have two states: active and inactive. Digital outputs can be active,
inactive or pulsed. Analog inputs can be within limits, above upper threshold, or below
lower threshold. Analog outputs can be set to any value within the range appropriate
for the associated equipment parameter.

Summary points reflect any change in the equipment status. In addition, they handle
communication alarms, which are generated when the communication with the
equipment or server is lost.

All of the configurable parameters are defined by the end-user through the system
configuration process.

4.3 Status And Alarm Processing

MACS detects status changes and alarm conditions in two ways: by passively
monitoring the equipment, or by actively polling the equipment status. Unsolicited
messages from the equipment or responses to the polls are then translated into the
user-defined status and alarm messages.

Typically, several operators simultaneously use their GUIs on the local or wide area
network. Status messages and/or alarms received from the equipment are reported to
all GUIs. They provide extensive buffering capability, thus allowing operators to browse
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through several pages of collected records.

When displaying event reports on the screen, the client typically uses a subset of the
information actually available in the event report. This subset consists of the date,
time, unit name, point name and message text. The rest of the information is used
internally by the system, but it remains available for further analysis if saved into the
binary event log.

The following picture depicts GUI main window, with a number of status and alarm
messages.

In addition to the text messages displayed in the scrollable window, changes in the
equipment status and alarms are also shown in all graphical monitor and control
windows. Each time a given point changes its status, the color of the point displayed
in the window changes accordingly.

4.4 Monitor And Control Windows

To monitor and control the equipment, you can create any number of monitor and con-
trol windows. Typically, these windows contain geographical maps, building layouts,
equipment racks, equipment diagrams, equipment front panels, etc.
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To monitor and control the equipment, the users can create any number of monitor
and control windows. Typically, these windows contain geographical maps, building
layouts, equipment racks, equipment diagrams, equipment front panels, electrical
circuit schematics, and other diagrams.

MACS monitor and control windows are non-modal. This means that the user can
display more than one window on the workstation screen, and freely switch from one
window to another. As the system detects status changes, all windows on the screen
are updated accordingly.

Each monitor and control window consists of two components: a background graphical
image and a list of status and control points. A background image can be created
using any graphic editor, such as MS Windows Paint or CorelDraw. When displaying
the window, the system determines the size of the image and adjusts the window size
accordingly. The following picture shows a typical on-screen presentation of the
equipment front panel and alarm status.
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The list of points to display in the window is kept in the system configuration database.
A single window may combine points from various pieces of equipment. The status
and alarm points only reflect equipment status. The control points have push buttons,
which allow operators to set, reset, toggle or pulse the point.

The points can be displayed on the screen using a variety of styles:
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LED style point is displayed as a small circle or square
that changes color as the associated point changes its
state. The point name is not displayed. This style is typi-
cally used to draw the equipment front panels.

Points can be displayed using either full width, half width
or proportional width rectangles. A rectangle contains
the point name and changes its color as the point
changes status. Full and half size rectangles are used to
align points displayed in the window. Proportional width
is used to make the rectangle size proportional to the
point name length.

Points can be displayed using either solid or transparent
rectangles. Solid rectangles change both foreground and
background color when the associated point changes
state. Transparent rectangles change only the outline
and the text color, while the background remains visible
through the rectangle.

Output points can be displayed with the push button,
used to select and operate the point. Output points can
also be displayed as read-only points, in which case they
can be monitored but not operated from a given window.

Points can be displayed as animated switches. The
same point can be mapped onto more than one switch.
Switches can be drawn using any size and orientation,
and can be displayed in different colors in active and
inactive states.
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Points can be mapped onto one or more lines, which
change color depending on the point state. This style is
typically used to depict communication links or electrical
circuits.

Points can be presented as open or closed doors in an
architectural drawing, depicting a building layout. This
style is typically used for security applications.

Point states can be presented using two bitmap draw-
ings, one for each state. In this example, the active point
state is mapped into a drawing of an open fridge, while
the inactive point state is mapped into a drawing of a
closed fridge.

Analog points can also be displayed as gauges, with the
handle optionally changing color when exceeding the
upper or lower threshold.
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Analog points can be displayed as vertical or horizontal
histograms that optionally change color when their
respective analog values exceed the upper or lower
threshold.

The numerical reading from analog points can be dis-
played using an integer, decimal or scientific notation.

The numerical values for the output points can be set
from an edit box.

Some analog points can have a fixed set of values that
can be mapped into a list of names. For example, TV
channel numbers can be mapped into the corresponding
TV channel names. In such case, instead of displaying
numerical values, the screens will contain the associated
names. Each name can be displayed in a different color.

Some analog output points can be set to a fixed set of
values. These values can be mapped into a list of
names. For example, TV channel numbers can be
mapped into the corresponding TV channel names. In
such a case, instead of entering numbers, the values
can be selected from a drop-down list of the associated
names.
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The system allows the end-users to nest any number of windows they create into a
logical chain. For example, the top-level window may contain a geographical map with
the regional centers. By clicking on the regional center, the operator opens the next
window with the regional map, which contains sites. Clicking on a given site opens a
building layout window with the equipment racks, secured doors, environment and
power alarms etc. Finally, by clicking on a particular rack, the operator displays the
equipment block diagram or a front panel.

To monitor analog values over time, points may be pre-
sented using scrolling graphs. Each time a new analog
value is sampled, it gets added to the right end of the
graph. Once the end of the working rectangle is reached,
the graph starts scrolling to the left.

Analog values below lower threshold, within limits and
above upper threshold may be represented using differ-
ent colors.

Two scrolling graph styles are available: a transparent
graph style and a solid graph style.

You can define the length and width of the graph in pix-
els. One vertical line is added to the graph each time a
new value is received. Thus, the scrolling speed of the
graph depends on its width in pixels, and the polling
interval used to sample the value.
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4.5 Configuration

All key system parameters are field-configurable. The system configuration includes
the type of equipment connected to the computer, the number of units connected to
each serial port, polling intervals, point definitions, networking parameters and more.
System configuration is done using a set of configuration utilities, all of which are
based on a consistent, user friendly GUI. All configuration parameters are stored in the
configuration database.

In addition, MACS provides the means to configure and initialize various pieces of
equipment, such as intelligent modems, satellite communications equipment, and
programmable logic controllers. Depending on the equipment, configuration can be
done using the command line mode interface or equipment specific configuration
utilities.

To communicate with the database, MACS uses the Microsoft Open Database
Connectivity (ODBC) interface and the Structured Query Language (SQL). This means
that any industry standard database engine can be used, as long as the ODBC driver
is available for it.

To configure the system, you must define the servers, the units attached to the
servers, the slots within each unit, and the points. You also need to configure serial
ports to use to communicate with the equipment.

When using the optional pager, e-mail or fax system, you need to define a list of
pager, e-mail or fax users, and to assign a list of events for each user on the list.
Similarly, the optional trouble ticketing system requires additional configuration for the
list of trouble tickets, repair procedures, technicians, etc.

Although the configuration database contains many parameters, most of them are
hidden from the operators who use MACS utilities to configure the system. Most of the
parameters are set automatically and you must enter only those parameters where the
system allows choices.
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4.6 Event Log Management

Each event report received from the equipment is stored into a log file. This feature
allows static analysis of the recorded alarm conditions. The system automatically
creates and maintains log files on a daily basis. Since all event reports are stored into
the files, the simplest way of analyzing events is to view the log files. While viewing
any given file, the operator can search for specific keywords or text strings (such as
time stamps or equipment names). In addition, the operator can selectively print
relevant sections of the file, or the entire file.

Typically, the system maintains only a single event log, managed by the Event
Logger, a service specifically designed to handle the event log. The equipment
modules are then configured to send their event reports to that logger. However, the
system does allow for more than one logger, depending on the specific customer
requirements.

In addition to the centralized event log, which contains the event reports from the
entire system, each equipment module can be configured to maintain its own event
log. Such a log will contain only the event reports from the equipment attached to that
equipment module.

The system can maintain an ASCII event log, a binary event log, or both. ASCII logs
contain less information, but may be viewed and analyzed using any text editor.
Binary logs contain more information and are better suited for processes such as
analysis, event correlation, and root cause rationalization.
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4.7 Pager

Any status change or alarm message may be configured to activate the paging
system. Based on the event being reported, the pager selects, from the database, a
list of responsible personnel and sends pager messages to all individuals on the list.

The standard MACS pager uses the Telocator Alphanumeric Input Protocol (TAP),
which is the most commonly used paging protocol. If the local paging company uses
some other protocol, the pager module may need modifications to support the commu-
nication protocol used by the paging company.

4.8 E-mail and Fax

MACS sends e-mail and fax messages using the industry standard Messaging API
(MAPI) interface. Status changes and alarm messages may be e-mailed or faxed to
one or more users. Based on the event being reported, the MAPI service selects, from
the database, a list of responsible personnel and sends MAPI messages to all
individuals on the list.

MACS itself does not contain fax and e-mail software. It provides only the interface to
the operating system native fax and e-mail services. To send MAPI messages, MACS
relies on a third party software, such as Microsoft Messaging, which comes with the
Windows NT operating system, and Microsoft Fax for Windows NT.

4.9 Trouble Tickets

As an option, your MACS server may be equipped with the MACS Trouble Ticket
System (TTS)1. In such a case, MACS automatically opens trouble tickets predefined
in its configuration database. A ticket is opened when the system detects equipment
failure and closed explicitly by the operator. Once the ticket is open, the operator can
select appropriate repair procedure from the predefined list and assign a responsible
technician. The technician can enter his comments related to the repair and, upon
completing the task, close the ticket.

Operators can view and print individual tickets, a list of open tickets, or a list of closed
tickets. In addition, obsolete tickets can be deleted from the list of closed tickets.

1. The TTS is an add-on component, which must be purchased separately.
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4.10 Multi-user Support

MACS is a multi-user system. Any number of users can monitor alarms, or perform
various control and configuration tasks concurrently.

Each user interface connected to the system is a completely independent client
program that may run on any computer on the TCP/IP network.

Each operator can perform various tasks independently from any other user on the
system. The only restriction is that two operators cannot access the same piece of
equipment simultaneously. This feature protects the equipment from the conflicting
requests issued by different operators.
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4.11 Remote Access

The MACS can be accessed remotely either via the serial modem connections, ISDN
connections or the local area network. Remote access via serial lines can be used as
long as at least one computer on the local area network is configured to support a dial-
in modem line.

Similarly, serial ports used by the system to communicate with the equipment can be
configured to connect either directly to the equipment, or to use dial-up modem
connections.

Windows XP operating system comes with a built-in Remote Desktop feature. It is
important to emphasize the difference between using the remote desktop and MACS
client GUI.

The remote desktop presents the entire screen of the remote computer. If you start a
program using the remote desktop, the program will actually run on the remote
computer. Since the remote desktop copies the entire remote computer screen, it is
very, very slow, in particular over the serial lines.

By contrast, when you use the MACS client GUI, the GUI actually runs on your
workstation. It connects to the server to exchange only the minimum amount of infor-
mation needed to locally present status and control information. Thus, the difference in
performance between the remote desktop and the MACS GUI is huge, at least two
orders of magnitude.

4.12 Networking

MACS provides full LAN and WAN support, as well as dial-in modem connections. The
system may be configured to use any physical network topology as long as the TCP/IP
protocol is available for that network. Therefore, the system may run on the token ring
and Ethernet networks, and across wide area networks, using bridges and routers. In
addition, clients and servers may use Point To Point Protocol (PPP), to communicate
using TCP/IP over dial-up serial lines and Remote Access Service (RAS).

4.13 Security

MACS servers run on the Windows NT platform, which conforms to the Class C2
security level. Windows NT grants access to various resources either to individual
users or to user groups. In addition, Windows NT recognizes its own domain and
trusted external users, groups and domains.
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Individual user access to the regional servers can be controlled by assigning
personnel to different user groups. For example, membership in a given region group
will grant individual user access to the respective regional server. The same user can
be a member of more than one group. User groups can be defined in a way that
further refines access to various system resources within a given server.

4.14 On-line Diagnostics

All MACS programs have powerful built-in real time on-line diagnostics that can be
used in the field to verify system configuration and to monitor operation of the external
system interfaces.

On-line diagnostics can be accessed remotely by our customer support personnel, to
assist the operators in configuring and running the system.
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4.15 System Connections

The following pages provide a functional and architectural overview of the various
system connections.

4.15.1 Regional and Master Servers

MACS is a client/server application. Both server and clients run on a Windows XP,
Windows 2000 or Windows NT platform2. All network connections between clients and
servers are over the TCP/IP network. In addition, MACS uses MS networking features,
such as disk and printer sharing, to access remote files and printers. Alternatively,
access to the remote files over a WAN can be done using the File Transfer Protocol
(FTP).

MACS servers are capable of sending their event reports to any number of remote
locations, via a TCP/IP network. At the same time, MACS servers listen to the service
requests from the TCP/IP network. Thus, MACS servers can be configured into a
hierarchical structure of regional servers and master servers. An example of a hierar-
chical topology involving regional and master MACS servers is depicted in the
following figure.

2. Some of the MACS server components are available for the SCO OpenServer UNIX operating system, but our
focus in this document is on the Windows NT version of the product.

TCP/IP WAN

Master
Servers

Regional Severs
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This figure illustrates the connectivity between master and regional servers. Regional
servers send their event reports to one or more master servers. Both master and
regional servers listen to the TCP/IP network and accept service requests from the
clients.

4.15.2 Client Connections to Servers

The clients can be located anywhere on the TCP/IP LAN or WAN network. The
following figure depicts possible client connections to a server, which could be either a
regional or a master server. The figure illustrates a variety of possible physical
connections: LAN connections, RAS connections via modems or ISDN, and WAN
connections. Clients can connect to a MACS server over any physical network, as
long as the TCP/IP connectivity is available.

Multiple MACS servers can be configured to share a common database, or to use
their own databases. When more than one database is used, the clients can dynami-
cally disconnect from one database and connect to another.

TCP/IP WAN

TCP/IP

Client Workstations

Client Workstations

Remote Access Service (RAS)
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4.15.3 Equipment Connections to Servers

MACS servers support a variety of connections to the equipment. The type of
connection depends on the equipment itself, and on the site location with respect to
the MACS server. Some equipment can be accessed over the Ethernet, using TCP/IP
connections. However, devices such as Remote Telemetry Units (RTUs) are typically
accessed over serial lines, using either direct connections or dial-up lines. In addition,
environment sensors and contact closures may be monitored using built-in opto
isolated inputs, while external devices can be controlled using built-in relays.

Usually, MACS servers are equipped with multi-port plug-in boards, which offer
RS232, RS422 or RS485 electrical interface.

MACS equipment modules are designed to work with any number of serial ports, up to
a maximum of 255, which is imposed by the Windows operating system. When more
than one port is used, the equipment modules allow for a combination of direct lines
and modem lines.

The following figure depicts typical equipment connections to a MACS server.

TCP/IP LAN connections RS422 multidrop line

Internal or external modem bank

RS485 daisy chain

PSTN
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4.15.4 Direct Connections

The equipment can be connected to the MACS server using an RS232, RS422 or
RS485 electrical interface. When the RS232 is used, each equipment unit must be
connected to a dedicated serial port. The RS485 interface allows a number of units to
be daisy-chained to a single serial port.

Direct connections allow for fast polling. Typically, the equipment is polled every few
seconds. The polling interval is configured individually for each piece of equipment.
However, direct connections do not allow unsolicited messages from the equipment,
to prevent possible collisions on the line.

4.15.5 Dial-up Connections

Any number of units can share the same dial-up line, as long as they can be uniquely
identified by their respective physical address. However, we usually configure MACS
to use more than one dial-up line, to balance the throughput.

Typically, the MACS server is configured to use one or more outbound modems to
poll units and to use one or more inbound modems to accept telephone calls from
units. Usually, the MACS server polls each unit every few hours, to check the commu-
nication link with the unit. The polling interval is configured individually for each unit. If
three consecutive calls to the unit fail, the MACS server issues a communication
alarm. In addition, MACS accepts and processes inbound calls from the units.
Typically, units call the server when they detect an alarm condition.

4.15.6 Network Connections

A growing number of vendors offer access to their equipment over a LAN or WAN,
usually using the SNMP protocol. MACS server can monitor and control any number
of SNMP-enabled devices, as long as it can connect to the equipment over a TCP/IP
network.

4.15.7 Digital Input Connections

MACS servers come with built-in opto isolated digital inputs. These inputs can be
used to monitor environment sensors and contact closures on the equipment in close
proximity to the MACS server. The MACS server can be equipped with 8 to 128 digital
inputs.
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4.15.8 Output Relay Connections

MACS servers come with built-in output relays. These relays can be used to switch
external devices on and off. The MACS server can be equipped with 8 to 128 output
relays.

4.16 Hardware and System Software Overview

MACS software is a client/server based application. Both server and client compo-
nents run under the Windows XP, Windows 2000 or Windows NT operating system.

4.16.1 Client Components

Hardware and system software requirements for the client components are:

• A standard Pentium PC, with 128 MB of RAM.

• An 800 by 600 resolution monitor for most of the screens, or a 1024 by 768
resolution monitor for the maps or other graphic intensive screens, and the MACS
display editor.

• Network adapter or high-speed modem, depending on the available TCP/IP
network connectivity.

• Windows XP Professional, Windows NT, or Windows 2000 operating system.

• MS Access ODBC driver, MySQL client software and ODBC driver, or Oracle

database3 client software and ODBC driver.

4.16.2 Server Components

Hardware and system software requirements for the server components are:

3. MACS software uses Open Database Connectivity (ODBC), which allows connectivity to any database for which
ODBC drivers are available. For the smaller installations, we recommend MS Access database. For the larger
installations, we recommend Oracle database because of its reliability, scalability, strong TCP/IP networking fea-
tures, and built-in tools for the Internet/web access. As a no-cost alternative to Oracle, we also recommend
MySQL.
35Micus Alarm and Control System



Overview
• A high-end Pentium PC, with a minimum of 128 MB of RAM for the MS Access
database, or 512 MB of RAM for the Oracle database.

• An 800 by 600 resolution monitor for most of the screens, or a 1024 by 768
resolution monitor for the maps or other graphic intensive screens, and MACS
display editor.

• One or more network adapters, depending on the network topology and on the
available TCP/IP network connectivity.

• A number of serial ports, depending on the exact requirements for each regional
server.

• A number of either internal or external high-speed modems, depending on the
exact requirements for each regional server.

• Windows XP Professional, Windows 2000 or Windows NT Workstation 4.0
operating system.

• MS Access ODBC driver, Oracle client software and ODBC driver, or MySQL
client software and ODBC driver.

• MS Access, Oracle or MySQL database.
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5 Getting Started

This section shows you how to start and stop your MACS server and your graphical
user interface (GUI), and introduces the main GUI functions used in day-to-day system
operation.

Your GUI can run on Windows XP, Windows 2000 or Windows NT workstations. This
is why in this manual we show sample screens using interchangeably either Windows
XP or Windows Classic appearance. Both sets of screens are shown only where tasks
are performed differently in Windows XP than in other environments. An example of
that is starting and stopping your system.

All MACS programs that run on your workstation are located in a dedicated directory,
similar to the one depicted in the following picture.

Depending on your actual system configuration, the number of MACS programs in the
programs folder and program names will wary. In this example, the MACS folder is
installed on disk C: and contains the following subfolders:

• The config folder contains database and bitmap files.

• The Distribution folder contains a copy of installation files found on the MACS
software distribution CD.
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• The Doc folder contains a set of MACS documents in PDF format.

• The log folder contains daily event log files.

• The programs folder contains all MACS executable programs and dynamic link
libraries (DLLs).

• The Working folder contains MACS temporary files.

The \MACS\Programs folder typically contains a number of programs. This is due to
the highly modular MACS architecture. However, all these programs are carefully
integrated to appear to the user as a single MS Windows application. As a typical
MACS operator, you will need to use only the main user interface program.

Usually, the \MACS\Programs folder contains three types of programs:

Configuration utilities

are the client programs used to configure the system. There are a
number of standard configuration utilities found in each MACS
installation. These utilities are used to define MACS colors and to
configure event reporting, MACS clients, custom monitor and
control windows and other features. In addition, there is one con-
figuration utility for each type of equipment attached to the sys-
tem. Typically, in the multi-user environments, configuration
utilities may not be installed on all workstations. They are used
only by the operators responsible for the system configuration
and maintenance. Configuration utility names are shown with the
MACS icon and usually contain the acronym Cfg (as in Menu-
Cfg.exe.)

User Interface Programs

provide the user interface to the system. You must have at least
the MacsMenu.exe user interface program installed. Other MACS
GUIs are optional. User interface program names are shown with
the MACS icon.

Equipment modules

are programs that execute in the background as Windows NT
services and actually communicate with the equipment. You will
find one equipment module for each type of equipment attached
to your system. The equipment module names are shown with
the MS Windows console program icon.
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The \MACS\Programs folder will contain one configuration utility and one equipment
module for each type of equipment attached to the system. In addition, the folder will
also contain some programs which are commonly used in any MACS installation:

MacsMenu.exe is the main graphical user interface to the system. It displays
alarms and graphical images.

MacsTicketMenu.exe

is a user interface program that allows you to access the optional
trouble ticketing system. You will use this program to examine
open trouble tickets, to assign technician to do the repairs, to
enter the status of the trouble tickets assigned to you, to create
reports, and to do other tasks.

MacsManager.exe is a user interface program used to start the MACS messaging
(MAPI) programs. This program is usually used only by the sys-
tem administrators.

MenuCfg.exe is a configuration utility program used to enable login access to
the MACS from individual workstations on your computer net-
work.

ColorCfg.exe is a configuration utility program used to define colors for the
alarm messages and graphical images.

LogCfg.exe is a configuration utility program used to configure the event
reporting and event log files location within your system.

PagerCfg.exe is a configuration utility program used to configure the paging ser-
vices.

MAPICfg.exe is a configuration utility program used to configure the e-mail and
fax messaging (MAPI) services.

MacsUtl.exe is a configuration utility program used to define which workstation
has access to which individual MACS components. Typically, this
utility is used only during the MACS installation process.

MacsEditor.exe is an optional configuration program that allows you to create your
own graphical screens. This program is usually referred to as the
Display Editor. Like the other configuration programs, the display
editor is typically installed only on workstations used to administer
the MACS system.

MacsMon.exe is an optional configuration utility program used to configure end-
user custom monitor and control windows. This program is usually
used as an integral part of the display editor, described above.
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MacsLogger.exe is a special equipment module, dedicated to event reporting and
login, and to the user login onto the MACS. If you have only a sin-
gle type of equipment attached to your system, you may not need
the MACS logger. However, if you want to monitor and control
more than one type of equipment, or if you want to use the pager,
e-mail or fax, you will need the logger.

MacsPager.exe is an optional equipment module, dedicated to sending pager
messages.

MacsMAPI.exe is an optional equipment module, dedicated to sending e-mail
and fax messages. This program works in conjunction with the
Windows NT native messaging (MAPI) services.

MacsTicket.exe is an optional equipment module responsible for the creating and
processing trouble tickets.

TestClient.exe is a freely distributed MACS diagnostics utility.

5.1 MACS Startup

The following pages explain how to start and how to stop your MACS. To start MACS,
first you need to start all server components. Once they start properly, you can start
your GUI. Similarly, to stop the system, you stop your GUIs, and then you stop your
server components.

You may want to start and stop the GUI on your workstation on a daily basis.
However, once started, the server components typically run for months without inter-
ruption. The only reason to occasionally stop them are changes in the MACS configu-
ration and computer maintenance.

5.1.1 MACS Services Startup

All MACS equipment modules are implemented as Windows NT services. Therefore,
these components could be either configured to start automatically when you boot the
computer, or you could start them manually from the Windows NT Services manager.

To start a given MACS equipment module automatically, you could select the
automatic startup option when you install it. However, we recommend that you always
select manual startup to start with. Once you verify that your configuration works
correctly, you can change the startup from manual to automatic using the Windows
NT Services manager.
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Typically, you would start the MACS event logger service first, followed by other
equipment modules. That way, all event reports will be properly saved into the event
log file.

5.1.1.1 Windows XP

To start your MACS equipment module manually under Windows XP, login to your
MACS server. Then open the Control Panel by clicking on Start -> Control Panel. In
the Control Panel doubleclick on the Administrative Tools icon. When you open the
Administrative Tools dialog box, doubleclick on the Services icon.
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In the Windows XP services manager highlight the service that you want to start and
click the right mouse button. Select the Start option from a pull-down list and click the
left mouse button on it, as shown in the next picture:

While starting the service, Windows XP displays the following message box:

Once the service is started, the message box will disappear.
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5.1.1.2 Windows NT

To start your MACS equipment module manually under Windows NT, login to your
MACS server. Then open the Services manager by clicking on Start -> Settings ->
Control Panel. When you open the Control Panel, doubleclick on the Services icon.

In the Windows NT Services manager, highlight the MACS equipment module you
want to start, and click on the Start push button.
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While starting the service, Windows NT displays the following message box:

Once the service is started, the message box will disappear. Note that in the above
example message box, ICIUS is the name of the computer. This name will be
replaced with the name of your own workstation.

5.1.2 MACS GUI Startup

You can start your MACS GUI in several ways:

• Double click on the MacsMenu.exe icon in the \MACS\Programs directory depicted
on the previous pages.

• Select the MacsMenu program from the Start -> Programs -> MACS menu.

The look of the Start menu on your workstation will depend on whether you use
Windows XP or Windows NT user interface style, as shown in the following pictures.
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In order to properly function, your GUI must be connected to the server. Usually, the
GUI is set up to connect to the server automatically when you start it. In such a case,
when the GUI opens its main window, you will see an event report similar to the follow-
ing example:
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This event report indicates that your GUI is properly connected to the server. If you do
not get this event report on the screen, you will have to connect to the server manu-
ally, using the Connect command. Details on the connect command are given later in
this manual.

You can start any other MACS user interface program using the same two methods. In
addition, for frequently used programs such as MacsMenu, you can also create a
shortcut in your desktop window.

5.2 MACS Shutdown

To shut down all MACS components, you have to shutdown all user interface
programs and all Windows NT services.

Usually, there is no need to stop the MACS server components, except for when you
want to change MACS configuration, or when you need to shutdown your computer.
You may want to shut down the GUI on your workstation every day before you leave
your office. Note that shutting down the GUI will not affect the server operation.The
MACS server will continue to monitor your equipment and to process alarms even
when there is no GUI logged in.

5.2.1 MACS Services Shutdown

To stop MACS services, use the Windows Services manager. How to access the
Services manager differs between operating systems.

5.2.1.1 Windows XP

To stop any of the MACS services, login to your MACS server. Then open the Control
Panel by clicking on Start -> Control Panel. In the Control Panel, double click on the
Administrative Tools icon. When you open the Administrative Tools dialog box, double
click on the Services icon.

In the Windows XP services manager highlight the service that you want to stop and
click the right mouse button. A pull-down list will appear. Select the Stop option and
click the left mouse button, as shown in the next picture:
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While stopping the service, Windows XP displays the following message box:
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5.2.1.2 Windows NT

To stop any of the MACS services, login to your MACS server, open the Windows NT
Services manager by clicking on Start -> Settings -> Control Panel. When you open
the Control Panel, double click on the Services icon.

Once in the Services manager, highlight the service you want to stop, and click on the
Stop push button.

While stopping the service, Windows XP displays the following message box:

5.2.2 MACS GUI Shutdown

You exit your MACS user interface programs the same way as any other Microsoft
Windows application. For the MacsMenu program use one of the following methods:

• Click on the ‘X’ button in the top right corner of the window.

• Select File -> Exit from the main window pull down menu.
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Some configuration utilities are dialog box based. For these programs, you can use
one of the following methods:

• Click on the ‘X’ button in the top right corner of the main dialog box window.

• Click on the Exit push button in the main dialog box window.

5.3 Elements of the Main MACS Window

In this section we present commonly used GUI features, while the details specific to
the individual commands are given later in this document. All MACS programs share
the same “look and feel” and follow the Microsoft user interface implementation guide-
lines. The main window for the MacsMenu program is depicted in the following picture.

The key elements of a GUI main window are:

Title Bar on the left side contains the program name and current revision
number. On the right side, it contains push buttons to minimize
and maximize the window, and to exit the application.
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Menu Bar allows you to access all available dialog boxes and commands
through a set of pull down selection menus.

Toolbar allows you to access frequently used dialog boxes and com-
mands by clicking on the toolbar icons.

Event Reports displays up to the 100 most recent events in the main window
working area. You can scroll the window up, down, left and right
to view the event reports.

Status Bar shows a brief single line help message, which explains the usage
of the main window item currently being pointed to by the mouse.

Horizontal Scroll Bar allows you to scroll horizontally through the contents of the main
window working area

Vertical Scroll Bar allows you to scroll vertically through the contents of the main
window working area

5.3.1 Toolbar Icons

The Toolbar allows you to quickly access the most frequently used commands by
clicking the mouse on the appropriate toolbar icon. The toolbar is depicted in the fol-
lowing picture.

The icons used in the toolbar are:

Connects the GUI to the server

Disconnects the GUI from the server
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Opens the Command Line dialog box

Opens a command line mode window

Opens a list of the user-defined monitor windows

Opens the list of the equipment-specific windows

Opens a dialog box to send pager message manually

Opens the selected log file for viewing

Opens the selected equipment specific file for viewing

Opens the selected configuration utility

Displays the application About… box

Displays MACS User’s Manual (this book)
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5.3.2 Event Report Format

Each event report displayed in the main window working area consists of:

• Severity icon

• Date

• Time

• Alarm unit name

• Alarm point name

• Event report text

The severity levels and associated icons are defined as follows:

Note that your system may not use all of these icons. Their usage will depend on the
severity levels you assign to your alarm messages. The event report text is displayed
using the foreground and background color assigned to the current state of the associ-
ated point.

5.4 Commands

From your GUI program, you can execute a number of commands to monitor and to
control your equipment. You can execute any command from the pull-down menus. In
addition, you can execute the most frequently used commands by clicking on their
respective toolbar icons. This section just briefly introduces the system commands.

Critical alarm

Major alarm

Minor alarm

Information only
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These commands are presented in detail in the following sections of this document.

Exit allows you to exit the GUI.

Connect allows you to manually connect to the MACS server.

Disconnect allows you to manually disconnect from the MACS server.

Command Line allows you to send single-line, equipment-specific commands to
the selected unit, and to receive responses from the unit.

Status Monitor allows you to select a user-defined monitor window from a list,
and to open that window.

Equipment Specific Monitor

allows you to select an equipment-specific monitor window from a
list, and to open that window.

Select MACS Node allows you to disconnect from one MACS database and to con-
nect to another MACS database without restarting the GUI.

Equipment Lock allows you to lock the selected piece of equipment, thus prevent-
ing other operators from operating that equipment.

Send Message allows you to manually compose and send a pager message to
the selected recipient.

View Event Log allows you to view all event reports reported on any given day.

View Equipment Log

allows you to view the raw input received from the selected equip-
ment on any given day.

View Toolbar allows you to select whether the toolbar appears on the screen or
not.

View Status Bar allows you to select whether the status bar appears on the screen
or not.

Copy Event Log allows you to archive the event log files into another folder or net-
work drive.

Copy Equipment Log

allows you to archive the equipment log files into another folder or
network drive.

Delete Event Log allows you to delete the selected event log files.
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Delete Equipment Log

is a command that allows you to delete the selected equipment
log files.

Select Utility allows you to open a list of all configured MACS utilities and to
launch the selected utility from the main user interface program.

Options allows you to select sounds to play on your workstation for differ-
ent alarm severity levels, and to setup your on-line User’s Man-
ual.

About MACS displays the MacsMenu program About dialog box.

User’s Manual displays on-line MACS User ‘s Manual (this book).
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6 Commands

This chapter presents in detail commands available through the MACS graphical user
interface. You can access any command using the pull-down menus. In addition, fre-
quently used commands have icons in the toolbar. You can invoke these commands
simply by clicking the appropriate push button.

The commands are arranged in the following pull-down menus:

File menu contains a standard Windows pull-down menu selection to
exit the application.

Monitor menu contains commands used to connect to and to disconnect
from the MACS server, commands to invoke user-defined monitor
windows, equipment-specific monitor windows, command to
select MACS node, and command line mode of operation.

Equipment Locking menu contains a command to lock and unlock individual pieces of
equipment.

Pager menu contains a command to manually compose and send a
pager message.

Event Log menu contains commands used to view the event log and the
equipment log files.

View menu contains a command to show or hide the toolbar and status
bar.

Archive menu contains commands to copy and delete event log and
equipment log files.

Configuration menu contains a command to select and launch MACS configura-
tion utilities.

Help menu contains a standard Windows command to display the
application About box, and a command to open the on-line copy
of the MACS User’s Manual, which is this book.

The following pages list all commands grouped into their respective selection menus.
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6.1 Connecting to MACS

In order to receive alarms, and to monitor and control your equipment using graphical
screens, you must connect to the MACS server. To inform the server not to send
events to your GUI, you must disconnect from the server.

Connecting and disconnecting is usually done automatically. That is, when you start
your GUI, it connects to the server all by itself. When you click on the button to exit, the
GUI disconnects from the server before exit.

In some cases, you may need to connect and disconnect manually. For example, if
you have more than one MACS server, you may need to select the server and to con-
nect to it manually. To connect and disconnect manually, use the commands
described on the following pages.

6.1.1 Connect Command

To manually connect your workstation to the MACS server, use the Connect com-
mand. To run the Connect command, click on the Monitor pull-down menu and select
the Connect menu item.

Alternatively, click on the toolbar icon depicted below.

Connect to MACS server
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In either case The Connect To MACS dialog box will pop up on the screen.

Connect push button connects your GUI to the MACS server selected from
the drop-down list. The list shows the names of the servers you
are not already connected to. If you are already connected to all
existing servers, the list will be empty. For example, if your MACS
has only one server and you are already connected to that server,
there will be no server names on the list.

Quit push button closes the dialog box after the connection has been
established.

6.1.2 Disconnect Command

The Disconnect command allows you to manually disconnect your GUI from the
surveillance system server. To manually disconnect from the server, click on the
Monitor pull-down menu and select the Disconnect menu item.
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Alternatively, click on the toolbar icon depicted below.

The Disconnect From Alarm System dialog box will pop up.

Disconnect push button disconnects your GUI from the server selected from
the drop-down list. The list contains the names of all servers that
you are already connected to. Typically, the list will contain only
the name of your primary MACS server.

Quit push button closes the dialog box after the GUI is disconnected
from the server.

6.1.3 Select MACS Node

If your installation consists of a network of MACS servers, these servers may share
the same database, or each of them could have its own database. When you run your
GUI from a workstation connected to a TCP/IP network, your GUI can connect to any
of the databases used by MACS.

When it starts, the GUI will open its default database, which is the last database it was
connected to. Once you start the GUI, you can dynamically switch to any other MACS
database using the Select MACS Node command.

To manually disconnect from the current database and connect to another database,
click on the Monitor pull-down menu and select the Select MACS Node menu item.

Disconnect from MACS server
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The Select MACS Node dialog box will pop up.

A scrollable list box contains the names of all MACS nodes configured in the current
database. To select another MACS node, highlight its name in the list and click on the
Select push button.

Select push button allows you to close the current MACS database, and
to open database on the selected MACS node.

Quit push button closes the Select MACS Node dialog box without
connecting to another database.
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6.2 Monitors

The Monitors are windows that you use to monitor and to control your equipment.
Monitor windows can be either equipment-specific, or user-defined.

Equipment-specific monitors are windows which are dynamically created by the sys-
tem when you display the alarm points for the selected piece of equipment.

User-defined monitors are windows that you create by yourself, using the Display Edi-
tor. These windows can contain alarm points from any location and any equipment
combined into a single window. You can create as many user-defined windows as you
want.

Both equipment-specific and user-defined windows are accessed from the Monitors
pull-down menu. In addition, the Monitors menu also contains the Command Line
command. This command allow you to control the equipment using the equipment’s
native user interface.

Finally, the Monitors window can also contain any number of lines that represent
actions rather than graphical images. Actions are used to run other programs from
within the MACS GUI. For example, you can add a list of actions that display on-line

documentation for your equipment, using the Acrobat Reader1.

6.2.1 Command Line Window

The Command Line window allows you to send a single line command to the selected
equipment and to receive one or more lines in response. You can use the command
line mode to control the equipment only if the equipment supports it. Note that the
command line does not provide a full terminal emulation.

To access the Command Line window click on the Monitor pull-down menu and select
the Command Line.

1. Acrobat Reader is a trademark of Adobe System Inc.
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Alternatively, click on the corresponding toolbar icon depicted in the following picture.

The system displays a dialog box depicted in the following picture. This dialog box con-
sists of the following elements:

Working Area will show all commands and responses exchanged between you
and the equipment. When the number of lines exceeds window
size, a vertical scroll bar will show up, and you can use it to scroll
through several pages of communication data.

Edit Box below the working area allows you to enter an equipment-specific
command that you want to send to the selected equipment.

Send push button sends commands to the selected unit. Type the com-
mand into the command line entry field in the bottom left corner of
the Command Line window. Then, click on the Send push button.
Instead of the push button, you can also press the Enter key on
your keyboard.

Select push button allows you to select the equipment you are interested
in.

Exit push button exits the dialog box.

Command Line Window
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Once the Command Line window is displayed, you need to select the equipment you
want to communicate with. To select the equipment, click on the Select push button.
The Equipment Selection window, depicted in the following picture, will pop up.
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To select the equipment, use the Equipment Selection window as follows:

Equipment Type list box contains a list of all equipment types that support the com-
mand line mode of operation. To select the equipment type, click
on the appropriate name in the list. When you select the equip-
ment, the system will display a list of all units of the selected
equipment type in the Unit Name list.

Unit Name list box contains a list of all units of the selected equipment type.
The list changes as you select different equipment types from the
Equipment Type list.

Select push button selects the equipment unit. The Equipment Selection
window is removed from the screen and the selected unit is
handed over to the Command Line window.

Once you select the equipment, you are ready to begin your session with the selected
unit. At this point, the system will lock the selected unit for you. You will be the only
operator who can operate this unit until you close the Command Line window, or until
you select another unit. In addition, if the unit is on a dial-up line, the system will dial
out and connect to the unit.

You start your conversation with the unit by typing a command into the edit box in the
bottom left corner of the dialog box. Note that you don’t have to type the entire packet
that is actually sent to the unit. You type only the command itself. We will illustrate this
with the Site Sentry equipment2 and the SNMP query examples below.

A packet to get a full status report from a Site Sentry unit whose physical address is ‘A’,
has the following form:

UQAS<CR><LF>

In this line, the command to get the full status is ‘S’. The UQA is a packet header in
which ‘A’ is the unit address. The <CR><LF> marks the end of the packet. Once you
select the equipment, the system knows exactly how to communicate with it. This is
why you don’t have to type the entire line in the above example. All you need to type is:

S

The system will automatically add the rest. Once you type your command, you can
send it by pressing <ENTER> or by clicking on the Send button.

2. For details on the Site Sentry equipment, please refer to the Site Sentry supplement documentation.
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In the next example, let’s assume that you selected a computer that you want to mon-
itor using the SNMP protocol. To query the SNMP agent in the computer, you need to
specify the SNMP command, the community name, and one or more object IDs that
you want to query. However, because the system already knows the selected com-
puter name and community name, you need to enter only the SNMP command and
the object IDs you want to retrieve. To retrieve the status of an SNMP device, use

GET, GETNEXT and WALK commands3. For example:

WALK system

command will retrieve all objects under the system arch in the selected agent Manage-
ment Information Base (MIB). This is depicted in the following picture.

When you send your command to the unit, the command is displayed in the large,
scrollable working area of the dialog box. When the system gets the response from
the unit, it will display the response below your command. The unit response may
contain one or more lines.

3. For details on the SNMP support, please refer to the MACS SNMP supplement documentation.
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As you continue your dialogue with the unit, the working area of the window will start to
scroll. You can use the scroll bar on the right side of the window to scroll through the
sequence of your commands and responses.

Note that the length of your conversation with the unit is ultimately limited by the
amount of memory your computer can allocate for the contents of the scrolling
window.

6.2.2 Status Monitors

To access the list of status monitors, click the Monitors pull-down menu and select the
Status Monitor menu item.

Alternatively, click on the corresponding toolbar icon depicted in the picture below.

The Status Monitors dialog box pops up.

User-defined status monitors
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The dialog box has the following layout:

Monitor List is a scrollable list of all user-defined monitors in your system. To
select the monitor you are interested in, highlight the monitor
name and click on the Open push button.

Open push button opens the selected monitor window.

Exit push button closes the dialog box.

A typical user-defined monitor window is depicted in the following picture.
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6.2.3 Equipment Specific Monitors

The equipment-specific monitors show the selected unit operational status and allow
you to control the unit. The degree of control you can exercise over the equipment
depends on the equipment characteristics.

For example, in this software release there is no equipment-specific monitor for the
DMS switches. The Site Sentry units have equipment-specific monitors which allow
you to see the current status of all currently used points within the unit. The monitors
also allow you to operate relays in the Site Sentry unit, if the unit is equipped with the
output modules.

To open an equipment-specific monitor, you need to select the type of equipment you
want to monitor, and a particular unit you are interested in. When you select the unit,
the system dynamically creates an equipment-specific monitor window and displays it
on the screen.

To monitor a particular equipment unit, click the Monitor pull-down menu and select the
Equipment Specific Monitors menu item.

Alternatively, click on the corresponding toolbar icon depicted in the picture below.

The Equipment Selection dialog box has the following layout:

Equipment-specific status monitors
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Equipment Type list box contains a list of all equipment types being monitored by
your MACS. To select the equipment type, click on the appropri-
ate name in the list. When you select the equipment, the system
will display a list of all units of the selected equipment type in the
Unit Name list.

Unit Name list box contains a list of all units of the selected equipment type.
The list changes as you select different equipment types from the
Equipment Type list.

Select push button opens the equipment-specific monitor for the
selected equipment unit.

The following picture depicts a typical equipment-specific monitor. It shows a Site
Sentry4 unit named TORONTO SS2 equipped with some IO162P input modules, O16
output modules, RS2A serial port module and AN846 analog module.

4. Site Sentry is a programmable logic controller manufactured by Electralert Ltd. Site Sentry units are typically
used to monitor and control remote sites.
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The equipment-specific monitor knows the equipment and draws the equipment slots
and points based on the information found in the configuration database. In this
example, the monitor shows all points for the IO162P and O16 modules. The names of
all configured points are shown in the appropriate color, depending on the point opera-
tional status. Unused points are left blank. Site Sentry slots with no installed modules
are also left blank.

When you invoke a monitor window, all points are displayed using the latest status
information known to the system. From this point on, as the status of the points
change, the monitor will be updated accordingly. To force a status update you can
click on the Refresh button. Updating the equipment status may take some time,
especially when the equipment is connected via a dial-up line.

In the example above, there are two types of points: input points and output points.
The input points have two states: active and inactive. While monitoring the equipment,
you can only refresh the operational status of these points.
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The output points are usually relays. They can be set, reset or pulsed. In addition, you
can toggle the output point state. You can also refresh the output point operational
status.

To operate an output point, you need to select the point by pressing the small push
button displayed with the point name. To deselect the point, press the push button
again, or simply select another point. The currently selected point is marked with a red
square displayed in the push button.

Once you select the point, you can operate the point using the push buttons from the
toolbar displayed at the bottom of the window:

Set push button sets the point to its active state.

Reset push button resets the point to its inactive state.

Pulse push button pulses the point from its current state to the opposite
state and back to the initial state. The duration of the pulse is
equipment dependent.

Toggle push button changes the state of the point from the current state
to the opposite state.

Refresh push button refreshes the operational status of all points dis-
played within the monitor window. Note that, for the equipment on
dial-up lines, refreshing the operational status may require one or
more telephone calls.

6.2.4 MACS IO Monitors

MACS servers come with built-in opto isolated inputs and output relays. You can use
inputs to monitor equipment contact closures, and environment and security sensors.
You can use output relays to control heating, air conditioning, opening external gates,
acknowledging and silencing audible alarms and so on.

Depending on your exact requirements, you can order a MACS server with a combi-
nation of inputs and outputs that suits best your needs. Up to four slots in the MACS
server chassis can be populated with MACS IO plug-in boards. There are several
different boards that you can order, which provide the following IO combinations:

• 8 opto isolated inputs and 8 mechanical relays.

• 16 opto isolated inputs and 16 mechanical relays.

• 32 REED relays.
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Based on its configuration, the system will dynamically create an appropriate MACS IO
monitor for each slot. If more than one slot is used for MACS IO, the system will first
prompt you to select the slot you are interested in, and then open the appropriate
monitor for that slot.

To open a MACS IO monitor, you need to select MACS IO as the type of equipment
you want to monitor and then select the unit. There is always at most one MACS IO
unit in each server. Each unit may have up to four slots. When you select the unit, the
system dynamically checks if there is more than one slot, and if so, displays an interim
screen from which you select the slot. If there is only one slot, the system creates an
appropriate monitor window for that slot and displays it on the screen.

To open a MACS IO monitor, click the Monitor pull-down menu and select the
Equipment Specific Monitors menu item.

Alternatively, click on the corresponding toolbar icon depicted in the picture below.

The Equipment Selection dialog box has the following layout:

Equipment-specific status monitors
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If there is more than one MACS server in your system, you will see more than one
MACS IO unit on the list. When you click on the Select push button, the system will
determine whether the selected unit consists of more than one slot. For a single slot, it
will open an appropriate window right away. If there is more than one slot, the system
will display a window from which you can select the slot you are interested in:
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Depending on the selected slot type, you will see one of the windows described on the
following pages.

Various MACS IO slots offer several combinations of inputs and output points, or
output REED relays only. The input points have two states: active and inactive. While
monitoring the equipment, you can only refresh the operational status of these points.

The output points are either mechanical or REED relays. They can be set, reset or
pulsed. In addition, you can toggle the output point state. You can also refresh the
output point operational status.

To operate an output point, you need to select the point by pressing the small push
button displayed with the point name. To deselect the point, press the push button
again, or simply select another point. The currently selected point is marked with a red
square displayed in the push button.

Once you select the point, you can operate the point using the push buttons from the
toolbar displayed at the bottom of the window:

Set push button sets the point to its active state.

Reset push button resets the point to its inactive state.

Pulse push button pulses the point from its current state to the opposite
state and back to the initial state. The duration of the pulse is
approximately 500 milliseconds.

Toggle push button changes the state of the point from the current state
to the opposite state.

Refresh push button refreshes the operational status of all points dis-
played within the monitor window.

6.2.4.1 Slot With 8 Inputs and 8 Outputs

If you select a MACS IO slot with 8 inputs and 8 outputs, the system will display the
following monitor window:
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The top section of the monitor window shows the MACS server front panel, and two
rows of LEDs that indicate the status of all input and output points. Note that these
LEDs are represented in monitor windows only. They do not actually exist in the
MACS server itself. LEDs for the unused points are left blank. For the configured
points, active inputs and outputs are shown as red, while inactive inputs and outputs
are shown as green.

The bottom section of the monitor window contains two panels. The left hand panel
shows 8 input points. Unused points are left blank. Configured points are displayed
using colors and names that you selected through the configuration process.

The right hand panel shows 8 output points. Unused points are left blank and their
push buttons are disabled. Configured points are displayed using colors and names
that you selected through the configuration process. As explained above, you can
operate these points using the SET, RESET, PULSE and TOGGLE push buttons.

You can refresh the entire monitor window status using the REFRESH push button.
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6.2.4.2 Slot With 16 Inputs and 16 Outputs

If you select a MACS IO slot with 16 inputs and 16 outputs, the system will display the
following monitor window:

The operation of this monitor window is the same as the previously described one.
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6.2.4.3 Slot With 32 Outputs

This slot type has 32 REED relays and no inputs. For this slot type, the system will
display the following monitor window:

The top section of the monitor window shows the MACS server front panel, and two
rows of LEDs that indicate status of all output points. Note that these LEDs are repre-
sented in monitor windows only. They do not actually exist in the MACS server itself.
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LEDs for the unused points are left blank. For the configured points, active outputs are
shown as red, while inactive outputs are shown as green.

The bottom section of the monitor window contains two panels. The left hand panel
shows the first 16 output points, while the right hand panel shows the remaining 16
outputs. Unused points are left blank. Configured points are displayed using colors
and names that you selected through the configuration process. As explained above,
you can operate these points using the SET, RESET, PULSE and TOGGLE push
buttons. You can refresh the entire monitor window status using the REFRESH push
button.

6.3 Equipment Locking

Equipment locking is primarily used to ensure that only one operator can operate a
selected piece of equipment at a given point in time. For example, if you need to repair
a radio transmitter controlled by MACS, you will turn the RF power off and lock the
transmitter, such that no one else can accidentally turn the RF power on while the
repair is taking place.

Locking the equipment is also useful when you need to operate a remote piece of
equipment connected to MACS via a dial-up line. If you don’t lock the equipment,
MACS will dial out on each command that you send, get the response from the
equipment and hang-up. This optimizes telephone line usage and keeps the long
distance bills down, but can be very time consuming if you need to send many
successive commands to the equipment. If you lock the equipment, MACS will keep
the telephone line open as long as the equipment is locked. It will therefore execute
your sequence of commands much faster than when dialing out to execute each
individual command separately.

6.3.1 Lock Command

Equipment locking is done using the Equipment Lock command. To enter the Equip-
ment Lock command, click Equipment Locking pull-down menu and select Lock menu
item.
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Alternatively, click on the corresponding toolbar icon depicted in the picture below.

The Equipment Locking dialog box has the following layout:

The dialog box shows two lists. The list on the left hand side contains the names of all
equipment units which are not locked by your GUI. The list on the right hand side
contains a list of all equipment units which are presently locked by your GUI.

To lock a piece of equipment, highlight the name of the unit in the list of unlocked
units and click the Lock push button. To unlock a unit, select its name from the list of
locked units and click on the Unlock push button.

Lock push button locks the selected unit. If the unit is on a dial-up line,
the system will dial out, and keep the telephone line off the hook
as long as the unit is locked.

Unlock push button unlocks the selected unit. If the unit is on a dial-up
line, the system will hang up the telephone call and release the
dial-up line.

Exit push button closes the Equipment Locking dialog box.

Equipment locking
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6.4 Pager

Your MACS system can be equipped with a pager module, which automatically sends
alarm messages to a predefined list of page recipients. In addition to sending page
messages automatically, the system also allows you to manually compose and send
page messages.

6.4.1 Send Pager Message

The Send Message command is used to manually send page messages. To execute
this command, click on the Pager pull-down menu and select the Send Message item.

Alternatively, you can click on the pager icon.

Your MACS supports a multiple pager service. Thus, to send a message, first select
the pager service name. After that, select the user name or type the pager ID
manually. Finally, enter the text of your message and press the Send push button.

The Send Message dialog box has the following layout:

Send message
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Pager Name pull-down list allows you to select your destination pager service.
For example, your system could use one paging service in the
Toronto area, and other paging services in the Montreal and Van-
couver areas.

User Name pull-down list contains the names of all recipients associated with
the selected paging service. If you select a user name from the
list, the system will automatically fill the pager ID number in the
edit box below. If your recipient name does not appear on the list,
you can enter the pager ID number manually.

Pager Number field contains the pager ID number associated with the selected
recipient name. If your recipient is not preconfigured in the data-
base, you can enter the pager ID number manually.

Message Text edit box provides a field in which you type the text of the mes-
sage you wish to send.

Send push button sends a page. Once you select your recipient and
enter your message text, press this push button to send your
message.

Exit push button closes the Send Message dialog box.

6.5 Event Log

Each event report received from the equipment is stored into a log file. This feature
allows you to view and analyze all recorded alarm conditions and other events. The
system automatically creates and maintains log files on a daily basis. Since all event
reports are stored into files, the simplest way of analyzing events is to view log files.
While viewing a log file, you can search for specific keywords or text strings, such as
time stamps or equipment names. In addition, you can selectively print relevant
sections of the file, or the entire file.

Typically, MACS maintains only a single event log, managed by the Event Logger.
The event logger is an equipment module specifically designed to handle the event
log. Other equipment modules send their event reports to that event logger. However,
the system does allow for more than one logger, in which case you have to select
which logger files you want to examine.

In addition to the centralized event log, which contains the event reports from the
entire system, each equipment module can be configured to maintain its own event
log. Such a log will contain only the event reports from the equipment attached to that
equipment module.
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The system can maintain the ASCII event log, binary event log, or both. ASCII logs
contain less information, but may be viewed and analyzed using any text editor. Binary
logs contain more information and are better suited for the more complex processes
such as trend analysis, event correlation, and root cause rationalization. The View
Event Log command provides access to the ASCII log files.

6.5.1 View Event Log

The View Event Log command is used to view all event reports saved by the system
on a given date. To open a log file click on the Event Log pull-down menu and select
View Event Log.

Alternatively, you can click on the appropriate toolbar icon depicted in the following pic-
ture.

If your system is configured to maintain more than one event log, you will be prompted
to select the event log you want to examine:

View event log
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The pull-down list in the Select Event Log dialog box contains the names of all event
loggers in your system. Select the logger you are interested in and click the OK push
button. To exit the command without selecting the logger, click on the Cancel push
button.

Once you select the event log, the Select Event Log File dialog box will pop up on the
screen:

The Select Event Log File dialog box is a standard MS Windows dialog box that
allows you to open a file. In the scrollable working area, the box will show you all daily
event log files. Select the file you want to view and click on the Open push button.

Daily event log file names have the following format:

YYYY_MM_DD

where:

YYYY represents the year

MM represents the month

DD represents the day

When you select a file, the system will open the file using the WordPad text editor.
From within the editor, you can print the file, save it into another file, search for a
particular character string, cut and paste event reports, and performs other functions
typical of WordPad.
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An example of a log file format is depicted in the following picture.

6.6 Equipment Log

For some types of equipment, your MACS records all information exchanges with the
equipment in a separate set of files, referred to as the Equipment Log. The format of
data stored in these files is equipment dependent.

Typically, your system will be configured to maintain a separate equipment log for
each unit. Thus, to view the equipment log files, you will have to select the unit you are
interested in, and then to open a daily equipment log file.

To enter the View Equipment Log command click on the Event Log pull-down menu
and select View Equipment Log.
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Alternatively, you can click on the appropriate toolbar icon depicted in the following
picture.

When you enter the View Equipment Log command, the system will prompt you to
select the unit for which you want to examine the equipment log.

The Equipment Selection dialog box has the following layout:

Equipment Type scrollable list contains the names of all equipment types.
Remember that the equipment log is maintained only for some
equipment. If you select the equipment for which there is no
equipment log, the system will not find any equipment log files.

When you select the equipment type, the system will display the
names of all units of that type in the Unit Name list.

Unit Name scrollable list contains the names of all units of the selected
equipment type. As you change your equipment type selection,
the list of unit names is updated accordingly.

View equipment log
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Select push button confirms your equipment unit selection and closes
the window.

Cancel push button allows you to exit the View Equipment Log command
without selecting any equipment.

If the equipment log for the selected equipment cannot be found, the system will
display your current folder contents in a standard MS Windows dialog box. From this
point, you can manually select the folder that contains the equipment log you are inter-
ested in.

If your equipment unit selection is valid, the Select Equipment Log File dialog box will
pop up.

The Select Equipment Log File dialog box is a standard MS Windows dialog box that
allows you to open a file. In the scrollable working area, the box will show you all daily
equipment log files for the selected unit. Select the file you want to view and click on
the Open push button.

Daily equipment log file names have the following format:

YYYY_MM_DD

where:

YYYY represents the year

MM represents the month

DD represents the day
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When you select a file, the system will open the file using the WordPad text editor.
From within the editor, you can print the file, save it into another file, search for a
particular character string, cut and paste event reports, and perform other functions
typical of WordPad.

An example of a log file format is depicted in the following picture.

6.7 Viewing Options

The MACS user interface is a MS Windows application, similar in “look and feel” to
many other applications you are familiar with. As such, MACS GUI supports the
following standard MS Windows features:

• Toolbar docking

• Toolbar hide and show

• Status bar hide and show

• About box
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6.7.1 Toolbar Docking

You can use the toolbar docking to position the toolbar icons to any convenient spot
within the application main window. By default, the toolbar is docked along the top
edge of the window working area.

6.7.2 Toolbar Control

Like many other MS Windows applications, the MACS GUI allows you to show or to
hide the toolbar. By default, the toolbar is always shown and docked along the top
edge of the main application window. If you want to hide it, click on the View push
button, and then click on the Toolbar menu item. If the toolbar is hidden, click on the
same menu item to show it.

6.7.3 Status Bar

Like most MS Windows applications, the MACS GUI allows you to show or to hide the
status bar, which shows a single line help message at the bottom of the main appli-
cation window. By default, the status bar is always shown. If you want to hide it, click
on the View push button, and then click on the Status Bar menu item. If the status bar
is hidden, click on the same menu item to show it.

6.7.4 About Box

In MS Windows applications, the About box contains information on the product,
vendor and a copyright notice. To examine your MACS GUI About box, click on Help --
> About MACS.
87Micus Alarm and Control System



Commands
Alternatively, you can click on the Help icon:

The About dialog box layout will be similar to the one depicted in the following picture:

MACS GUI about box
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6.8 User’s Manual

You have the option of installing an on-line version of the MACS User’s Manual.
Should you choose to do this, you can read the manual from the screen, using the
Acrobat Reader5. For instructions on how to install your on-line manual, please refer to
Local User Interface Options in the Configuration chapter of this book. To open the on-
line User’s Manual click on the Help pull-down menu and select User’s Manual.

Alternatively, you can click on the User’s Manual icon:

6.9 Archive

During its operation, MACS will create a number of event log and equipment log files.
Over a period of time, MACS will collect a large amount of data, which requires careful
management and from time to time needs to be archived and reduced to the amount
of data you actually need for your day to day operation.

The MACS GUI offers a number of archive commands, which assist you in managing
your event log information. There are two groups of archive commands:

• Commands to copy files to another directory on the same computer or across the
network.

• Commands to delete old event log or equipment log files

Copy commands allow you to archive your event log files or equipment log files into a
directory of your choice. Your destination directory could be on the same computer or
on any other Windows NT workstation on your Microsoft Network.

5. The Acrobat Reader is a trademark of Adobe Systems Inc.

MACS User’s Manual
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Typically, you may want to keep on-line up to six months worth of event log files, and
to archive older log files. Once you archive your log files, you can remove the originals
from the MACS directories with delete commands.

Note that the MACS GUI does not provide any commands to archive log files on tape.
The reason for this is simple: the tape drive hardware usually comes with fairly sophis-
ticated backup software. Thus, we recommend that you do your tape backups using
the software that came with your tape drive.

MACS does not provide any database backup commands integrated with the GUI.
Database backup is typically done off-line, using configuration specific scripts.

6.9.1 Copy Event Log

MACS maintains its event log in a dedicated directory, where it creates one event log
file per day. Over a period of time, MACS will generate a number of daily event log
files. You may decide to keep on-line a month or two worth of log files and to archive
the rest. The Copy Event Log command allows you to copy your log files to another
directory. This directory may reside on another disk drive, a floppy, or on a network
drive on another computer on your network.

The Copy Event Log dialog box has two groups of controls: list of files and destination
directory. The first group allows you to select the log files that you want to archive,
while the second group allows you to specify the destination directory.

To copy log files, first select the time period, then click on the Select Files button. The
program will list all log files for the selected time period in a scrollable list box. Each
file is displayed with a checkbox, indicating whether to copy this file or not. Initially, all
checkboxes are checked. You can uncheck those files that you don’t want to copy.

Once you select your log files, you need to select a destination directory. The desti-
nation directory tree control initially shows all disk drives on your computer. When you
click on a particular drive, the program will open it and show the folders you have. By
clicking on folders, you can select subfolders until you reach your destination folder.

Searching the entire network can be a time consuming process. For this reason the
program does not initially show your network resources. If you want to copy your log
files to another computer, click on the Network button. The control will display other
Windows NT workstations on your Microsoft Network. Click on the computer of your
choice and select a disk drive and a folder. To start copying files, click on the Copy
button. You can stop the process by clicking on the Stop button.

To open the Copy Event Log dialog box, click on Archive -> Copy Event Log
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If your system is configured to maintain more than one event log, you will be prompted
to select the event log you want to archive:

The pull-down list in the Select Event Log dialog box contains the names of all event
loggers in your system. Select the logger you are interested in and click the OK push
button. To exit the command without selecting the logger, click on the Cancel push but-
ton.

Once you select the event log, the Copy Event Log dialog box will pop up on the
screen. The dialog box layout is depicted in the following picture:
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List of files box allows you to select the event log files to archive and to con-
trol the file copy process.

From date field contains the start date and time of the period for which you
want to archive log files. When specifying the date and time, use
the same format as initially displayed in the field.

To date field contains the end date and time of the period for which you
want to archive log files. When specifying the date and time, use
the same format as initially displayed in the field.

Select Files push button loads all event log files for the specified time period.

File list list box contains all event log files for the specified time period.
Each log file has a checkbox, which is initially checked. If you
don’t want to archive a particular file, you can deselect it by click-
ing on the checkbox.

Destination directory

list box contains a tree hierarchy of your disk drives and folders.
You can expand it to show your network resources as well, by
clicking on the Network button.
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Network push button adds your Microsoft Network resources to the initial
display of your local disk drives and folders.

Copy push button starts the process of copying selected files to the des-
tination directory.

Stop push button terminates the process of copying files.

Progress bar graphically indicates the progress in copying selected files to the
destination directory.

6.9.2 Copy Equipment Log

MACS maintains its equipment log in a set of dedicated directories, one per each unit
attached to the system. It creates one equipment log file per day for each of the units.
Over a period of time, MACS will generate a number of daily equipment log files. You
may decide to keep on-line a month or two worth of log files and to archive the rest.
The Copy Equipment Log command allows you to copy your log files to another
directory. This directory may reside on another disk drive, a floppy, or on a network
drive on another computer on your network.

To start with, you have to select an equipment log using the Equipment Selection
dialog box. Once you select the equipment, you can select the equipment log files you
want to archive.

The Copy Equipment Log dialog box has two groups of controls: List of files and Desti-
nation directory. The first group allows you to select the log files that you want to
archive, while the second group allows you to specify the destination directory.

To copy log files, first select the time period, then click on the Select Files button. The
program will list all log files for the selected time period in a scrollable list box. Each file
is displayed with a checkbox, indicating whether to copy this file or not. Initially, all
checkboxes are checked. You can uncheck those files that you do not want to copy.

Once you select your log files, you need to select a destination directory. The Desti-
nation directory tree control initially shows all disk drives on your computer. When you
click on a particular drive, the program will open it and show the folders you have. By
clicking on folders, you can select subfolders until you reach your destination folder.

Searching the entire network can be a time consuming process. For this reason, the
program does not initially show your network resources. If you want to copy your log
files to another computer, click on the Network button. The control will display other
Windows NT workstations on your Microsoft Network. Click on the computer of your
choice and select a disk drive and a folder. To start copying files, click on the Copy
button. You can stop the process by clicking on the Stop button.
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To enter the Copy Equipment Log command, click on Archive -> Copy Equipment
Log.

The system will prompt you to select the unit for which you want to archive the
equipment log.

The Equipment Selection dialog box has the following layout:

Equipment Type scrollable list contains the names of all equipment types.
Remember that the equipment log is maintained only for some
equipment. If you select equipment for which there is no equip-
ment log, the system will not find any equipment log files.

When you select the equipment type, the system will display the
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names of all units of that type in the Unit Name list.

Unit Name is a scrollable list that contains the names of all units of the
selected equipment type. As you change your equipment type
selection, the list of unit names is updated accordingly.

Select push button confirms your equipment unit selection and closes
the window.

Cancel push button allows you to exit the Copy Equipment Log command
without selecting any equipment.

If the equipment log for the selected equipment cannot be found, the system will not
list any equipment log files. If your equipment unit selection is valid, you can use the
Copy Equipment Log dialog box to archive your files.

List of files allows you to select the equipment log files to archive and to con-
trol the file copy process.

From date contains the start date and time of the period for which you want
to archive log files. When specifying the date and time, use the
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same format as initially displayed in the field.

To date contains the end date and time of the period for which you want
to archive log files. When specifying the date and time, use the
same format as initially displayed in the field.

Select Files loads all equipment log files for the specified time period and for
the selected unit.

File list contains all equipment log files for the specified time period. Each
log file has a checkbox, which is initially checked. If you don’t
want to archive a particular file, you can deselect it by clicking on
the checkbox.

Destination directory

contains a tree hierarchy of your disk drives and folders. You can
expand it to show your network resources as well, by clicking on
the Network button.

Network adds your Microsoft Network resources to the initial display of
your local disk drives and folders.

Copy starts the process of copying selected files to the destination
directory.

Stop terminates the process of copying files.

Progress bar graphically indicates the progress in copying selected files to the
destination directory.

6.9.3 Delete Event Log

Over a period of time, MACS will create a number of daily event log files. You may
decide to keep on line a month or two worth of event log files and to archive the rest.
First, use the Copy Event Log command to copy old event log files to your archive
media. After that you can use the Delete Event Log command to remove the originals.

Your MACS can be configured to maintain more than one event log. In such case, the
system will prompt you to select the event log from which you want to delete files.

To delete event log files, first select the time period, then click on the Select Files
button. The program will list all event log files for the selected time period in a scrol-
lable list box. Each file is displayed with a checkbox, indicating whether to delete this
file or not. Initially, all checkboxes are checked. You can uncheck those files that you
don’t want to delete.

Once you select the event log files to delete, click on the Delete button. You can stop
the process by clicking on the Stop button.
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To open the Delete Event Log dialog box, click on Archive -> Delete Event Log

If your system is configured to maintain more than one event log, you will be prompted
to select the event log you want to delete files from:

The pull-down list in the Select Event Log dialog box contains the names of all event
loggers in your system. Select the logger you are interested in and click the OK push
button. To exit the command without selecting the logger, click on the Cancel push but-
ton.

Once you select the event log, the Delete Event Log dialog box will pop up on the
screen. The dialog box layout is depicted in the following picture:
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List of files allows you to select event log files to delete.

From date contains the start date and time of the period for which you want
to delete event log files. When specifying the date and time, use
the same format as initially displayed in the field.

To date contains the end date and time of the period for which you want
to delete event log files. When specifying the date and time, use
the same format as initially displayed in the field.

Select Files loads all event log files for the selected time period.

File list contains all event log files for the specified time period. Each file
has a checkbox, which is initially checked. If you do not want to
delete a particular file, deselect it by clicking on the checkbox.
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Delete button starts the process of deleting the selected files. When you
click on the button, the program prompts you with the query:

If you are sure that you want to delete the selected event log files,
click on Yes. Otherwise, click on No.

Stop terminates the process of deleting event log files.

Progress bar graphically indicates the progress deleting the selected event log
files.

6.9.4 Delete Equipment Log

If configured to maintain the equipment log, your MACS will, over a period of time,
create a number of daily equipment log files. You may decide to keep on line a month
or two worth of equipment log files and to archive the rest. First, use the Copy
Equipment Log command to copy old equipment log files to your archive media. Then,
you can use the Delete Equipment Log command to remove the originals.

Your MACS will maintain a separate equipment log for each unit that requires an
equipment log. Thus, before deleting the files, you have to select the equipment log
from which you want to delete files.

To delete equipment log files, first select the time period, then click on the Select Files
button. The program will list all equipment log files for the selected time period in a
scrollable list box. Each file is displayed with a checkbox, indicating whether to delete
this file or not. Initially, all checkboxes are checked. You can uncheck those files that
you do not want to delete.

Once you select the equipment log files to delete, click on the Delete button. You can
stop the process by clicking on the Stop button.

To enter the Delete Equipment Log command, click on Archive -> Delete Equipment
Log.
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The system will prompt you to select the unit for which you want to delete the
equipment log files.

The Equipment Selection dialog box has the following layout:

Equipment Type scrollable list contains the names of all equipment types.
Remember that the equipment log is maintained only for some
equipment. If you select the equipment for which there is no
equipment log, the system will not find any equipment log files.

When you select the equipment type, the system will display the
names of all units of that type in the Unit Name list.
100 Micus Alarm and Control System



Commands
Unit Name scrollable list contains the names of all units of the selected equip-
ment type. As you change your equipment type selection, the list
of unit names is updated accordingly.

Select push button confirms your equipment unit selection and closes
the window.

Cancel push button allows you to exit the Delete Equipment Log com-
mand without selecting any equipment.

If the equipment log for the selected equipment cannot be found, the system will not
list any equipment log files. If your equipment unit selection is valid, you can use the
Delete Equipment Log dialog box to delete the selected files. The dialog box layout is
depicted in the following picture:
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List of files box allows you to select equipment log files to delete.

From date fields contains the start date and time of the period for which you
want to delete equipment log files. When specifying the date and
time, use the same format as initially displayed in the field.

To date field contains the end date and time of the period for which you
want to delete equipment log files. When specifying the date and
time, use the same format as initially displayed in the field.

Select Files push button loads all equipment log files for the selected time
period.

File list box contains all equipment log files for the specified time period.
Each file has a checkbox, which is initially checked. If you don’t
want to delete a particular file, deselect it by clicking on the
checkbox.

Delete push button starts the process of deleting the selected files.
When you click on the button, the program prompts you with the
query:

If you are sure that you want to delete the selected equipment log
files, click on Yes. Otherwise, click on No.

Stop push button terminates the process of deleting equipment log
files.

Progress bar graphically indicates the progress deleting the selected equip-
ment log files.
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6.10 Configuration

Your MACS is a highly modular system. You can pick and chose the equipment
modules that you need to support your own equipment. You can also select a number
of optional components, such as paging, e-mail, trouble ticketing and others. Each of
these modules comes with a configuration utility program specifically designed for that
module.

To hide the complexity of so many different programs, MACS presents all of them in a
list of configuration utilities and provides a dialog box that allows you to select and
launch the utility you need. As a result, you will perceive MACS configuration utilities
as an integral part of the main user interface program, and you will not be even aware
that you are actually using a separate program.

6.10.1 Select Utility

To launch a configuration utility, click on the Configuration pull-down menu and select
Select Utility.

Alternatively, you can click on the appropriate toolbar icon depicted in the following
picture.

The Configuration Utilities dialog box will pop up, and present you with a list of configu-
ration utilities:

Select MACS configuration utility
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The Configuration Utilities dialog box has the following layout:

List of Utilities scrollable list box contains descriptive names of all MACS config-

uration utilities available from your GUI6. To launch the utility that
you need, highlight the utility name and click on the Open push
button, or simply doubleclick on the utility name.

Open push button actually launches the utility highlighted in the List of
Utilities.

Cancel push button closes the dialog box without launching any configu-
ration utility.

Instructions on how to use some of the common configuration utilities are described in
the Configuration chapter of this book. Configuration specific to the individual
equipment modules is documented in the supplement manuals that come with each
equipment module.

6. Your system administrator may decide not to provide all of these utilities to all users. In such case, only a subset
of utilities will appear on the list, if any.
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6.10.2 Configuration Options

There are a few configuration options that you can set locally to apply only to your own
workstation. These options are:

• Sounds to play upon receiving event reports.

• User’s manual on-line setup

To set these options, click on the Configuration menu and select Options:

The User Interface Options dialog box has the following layout:

Critical alarm sound edit box allows you to specify which wave file to play upon receiv-
ing an event report with the critical severity level. If you leave this
edit box blank, no sound will be played upon receiving a critical
alarm.

Major alarm sound edit box allows you to specify which wave file to play upon receiv-
ing an event report with the major severity level. If you leave this
edit box blank, no sound will be played upon receiving a major
alarm.
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Minor alarm sound edit box allows you to specify which wave file to play upon receiv-
ing an event report with the minor severity level. If you leave this
edit box blank, no sound will be played upon receiving a minor
alarm.

Warning sound edit box allows you to specify which wave file to play upon receiv-
ing an event report with the warning severity level. If you leave
this edit box blank, no sound will be played upon receiving a
warning message. Typically, no sounds are used for the warning
messages.

On-line User’s Manual

edit box contains a valid command line which, when executed
displays the on-line MACS User’s Manual.

OK push button saves the settings and closes the dialog box.

Cancel push button closes the dialog box without saving the settings.
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7 Configuration

Before you start using your MACS, you need to configure it for your particular applica-
tion. All relevant MACS parameters are field-configurable. System configuration
includes the type of equipment connected to the computer, number of units connected
to each serial port, polling intervals, point definitions, networking parameters and more.
System configuration is done using a set of configuration utilities, all of which are
based on a consistent, user friendly GUI. This chapter illustrates the MACS configura-
tion process, and shows how to configure commonly used MACS modules.For details
on the equipment-specific configuration, consult the equipment-specific supplement
documentation, provided with individual equipment modules.

7.1 Color Configuration

Before configuring anything else, we suggest that you start with defining color combi-
nations you wish to use when presenting equipment status on the computer screen.

MACS presents status and control points and text messages using combinations of
foreground and background colors. You can define as many colors as you want,
MACS does not impose any limitation on the number of colors. As you define your
color combinations, you assign them descriptions, such as BLACK ON GRAY or
CRITICAL ALARM. Later on, when you define your alarm points, you will use this
description to select colors to be used for active alarm points, inactive alarm points
and warning messages.

You can add, modify, and delete all of your color definitions. As a minimum, the
system requires the following colors to be defined:

• DEFAULT CRITICAL

• DEFAULT MAJOR

• DEFAULT MINOR

• DEFAULT WARNING

When you start defining your own colors, you will see that these four color definitions
already exist in your configuration. You can change foreground and background
combinations assigned to these colors, but you cannot delete them.
107Micus Alarm and Control System



Configuration
To define your own colors, you will use the MACS configuration utility called ColorCfg.
Note that configuration utilities may not be installed on all workstations used to
operate MACS. In this chapter we assume that configuration utilities are installed on
your workstation.

7.1.1 Starting Colors Configuration Utility

You can start the ColorCfg configuration utility from your GUI, from the Windows Start
menu or from the Windows Explorer. To start it from the GUI, select Configuration ->
Select Utility pull-down menu, or click on the Configuration toolbar icon.

The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select Color Definitions and click on the Open push button, or simply doubleclick on
the Color Definitions name. The main Color Definitions dialog box will pop up on the
screen.
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To start the Colors utility from the Windows Start menu, click on Start -> Programs ->
MACS -> Colors, as shown in the following picture.
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The main MACS Color Definitions dialog box is depicted in the following figure:

The dialog box has the following layout:

Modify push button allows you to modify an existing color definition.

Add push button allows you to add a new color definition to your con-
figuration database.

Delete push button allows you to delete an existing color definition.

View push button allows you to view a list of all color definitions.

Preview Box shows you the selected color definition foreground and back-
ground color and blinking.

Exit push button exits the ColorCfg configuration utility.

7.1.2 Color Selection

You need to define a foreground color and a background color either when adding a
new color definition, or when modifying an existing color definition. To modify an
existing color definition, select the color name and click on the Modify push button. To
add a new color, click on the Add push button.
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When defining or modifying the foreground and background colors, the program
displays a standard Windows dialog box, used to select colors. If you intend to use
your color definition for graphics only, you can select any color that you want. If you
are creating a color definition to be used for text messages, you must select a solid
color, because Windows accepts only solid colors when displaying text.

7.1.3 Color Descriptions

Each color that you define has a description. Typically, you will either describe the
color itself, as in BLUE ON GREEN, or you will describe the condition you intend to
use this color for, as in CRITICAL ALARM.

There are some color descriptions which must exist within the system and you cannot
modify them. These descriptions are:

• DEFAULT CRITICAL

• DEFAULT MAJOR

• DEFAULT MINOR

• DEFAULT WARNING

When you select one of these color definitions and open the Modify Color dialog box,
the color description field will be grayed out.
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7.1.4 Add Color

To add a new color definition, click on the Add push button in the main dialog box.
The Add Color dialog box, depicted in the figure below, will pop up. The dialog box
has the following layout.

Description is an edit box provides a space on which you type in your new
color description. As you edit description, the preview box will
show your newly entered description text.

Blinking check box determines whether the color will blink when displayed
on the screen. Note that blinking applies only to the graphical
images. Text screens, such as the GUI main window, do not sup-
port blinking.

Foreground is a push button that opens a standard Windows dialog box to
select colors, described on the previous pages. When you select
the foreground color and close the Foreground Color dialog box,
the preview box will display the color description using the newly
selected foreground color.

Background is a push button that opens a standard Windows dialog box to
select colors, described on the previous pages. When you select
the background color and close the Background Color dialog box,
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the preview box will display the color description using the newly
selected background color.

Preview Box shows you the new foreground and background color combina-
tion, and blinking.

OK push button saves the new color definition and closes the Add
Color dialog box.

Cancel push button closes the Add Color dialog box without saving the
new color definition.

An example of a new color definition is shown in the following picture.

To save the new color definition, click on the OK push button. To exit the dialog box
without creating a new color definition, click on Cancel.

7.1.5 Modify Color

To add an existing color definition, select the color description and click on the Modify
push button in the main dialog box. The Modify Color dialog box has the same layout
as the Add Color dialog box described on the previous pages.
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7.1.6 Delete Colors

To delete an existing color definition, select it from the main dialog box list, and click
on the Delete push button. The program will display the following prompt:

Before deleting any color, ensure that the color is not assigned to any status and
control messages and/or graphical screens.

There are some color definitions which must exist within the system and you cannot
delete them. These definitions are:

• DEFAULT CRITICAL

• DEFAULT MAJOR

• DEFAULT MINOR

• DEFAULT WARNING

If you attempt to delete any of these definitions, the program will display the following
prompt:
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7.1.7 View Colors

To view a list of all color definitions, click on the View push button in the main dialog
box. The program will create a text report with details on all color definitions, and
present the report using the WordPad text editor.

From within the editor, you can search for the specific color description, cut and paste
parts or the entire report, print it or save it into a text file, and perform other functions
typical of WordPad. A typical report layout is presented in the following picture.
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7.2 Event Logger Configuration

In its standard configuration, MACS maintains a centralized event log, which contains
event reports reported by all system components. The event log is a set of text files1,
automatically created on a daily basis. These files are created by the dedicated
component of the MACS, referred to as the Event Logger.

The Event Logger is a Windows NT service, specifically designed to do the following:

• To create a new event log file every day at midnight

• To append all new event reports to the current log file

• To accept login and logout requests from the MACS users on the network

• To forward event reports to all active user interfaces, and to other MACS modules
such as the pager service or trouble ticketing service

Your MACS system consists of the equipment modules and user interface GUIs. The
equipment modules monitor the attached equipment and detect alarm conditions and
changes in the equipment status. On each alarm or status change, the equipment
modules generate event reports. Typically, the equipment modules are configured to
send their event logs to the Event Logger2. The Event Logger saves these event
reports into the event log and sends them to all active GUIs and to other components,
such as the pager and trouble ticketing components. This scenario is depicted in the
following figure.

1. In this software revision, the system can actually maintain the text event log, binary event log or both. At the
present time, the system provides tools to view and search only the text log. The binary log is for future use, for
features such as graphs, trend analysis, etc.

2. In its minimal configuration, MACS consists of a single equipment module and only one GUI. In such case there
is no need for the Event Logger.
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To enable the Event Logger to perform its functions, you need to configure the
following parameters:

• The name you want to use for the Event Logger service

• The name of the computer on which the Event Logger runs

• The TCP/IP protocol port to use for the Event Logger service

• The path to the event log files

• Event reporting destinations

The following pages show how to configure these parameters.

To configure your Event Logger, use the event logger configuration utility program
LogCfg. Depending on the way your system is administered, this utility may or may not
be accessible from the MACS main GUI3.
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To access the event log configuration utility from your workstation desktop, click on
Start -> All Programs -> MACS ->LogCfg.

3. Some network administrators do not want to make configuration utilities accessible to all users. In such cases,
these utilities are installed only on the workstations used by the system administrators. Others prefer to make
configuration programs accessible from the MACS main user interface. The choice is yours, and the way you
access configuration utilities is a field-configurable option.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI4, you can also start the event logger configuration utility by selecting
configuration utilities from the Configuration -> Select Utility pull-down menu or by
clicking the Configuration button on the toolbar.

The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select Event Log Configuration and click on the Open push button, or simply double-
click on the Event Log Configuration name. The main Event Log Configuration dialog
box will pop up on the screen.

Conceptually, MACS could be configured to maintain more then one event log. The
Event Log Configuration utility will allow you to add more than a single Event Logger to
your system. For example, if you have more than one MACS server, then each server
could maintain its own event log. This configuration is frequently used in configurations

4. How to add configuration utilities to the MACS main GUI is explained later in this document, in Access To Config-
uration Utilities.
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where regional MACS server report to a master MACS server in a central location.
However, most of the systems use a single event log.

When you run the utility, the list box on the left hand side will show all presently
configured event loggers. When you run the utility for the first time, the list box will be
empty, and you will have to add your Event Logger to the system. Once your Event
Logger is configured, the Event Log Configuration utility will allow you to view and to
modify that configuration.

The Event Log Configuration utility main dialog box is depicted in the following picture:

The push buttons and other functions are:

Configure Server allows you to modify configuration of an already configured event
logger.

Add Server allows you to add a new event logger to your system configura-
tion.

Delete Server allows you to delete an existing event logger from your system
configuration.

Event Reporting allows you to specify computers and programs on your network
that will receive event reports from the event logger being config-
ured.

View Server allows you to create a text report that contains event logger’s
present configuration.

Exit exits the Event Log Configuration utility.
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7.2.1 Add Event Logger

When you run the Event Log Configuration utility for the first time, the list of existing
event loggers will be empty, and you will have to add a new event logger to your
system configuration.

To add a new event logger, click on the Add Server button in the Event Log Configu-
ration main dialog box, and the Add Event Log Server dialog box will appear:

The Add Event Log Server dialog box has the following layout:

Server name edit box allows you to specify the name of your event logger. This
name will appear in all event reports originated by the event log-
ger.

The name you select must be the same as the name you speci-
fied while installing the event logger Windows NT service. The
event logger Windows NT service uses this name on startup, to
query its configuration from the database. If there is a mismatch in
names, the service will not find its configuration and will not start
properly.
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Computer name edit box allows you to specify the name of the computer your
event logger will run on. This name is used, in conjunction with
the protocol port, by other computers and programs on your net-
work to establish a TCP/IP connection with your event logger.

Protocol port edit box allows you to specify the TCP/IP protocol port your event
logger will listen to service requests from other computers and
programs on your TCP/IP network.

Text Event Log check box allows you to select whether your event logger will
maintain the text event log. This box is normally checked, which
means that the event logger will create and maintain a set of daily
created event log text files.

Text log path edit box allows you to specify the fully qualified path to the folder
which will contain the event log text files.

Binary Event Log check box allows you to select whether your event logger will
maintain the binary event log. This box is normally unchecked,
which means that the event logger will not create and maintain a
set of daily created event log binary files. Note that to use and
analyze the binary event log, you need a special set of tools,

which are not part of our standard MACS product5.

Binary log path edit box allows you to specify the fully qualified path to the folder
which will contain the event log binary files.

The path you use to access your event log files may take one of the following two
forms.

• If you run your MACS on a single workstation, you could specify the path such as
C:\MACS\Log. Make sure that the folder you specify exists, and that MACS
programs have full access rights to that folder.

• If you use your MACS in a multiuser environment, in which you want to access
your event log from other workstations on the network, you must specify a fully
qualified network path to your event log folder. For example, if the MACS server
name is PLATO, you path could be \\PLATO\MACS\Log. In such cases, make
sure that the MACS folder is a shared network resource, and that MACS programs
have full access to that folder.

When you use a fully qualified network path, you have to make sure that your MACS
services run from an account that have access to the network resources. By default,

5. The binary event log is intended for the trend analysis, graphing analog processes and other functions. These
tools will be offered by Micus Real Time Software Inc. with part of future releases of the MACS product.
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MACS services run under the Windows NT system account LocalSystem, with inter-
action with desktop enabled. This account is appropriate if you use MACS on a single
computer. However, for security reasons, the Windows NT LocalSystem account does
not have access to the network resources. Thus, if you specify a network path to your
event log folder, and you run the Event Logger under the LocalSystem account, the
Event Logger will not be able to create and write into the event log files.

To examine your Event Logger Windows XP service setup, open the Administrative
Tools from the Control Panel, and then the Windows XP Service Manager located in
the Administrative Tools.

Highlight the MACS Event Logger service and click on the right button. Select
Properties. You will see your Event Logger service configuration as depicted in the
following picture.
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To select an account under which you want the service to run, click on the Log On tab.
Then specify the account name and password. Remember, if you change the account
password in the future, you will have to change it in these service properties as well.
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To examine your Event Logger Windows NT service setup, open the Windows NT
Service Manager from the Control Panel. Highlight the MACS Event Logger service
and click on the Startup button. You will see your Event Logger service configuration
as depicted in the following picture.

To configure your Event Logger for the multiuser environment, change the Log On As
data to another account, such as MACS, and make this account a member of the
Administrators group.
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7.2.2 Configure Event Logger

The Configure Server command allows you to change an existing event logger config-
uration. In the current MACS software release, the event logger configuration changes
take effect on the first subsequent Windows NT service startup. Therefore, after
making changes in your Event Logger configuration, make sure to restart the corre-
sponding Windows NT service.

To change the configuration of an existing event logger, highlight the event logger
name in the list, and click the Configure Server push button in the Event Log Configu-
ration utility main dialog box.

The Modify Event Log Configuration dialog box has the same layout as the Add Event
Logger, described on the previous pages.
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7.2.3 Delete Event Logger

To delete an existing event logger configuration, highlight the name of the event
logger you want to delete, and click on the Delete Server push button in the Event Log
Configuration utility main dialog box.

The following dialog box will pop up:

To delete the selected event logger, click on the Yes push button. To exit the dialog
box without deleting the event logger, click on the No push button.

7.2.4 Event Reporting

One of the main Event Logger responsibilities is to dispatch event reports to all other
MACS components that need to receive and process the event reports. Examples of
these components are:

• MACS GUIs, running on the MACS server itself, and on any number of other
workstations on the network

• Pager service

• Trouble ticketing service

MACS GUIs log into the Event Logger and log out of it dynamically. You do not have
to configure your Event Logger to accept login from GUIs. Other MACS components,
such as pager and trouble ticketing, require the Event Logger to forward event reports
to their respective network locations.

For example, if you run your pager service on the workstation called ICIUS, and you
configure your pager service to listen to the TCP/IP protocol port 4464, you will have
to configure your Event Logger to forward all event reports to the computer ICIUS,
and to the protocol port 4464.

To configure your event report forwarding, select your event logger from the list in the
Event Log Configuration utility main dialog box, and click on the Event Reporting push
button.
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The Event Reporting dialog box has the following layout:

MACS Recipients list contains all possible event reportrecipients known to your
MACS system. You can select your event report recipient from
that list, or you can enter it manually in the Computer Name and
the Protocol Port fields.

Computer name edit box allows you to enter the destination computer name.
When you select your recipient from the MACS Recipients list, the
Computer Name field is filled in automatically.

Protocol Port edit box allows you to enter the destination TCP/IP protocol port.
When you select your recipient from the MACS Recipients list, the
Protocol Port field is filled in automatically.

Selected Recipients contains a list of all already configured recipients. These are the
destinations to which your event logger will send event reports.

Add push button allows you to add a new event report recipient to the
Selected Recipients list. To add a new recipient, select it from the
MACS Recipients list, or enter the computer name and the proto-
col port manually. Then click on the Add push button.
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Delete push button allows you to delete an entry from the Selected
Recipients list. To delete a recipient, highlight it in the Selected
Recipients list and click the Delete push button.

Exit push button closes the Event Reporting dialog box.

When you add a destination to the Selected Recipients list, make sure that the corre-
sponding service is actually running at the specified location on your network. If the
service is not running, your event logger will attempt to connect to this service on each
event report, and time out after several seconds. This delay will severely impede the
overall MACS performance. If you decide not to use a particular event report recipient
for a period of time, make sure to take it off of the Selected Recipients list, and to
restart your Event Logger Windows NT service.

7.2.5 View Event Logger

To view your Event Logger present configuration, select your event longer from the
list in the Event Log Configuration utility main dialog box, and click on the View Server
push button.

The system will create a report and present it as a text file using the WordPad text
editor. Using the editor, you can save the report in a file, print it, cut and paste the text
and perform other functions typical of WordPad. The report layout is depicted in the
following picture.
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7.3 Graphical User Interface Configuration

In order to display event reports, update graphical images and execute operator
commands, MACS Graphical User Interface (GUI) must login into the MACS system.
To log in, the GUI establishes a network connection with the MACS event logger and
requests that the event logger forwards all future event reports to that GUI.

The event logger places the GUI on its internal list of all user interfaces active on the
network, and continues to send event reports to that GUI until it receives a logout
request from the GUI.

Typically, MACS has only one event logger. However, in large installations, you may
have more than a single event logger. For example, if your monitoring system covers a
large geographical area, you may have a number of regional MACS servers and the
main MACS server in a central location. In such a scenario, your regional servers will
have their own event loggers, while the server in the central location will collate event
reports from all regional servers into its own main event log.

To support multi-server configurations, you can configure your GUI to log in to one or
more event loggers. Furthermore, you can configure your GUI to login automatically on
startup, or you can login manually, while the GUI is already running.

GUI login options are setup for each workstation individually. This means that you can
selectively allow or disallow access to MACS server from one workstation to another. If
you have regional MACS servers, you can also selectively allow access to each
regional server from individual workstations.

In a multi-server environment, you may have a common database shared among the
servers, or each server may have its own database. Thus, you can define a list of
MACS nodes and specify which database to use for each node. When the GUI starts,
by default it opens the database it was connected to during the last session. Once you
start your GUI, you can dynamically switch from one database to another.

To configure access to your MACS from the individual workstations on your network,
you will use the User Interface Configuration Utility program MenuCfg. Depending on
the way your system is administered, this utility may or may not be accessible from the
MACS main GUI.6

To access the user interface configuration utility from your workstation desktop, click
on Start -> All Programs -> MACS ->MenuCfg.

6. Some network administrators do not want to make configuration utilities accessible to all users. In such cases,
these utilities are installed only on the workstations used by the system administrators. Others prefer to make
configuration programs accessible from the MACS main user interface. The choice is yours, and the way you
access configuration utilities is a field-configurable option.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI7, you can also start the user interface configuration utility by
selecting configuration utilities from the Configuration -> Select Utility pull-down menu
or by clicking the Configuration button on the toolbar.

7. How to add configuration utilities to the MACS main GUI is explained later in this document, in Access To Con-
figuration Utilities.
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The Configuration Utilities dialog box will pop up and present you with a list of all
configuration utilities accessible from your GUI.

Select the User Interface Configuration and click on the Open push button, or simply
doubleclick on the User Interface Configuration name. The main User Interface
Configuration dialog box will pop up on the screen.

The dialog box layout consists of two list boxes and the push buttons used to add,
modify, delete and view entries and to exit the configuration program.

The list box on the left hand side of the dialog box contains the names of all worksta-
tions that have access to the MACS. You can add new workstations to that list to allow
their users to access the MACS, or you can delete the existing to deny access to the
MACS.
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When you select a workstation name in the list, the list box on the right hand side of
the dialog box will show all event loggers to which the selected workstation has
access to. Typically, all workstations will have access to a single event logger.
However, in the multi-server MACS configurations, you may see more than one entry
in the right hand side list box.

GUI Computer scrollable list allows you to select the workstation for which you
want to configure MACS user interface.

Event Source scrollable list allows you to select the event logger that you want
access from the selected workstation.

Add GUI push button allows you to add a new workstation to the list, thus
allowing this workstation to login into your MACS system.

Modify GUI push button allows you to modify the selected workstation config-
uration.

Delete GUI push button allows you to delete a workstation from the list, thus
disallowing login access to MACS to that workstation.

View GUIs push button allows you to create and view a text report that con-
tains a list of all presently configured workstations.

MACS Nodes push button opens a dialog box, which allows you to manage
your list of MACS nodes.

Exit push button exits the user interface configuration utility program.
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7.3.1 Add User Interface

To grant MACS login access to a new workstation, click on the Add GUI push button.
The Add User Interface dialog box will pop up on the screen. This dialog box has the
following layout.

GUI computer name

pull down list contains all workstations, that presently have login
access to the MACS. If you are adding a new workstation, just
type in your new workstation name. If you want to grant access to
a workstation already on the list, select the workstation name from
the list.

The TCP/IP networking must be able to translate the workstation
name into an IP address of the nnn.nnn.nnn.nnn form. If you don’t
have the Domain Name System (DNS) service for your network,
make sure that all of your workstation and server names appear in
the etc/hosts file, which provides static name resolution for your
TCP/IP network.

Event logger service name

pull down list contains all presently configured event loggers. This
list allows you to select the event logger for which you want the to
grant access. On smaller MACS installations, you will typically
have only a single name on that list. If your MACS consists of sev-
eral regional event loggers, you will see all of their names in the
list.

Event logger computer name

pull down list contains all presently configured MACS servers.
This list allows you to specify the name of the computer on which
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the event logger service runs. On smaller MACS installations,
you will typically have only a single name on that list. If your
installation consists of several MACS servers, you will see all of
their names in the list. If you are adding a new server, just type in
your new server computer name. If you want to grant access to a
server already on the list, select the computer name from the list.

Event logger protocol port

edit box allows you to enter the TCP/IP protocol port to use when
connecting to the selected event logger.

Connect on startup

check box determines whether the GUI running on a workstation
being configured will login to the specified event logger automati-
cally upon startup. Typically, if you have only a single event log-
ger, you will configure the GUI to login automatically. If you have
more than one event logger to monitor, you may prefer to login to
each of them manually.

Note that your GUI can login to any number of event loggers
simultaneously. In such cases, your GUI will collate events from
all loggers being monitored.

Save push button allows you to grant a specified workstation access to
the selected event logger and close the dialog box.

Exit push button allows you to exit the dialog box without changing a
workstation access to MACS.

7.3.2 Modify User Interface

The Modify User Interface command allows you to change an existing user interface
configuration. To change the configuration of an existing user interface, highlight its
workstation name in the GUI Computer list, select the event source in the Event
Source list, and then click the Modify GUI push button.

The Modify User Interface dialog box has the same layout as the Add User Interface
dialog box.

7.3.3 Delete User Interface

To disallow login access to a workstation, highlight the workstation name in the left
hand side list box, and then highlight a particular event logger name in the right hand
side list box. Then, click on the Delete push button. The program will delete the
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selected event logger name from the list. Once there are no more event loggers
assigned to the selected workstation, the program will also delete the workstation
name from the left hand side list.

If you have only one event logger in your system, then deleting access to that logger
will also delete the workstation name from the list.

7.3.4 View User Interfaces

To view your present user interfaces configuration, click on the View GUIs push
button.

The system will create a report and present it as a text file using the WordPad text
editor. Using the editor, you can save the report in a file, print it, cut and paste the text,
and perform other functions typical of WordPad. The report layout is depicted in the
following picture.

7.3.5 MACS Nodes Configuration

Your installation may consist of one or more MACS servers. Since MACS is a fully
distributed system, even individual MACS services may be installed on different
computers. For example, your equipment modules and event logger may be installed
on one computer, while your email and pager services may reside on another
computer. Servers and other computers on which MACS services run are referred to
as MACS nodes.
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While configuring your system, you must instruct your GUIs which network address
and which database to use when accessing a given MACS node, and where to find
bitmap drawings and executable programs. MACS nodes are configured using the
User Interface Configuration Utility.

To configure your list of MACS nodes, click on the MACS Nodes push button. The
MACS Node Selection dialog box will pop up on the screen. This dialog box has the
following layout.

The scrollable list box on the left hand side contains all presently configured MACS
nodes. Each entry consists of the name of the MACS node and the name of the host
computer.

Configure Node push button allows you to modify configuration of an existing
MACS node. To change node configuration, select its name from
in the list and click on the Configure Node push button.

Add Node push button allows you to add a new MACS node to the configu-
ration database.

Delete Node push button allows you to delete an existing MACS node from the
configuration database. To delete node, select its name from in
the list and click on the Delete Node push button.

View Nodes push button allows you to create and view a text report that con-
tains a list of all presently configured MACS nodes.
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Exit push button closes the MACS Node Selection dialog box and
returns to the User Interface Configuration Utility main window.

7.3.5.1 Add MACS Node

To add a new MACS node to your configuration database, open the MACS Node
Selection dialog box and click on the Add Node push button. The New MACS Node
Configuration dialog box will pop up on the screen. This dialog box has the following
layout.

MACS Node Name edit box allows you to specify the name of the new MACS node.
The name is a 15 character long ASCII string, independent from
the host computer name.

Database ID is a read-only field that contains the database record ID, automat-
ically assigned by the system. When adding a new node, this field
always contains zero.

Computer Name edit box allows you to enter the name of the MACS node host
computer. This name is subsequently used to resolve the node IP
address.

The TCP/IP networking must be able to translate the computer
name into an IP address of the nnn.nnn.nnn.nnn form. If you don’t
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have the Domain Name System (DNS) service for your network,
make sure that computer names for all of your MACS nodes
appear in the etc/hosts file, which provides static name resolution
for your TCP/IP network.

ODBC Data Source Name

edit box allows you to enter the name of the ODBC data source
to use to open the MACS node database. You must configure the
ODBC data source under the same name on each workstation
you want to use to access this MACS node. To configure the
ODBC data source use your workstation native ODBC manager.

Database Login Account

edit box allows you to enter the login account to use to open the
MACS node database.

Database Login Password

edit box allows you to enter the login password to use to open the
MACS node database.

Bitmap Files Path edit box allows you to enter the path to the folder that contains
bitmap drawings used for your custom screens. The path you
specify might point to a local disk drive, or to a shared network
drive.

MACS Root Path edit box allows you to enter the path to the root folder that con-
tains MACS sub-folders. The path you specify might point to a
local disk drive, or to a shared network drive.

Save push button allows you to add your new MACS node to the con-
figuration database and close the dialog box.

Exit push button allows you to exit the dialog box without adding the
new MACS node.

7.3.5.2 Modify MACS Node

The modify an existing MACS Node configuration use the Configure Node command.
Open the MACS Node Selection dialog box, highlight the node that you want to
modify and click the Configure Node push button. The Edit MACS Node Configuration
dialog box will pop up on the screen.

The Edit MACS Node Configuration dialog box has the same layout as the New
MACS Node Configuration dialog box.
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7.3.5.3 Delete MACS Node

To delete an existing MACS node from the configuration database, open the MACS
Node Selection dialog box, highlight the node in the scrollable list, and click on the
Delete Node push button. The following dialog box will pop up:

To delete the selected MACS node click on the Yes push button. To exit the dialog box
without deleting the node, click on the No push button.

7.3.5.4 View MACS Nodes

To view your present MACS nodes configuration, open the MACS Node Selection
dialog box and click on the View Nodes push button.

The system will create a report and present it as a text file using the WordPad text
editor. Using the editor, you can save the report in a file, print it, cut and paste the text,
and perform other functions typical of WordPad. The report layout is depicted in the
following picture.
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7.4 Pager Configuration

The MACS Pager System is an optional add-on component, that sends the same
alarm messages displayed on the MACS GUI screens to one or more alphanumeric
pagers. Based on the event being reported, the pager service selects from the
database a list of personnel responsible for that event, and sends pager messages to
all individuals on the list.

For example, you could define a list of personnel responsible for the equipment
alarms, another list of personnel responsible for the environment alarms, another for
security alarms, and another for fire alarms. When an event is reported, the pager
service sends pages only to those individuals responsible for a given alarm condition.

You can configure your system to use more than one service provider. For example, if
your MACS system covers a large geographical area, you will have different service
providers in different cities. You could decide to use one pager service for the east
coast, and another for the west coast.

The standard MACS pager system is implemented as a Windows XP service, and
uses the de-facto standard Telocator Alphanumeric Input Protocol (TAP). If your local
paging company uses different protocol, you will need a custom-built MACS pager
module.

To process event reports, your MACS pager service must receive them from your
event logger. To learn how to configure your event logger to forward event reports to
the pager, please refer to the Event Logger Configuration description earlier in this
manual.

To configure your pager, use the Pager Configuration utility program PagerCfg.
Depending on the way your system is administered, this utility may or may not be
accessible from the MACS main GUI.8

To access the pager configuration utility from your workstation desktop, click on Start -
> All Programs -> MACS ->PagerCfg.

8. Some network administrators do not want to make configuration utilities accessible to all users. In such cases,
these utilities are installed only on the workstations used by the system administrators. Others prefer to make
configuration programs accessible from the MACS main user interface. The choice is yours, and the way you
access configuration utilities is a field-configurable option.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI 9, you can also start the pager configuration utility by selecting

9. How to add configuration utilities to the MACS main GUI is explained later in this document, in Access To Config-
uration Utilities.
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configuration utilities from the Configuration -> Select Utility pull-down menu or by
clicking the Configuration button on the toolbar.

The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select Pager Configuration and click on the Open push button, or simply double click
on the Pager Configuration name. The main Pager Configuration dialog box will pop
up on the screen.

MACS can be configured to use more than one pager Windows XP service. For
example, if you have regional MACS servers, you could use these servers to page
local personnel to avoid long distance calls from your central location. The Pager
Configuration utility will allow you to add more than a single pager to your system.
When you run the utility, the list box on the left hand side will show all presently
configured pagers When you run the utility for the first time, the list box will be empty,
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and you will have to add your first pager to the system. Once your pager is configured,
the Pager Configuration utility will allow you to view and to modify that configuration.

The Pager Configuration utility main dialog box is depicted in the following picture:

The push buttons and their functions are:

Configure Server allows you to modify the configuration of an already configured
pager.

Add Server allows you to add a new pager to your system configuration.

Delete Server allows you to delete an existing pager from your system configu-
ration.

Pager Services allows you to configure the selected pager service providers,
message recipients and other pager services.

Pager Queue allows you to delete messages from the pager queue.

Serial Ports allows you to configure one or more serial ports used by the
pager.

Event Reporting allows you to specify computers and programs on your network,
that will receive event reports from the pager being configured.

View Server allows you to create a text report that contains your pager present
configuration.

Exit exits the Pager Configuration utility.
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7.4.1 Add Pager

When you run the Pager Configuration utility for the first time, the list of existing
pagers will be empty, and you will have to add a new pager to your system configu-
ration.

To add a new pager, click on the Add Server button in the Pager Configuration main
dialog box, and the Add Server dialog box will appear:

The Add Server dialog box has the following layout:

Server name edit box allows you to specify the name of your pager. This name
will appear in all event reports originated by the pager.

The name you select must be the same as the name you speci-
fied while installing the pager Windows NT service. The pager
Windows NT service uses this name on startup to query its con-
figuration from the database. If there is a mismatch in names, the
service will not find its configuration and will not start properly.

Computer name edit box allows you to specify the name of the computer your
pager will run on. This name is used, in conjunction with the pro-
tocol port, by other computers and programs on your network to
establish a TCP/IP connection with your pager.
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Protocol port edit box allows you to specify the TCP/IP protocol port your pager
will listen to service requests from other computers and programs
on your TCP/IP network.

Text Event Log checkbox allows you to select whether your pager will maintain its
own text event log. This box is normally unchecked, which means
that the pager will not create and maintain its own set of daily cre-
ated event log text files. Usually, the pager is configured to report
its events to the event logger.

Text log path edit box allows you to specify the fully qualified path to the folder
that will contain the pager event log text files. If you want your
pager to maintain its own event log, you must specify a folder that
differs from the event log maintained by the event logger.

Binary Event Log checkbox allows you to select whether your pager will maintain its
own binary event log. This box is normally unchecked, which
means that the pager will not create and maintain its own set of
daily created event log binary files.

Binary log path edit box allows you to specify the fully qualified path to the folder
that will contain the pager specific event log binary files.

For instructions on how to specify the path for the pager specific event log, please
refer to the chapter on Event Logger Configuration.

7.4.2 Modify Pager

The Configure Server command allows you to change an existing pager configuration.
In the current MACS software release, pager configuration changes take effect on the
first subsequent Windows NT service startup. Therefore, after making changes in your
pager configuration, make sure to restart the corresponding Windows NT service.

To change the configuration of an existing pager, highlight the pager name in the list,
and click the Configure Server push button in the Pager Configuration utility main
dialog box.

The Modify Server dialog box has the same layout as the Add Server dialog box.

7.4.3 Delete Pager

To delete an existing pager configuration, highlight the name of the pager you want to
delete, and click on the Delete Server push button in the Pager Configuration utility
main dialog box.
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The following dialog box will pop up:

To delete the selected pager, click on the Yes push button. To exit the dialog box
without deleting the pager, click on the No push button.

7.4.4 View Pager

To view your present pager configuration, select your pager from the list in the MACS
Pager Configuration utility main dialog box, and click on the View Server push button.

The system will create a report and present it as a text file using the WordPad text
editor. Using the editor, you can save the report in a file, print it, cut and paste the text,
and perform other functions typical of WordPad. The report layout is depicted in the
following picture.
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7.4.5 Serial Port Configuration

To send an alphanumeric page, your MACS needs to dial your paging service
provider’s telephone number, establish a modem connection, and submit the page
message using the TAP protocol. Pager dial out modem connections require a serial
port allocated to the pager service. MACS allocates serial ports exclusively, which
means that serial ports cannot be shared between programs on your MACS server.10

If you want to use more than a single pager service, you may want to use a separate
serial port, modem and telephone line for each service. MACS modules do not impose
any limitation on the number of serial ports you use, up to the maximum imposed by
your operating system. 11

To allocate and configure serial ports to be used for your pager, highlight your pager
name in the list in the Pager Configuration utility main dialog box. Then click on the
Serial Ports push button. The Serial Port Selection dialog box will pop up on the
screen. This dialog box allows you to add, modify and delete serial ports assigned to
your pager.

The Serial Port Selection dialog box has the following layout:

10. MACS background modules are usually implemented as Windows NT services. Windows NT services them-
selves cannot share allocated resources.

11.Windows NT supports up to 255 serial ports.
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The push buttons and their functions are:

Modify allows you to modify the configuration of a serial port already allo-
cated for your pager.

Add allows you to allocate a new serial port for your pager.

Delete allows you to remove the selected serial port from your pager
configuration.

Exit closes the Serial Port Selection dialog box.

7.4.5.1 Add Serial Port

When you start configuring your pager, the list of serial ports assigned to it will be
empty. Thus, you have to start your configuration process by allocating one or more
serial ports to the pager configuration. To add a serial port, click on the Add push
button. The Serial Port Configuration dialog box will appear.
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Name edit box allows you to type in the name of the serial port. Windows
NT standard names are COM1 to COM255. In some cases, you
may need to use a special naming convention for the serial ports
above COM10, such as \\.\COM10. Consult your hardware ven-
dor manual for details.

Data rate pull down list allows you to select data rate.

Parity pull down list allows you to select parity.

Stop bits pull down list allows you to select the number of stop bits.

Character size pull down list allows you to select the number of bits per charac-
ter.

Dial out port checkbox allows you to specify whether you will use the selected
serial port as a dial out port. For the pager, this check box is usu-
ally checked.

When you designate the selected port as a dial out port, the
Modem initialization string field is enabled, so that you can specify
the set of options to be used to initialize the modem.

Modem initialization string

edit box allows you to enter a string of options to be used to initial-
ize the modem before dialing out.

To add a serial port to your pager configuration, click on the OK push button. To close
the dialog box without adding a serial port, click on the Cancel push button.

7.4.5.2 Modify Serial Port

The Modify Serial Port dialog box allows you to modify the configuration of a serial port
already configured and assigned to the pager. To modify serial port configuration,
highlight its name in the Serial Port Selection dialog box, and click on the Modify push
button.

The Modify Serial Port command uses the same Serial Port Configuration dialog box
as the Add Serial Port command.
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7.4.5.3 Delete Serial Port

To delete a serial port from your pager configuration, highlight the serial port name in
the Serial Port Selection dialog box list, and click on the Delete push button.

If the serial port you want to delete is used by some of your pager services, the
following dialog box will pop up:

You will have to assign another serial port to all affected services before the system
will allow you to delete this port. If there is no pager service assigned to this port, the
port will be deleted.

7.4.6 Pager Event Reporting

During its operation your pager will generate a number of event reports, informing you
about page messages it sends and about problems encountered while trying to send
page messages. Typically, the pager is configured to send its event reports to the
event logger, which in turn forwards these reports to all other recipients.

To configure your pager to send event reports to the event logger, highlight the pager
name in the Pager Configuration utility main dialog box and click on the Event
Reporting push button.

The Event Reporting dialog box will pop up on the screen. The dialog box has the
following layout:
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MACS Recipients is a list of all possible event reportrecipients known to your pager.
You can select your event report recipient from that list, or you
can enter it manually in the Computer Name and the Protocol Port
fields. Typically, you will configure your pager to send its event
reports to your event logger.

Computer name edit box allows you to enter the destination computer name.
When you select your recipient from the MACS Recipients list, the
Computer Name field is filled in automatically.

Protocol Port edit box allows you to enter the destination TCP/IP protocol port.
When you select your recipient from the MACS Recipients list, the
Protocol Port field is filled in automatically.

Selected Recipients list contains all already configured recipients. These are the desti-
nations to which your pager will send event reports. Typically, the
list will contain only your event logger.

Add push button allows you to add a new event report recipient to the
Selected Recipients list. To add a new recipient, select it from the
MACS Recipients list, or enter the computer name and the proto-
col port manually. Then click on the Add push button.
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Delete push button allows you to delete an entry from the Selected
Recipients list. To delete a recipient, highlight it in the Selected
Recipients list and click the Delete push button.

Exit push button closes the Event Reporting dialog box.

When you add a destination to the Selected Recipients list, make sure that the corre-
sponding service is actually running at the specified location on your network. If the
service is not running, your pager will attempt to connect to this service on each event
report, and time out after several seconds. This delay will severely impede the overall
MACS performance. If you decide not to use a particular event report recipient for a
period of time, make sure to take it off from the Selected Recipients list, and to restart
your pager Windows NT service.

7.4.7 Pager Services

To use your pager, you have to configure at least one pager service. However,
depending on your requirements, you may need to configure more than a single pager
service. For example, you may want to use one service to page your personnel in the
Toronto area, and other services for the Montreal area and Vancouver area.

In this context, each service that you add will correspond to one service provider.
Once you add all service providers you intend to use, you will add a list of your
personnel that you want to page using each service. Finally, you will also define for
each individual which pager messages they should receive.

You will manage your pager services using the Pager Service Selection dialog box.
This dialog box allows you to add, modify, view or delete your pager services. It also
allows you to manage your message recipients.

To enter the Pager Service Selection dialog box, highlight your pager name in the
Pager Configuration utility main dialog box, and click on the Pager Services push
button. The dialog box has the following layout:
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The push buttons and their functions are:

Modify Service allows you to modify an existing service configuration.

Add Service allows you to add a new service to your pager configuration.

Delete Service allows you to delete an existing service from your pager configu-
ration.

Pager Users allows you to define your list of pager users, and a list of mes-
sages each user will receive.

View Services allows you to create a report containing a list of all your pager ser-
vices.
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7.4.7.1 Add Pager Service

To add a new service to your pager configuration, click on the Add Service button in
the Pager Service Selection dialog box. The Add Service dialog box will pop up on the
screen. The dialog box has the following layout:

Name edit box allows you to type in the name of your pager service.
Usually, this is the name of your service provider, such as Bell
Mobility or PageMart.

Service ID read-only field contains a numerical value which is used internally
within the MACS configuration database to identify the service.
This number is automatically assigned, and you cannot change it.

Serial Port pull down list allows you to select the serial port to use to dial the
service provider telephone number.

Polling Interval edit box allows you to specify the pager service polling interval in
seconds. To optimize its operation, the pager does not send indi-
vidual page messages as it receives event reports. Instead, the
pager forms a queue of all page messages to send, and sends all
pending page messages in a single telephone call when the poll-
ing interval expires.
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Selecting the right polling interval for your system greatly affects
pager performance. There is no point in specifying less than 30
seconds, if the modem needs more than that just to dial out and
negotiate a connection. Specifying a short polling interval will also
force the pager to send very few pager messages in each tele-
phone call. On the other hand, specifying a very long interval,
such as an hour, will adversely affect the response time from the
people you want to page. Typical time intervals used for paging
are 3 to 5 minutes.

Password edit box allows you to enter your pager service password. Some
service providers may require that you use a password when sub-
mitting your page messages. In such a case, enter your password
in this field.

Phone edit box allows you to enter the telephone number of your paging
service provider.

To add a new service to your pager configuration, click on the Save push button. To
close dialog box without adding the service, click on the Quit push button.

7.4.7.2 The Modify Pager Service

The Modify Pager Service dialog box allows you to modify an existing pager service
configuration. To modify a service configuration, highlight its name in the Pager
Service Selection dialog box and click on the Modify push button.

The Modify Service dialog box has the same layout as the Add Service, described on
the previous pages.

7.4.7.3 Delete Pager Service

To delete a service from your pager configuration, highlight the service name in the
Pager Service Selection dialog box and click on the Delete push button. The system
will respond with the following query:
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To delete the service, click on the Yes push button. To exit without deleting the
service, click on the No push button.

7.4.7.4 View Pager Services

To create a report with a list of all your pager services, open the Pager Service
Selection dialog box and click on the View Services push button. The system will
create the report and present it using the WordPad text editor. From within the editor,
you can save the report into a text file, print it, search for keywords, cut and paste
report contents and perform other functions typical of WordPad. The following picture
illustrates a typical report layout.
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7.4.8 Pager Users

Once you define your pager services, you need to define a list of pager users for each
pager service. For example, if you use one pager service in the Vancouver area and
another service in Montreal, you will add a list of your Vancouver based technicians to
the first service, and a list of Montreal personnel to the second service.

To add individual users to your pager configuration, you need to:

• Add user name and pager ID

• Define a list of possible pager messages12 for that user

To manage your pager users, you will use the Pager Users dialog box. To open it,
select a pager service in the Pager Service Selection dialog box, and click on the
Pager Users push button.

The Pager Users dialog box has the following layout:

12. When configuring your pager, you have to define a list of all possible event reports that might be sent to the user
as pager messages. Any given message from the list will be sent to the user only if and when the corresponding
event happens.
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Pager Messages push button allows you to define a list of messages for a given
pager user. To define user messages, select a user by highlight-
ing his or her name in the list box, and click on the Pager Mes-
sages push button.

Add User push button allows you to add new users to the list. To add a new
user, fill in the Name and Pager ID fields and then click on the
Add User push button. Note that this dialog box does not allow
you to modify user name and pager ID. You can only delete a
user and then add it again.

Name edit box allows you to specify a user name when adding a new
user to the pager configuration.

Pager ID edit box allows you to specify a pager ID when adding a new user
to the pager configuration.

Delete User push button allows you to delete an existing user from the list. To
delete a user, select his or her name from the list and click on the
Delete User push button. The following dialog box will pop up:

To delete the selected user, click on the Yes push button. To exit
without deleting the user, click on the No push button.

View User push button allows you to view a list of all possible pager mes-
sages assigned to a particular user. To view the list, select a user
name by highlighting it in the list box, and then click on the View
User push button. The system will create a report containing all
possible messages assigned to the selected user, and present
that report using the WordPad text editor. From within the editor,
you can view the report, print it or save it in a text file. You can
also search for keywords, cut and paste selected sections, and
perform other functions typical of WordPad.

A typical report layout is depicted in the following figure:
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7.4.8.1 Pager Messages

After you define a list of your pager users, you have to specify a list of messages for
each user.

Your MACS will monitor a potentially large number of alarm, status and control points.
While configuring your equipment alarms and status and control points, you will define
point names and text to display for each alarm condition or change in status. For
example, digital inputs can be active or inactive. Digital outputs can be active, inactive
or pulsed. Analog inputs can be within limits, above upper threshold or below lower
threshold. For each of these states you can specify a text message to be displayed,
but you can also specify whether this particular point state will activate the pager. This
is done simply by checking a check box associated with the desired point state. The
following picture illustrates a typical digital output configuration.
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In this example, the Page check box for the active point state is checked. This means
that if an HPA-M_FL alarm is detected, the system will activate the pager, and send a
TORONTO HPA A PRODUCED FAULT pager message to all users, configured to
receive this particular message. You can assign any given message to any number of
users. When the corresponding alarm or status condition occurs, the system will send
a page to all users configured to receive this message.

To specify which event reports to send as pager messages to a given user, highlight
the user name in the list box in the Pager Users dialog box and click on the Pager
Messages push button.

The Pager Messages dialog box will pop up on the screen. The dialog box will
indicate the name of the selected user on the caption bar. The dialog box layout is
depicted in the following picture.
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This dialog box is divided into two sections: The bottom section, named All pager
events, contains a list of all events that can be assigned as pager messages. The top
section, designated as Pager messages assigned to this user, contains a list of all
events already assigned as the selected user pager messages.

When you add a new user to your pager configuration, the list of pager messages
assigned to this user will be empty. To select which pager messages your new user
will receive, simply highlight one or more messages in the list of all pager events, and
then click on the Add push button. The selected pager messages will appear in the top
list.
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Once you configure your user messages, you can always change the list by adding
new messages or deleting already assigned messages. To delete a message from
the selected user list, highlight the message in the Pager messages assigned to this
user list and click on the Delete push button.

In each list, pager events are presented using the server, unit, slot and point name. If
you want to see the text messages assigned to a given pager event, highlight the
corresponding event in either the top or bottom list, and click on the corresponding
Details push button. The Pager Event Details dialog box will pop up on the screen.
This dialog box layout is presented on the following pages.

Pager Messages Assigned to this User

scrollable list box contains allpager messages assigned to the
selected user.

All Pager Events scrollable list box contains allsystem-wide defined pager events.

Server column in the list contains the name of the Windows NT service
from which the message originates.

Unit column in the list contains the name of the equipment unit from
which the message originates.

Slot column in the list contains the name of the slot within the equip-
ment from which the message originates. Many communication
equipment devices have slots used to install equipment plug-in
modules. Equipment that does not have slots is considered sin-
gle slot equipment, meaning that all components are located
within a single, monolithic unit.

Point column in the list contains the name of the point from which the
message originates.

Details push button allows you to display details on the selected pager
message. There are two Details push buttons in the dialog box,
one for each list. If you want to see the text messages assigned
to a given pager event, highlight the event in either the top or bot-
tom list, and click on the corresponding Details push button. The
Pager Event Details dialog box will pop up on the screen. This
dialog box layout is presented on the following pages.

Delete push button allows you to delete a pager message assigned to
the selected user. To delete a message, highlight it in the top list
box and click on the Delete button.
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Add push button allows you to add new pager messages to the
selected user. To add a message, highlight it in the bottom list
box, and click on the Add push button. Note that the bottom list
box accepts multiple selections. By clicking on several lines at a
time, you can add all of them at once. The lines you select do not
have to be adjacent. To de-select a line, click on it again.

7.4.8.2 Event Details

The Pager Messages dialog box, described on the previous pages, contains a list of
messages assigned to the selected user, and a list of all pager events. In both of these
lists, events that can be sent as pager messages are displayed using their respective
server, unit, slot and point names. To see the text assigned to each point state,
highlight the event in the list and click on the respective Details push button. The
Pager Event Details dialog box will pop up. This read-only dialog box has the layout
depicted in the following picture.

Point Identification group box contains point identifiers, which are the server, unit,
slot and point names.

Server name field contains the name of the Windows NT service that originates
the message.
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Unit name field contains the name of the equipment unit that originates the
message.

Slot name field contains the name of the slot within the equipment that origi-
nates the message. Many communication equipment devices
have slots, which are used to install equipment plug in modules.
Equipment that does not have slots is considered a single slot
equipment, meaning that all components are located within a sin-
gle, monolithic unit.

Point name field contains the name of the point that originates the message.

Pager Messages group box contains a text field and a Page checkbox for each
point state. A Page checkbox indicates to the MACS whether or
not to include the text in the text field in a page. If checked, the
text will be sent; if unchecked, the text will not be sent. If the text
field is empty for a given state, the system will not report point

transition to that state.13

Active/above limits text

field contains the text to include in the event report when a digital
point becomes active, or when an analog point value exceeds the
upper threshold. If the associated checkbox is checked, the same
text will be included in the pager message and sent to all users
configured to receive this message.

Inactive/within limits text

field contains the text to include in the event report when a digital
point becomes inactive, or when an analog point value returns to
a value within limits. If the associated checkbox is checked, the
same text will be included in the pager message and sent to all
users configured to receive this message.

Pulsed/below limits text

field contains the text to include in the event report when a digital
output is pulsed, or when an analog point value falls below the
lower threshold. This state is not used for the digital inputs. If the
associated checkbox is checked, the same text will be included in
the pager message and sent to all users configured to receive
this message.

13.If there is no text message assigned to a given point state, the system will not display a text message when the
point enters that state. However, the system will still update all graphical images representing that point.
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7.4.8.3 Delete User

To delete an existing user from your pager configuration, highlight the user name in
the Pager Users dialog box, and click on the Delete push button. The following dialog
box will pop up:

To delete the user, click on the Yes push button. To exit without deleting the user, click
on the No push button.
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7.5 E-mail and Fax Configuration

MACS MAPI14 Interface15 is an optional add-on component, which sends the same
alarm messages displayed on the MACS GUI screens to one or more e-mail and/or
fax recipients. Based on the event being reported, the MAPI interface selects from the
database a list of personnel interested in that event, and sends e-mail and/or fax
messages to all individuals on the list.

For example, your company could offer network and system management services to
your clients. While your company will take care of each individual alarm condition as it
happens, the client companies may ask for daily reports, that contain a list of all
important events. In such a scenario, you can use the MAPI interface to automatically
create daily reports and to e-mail or fax them to your clients. You program your MAPI
interface to run once a day, and you define a list of all possible event reports to be e-
mailed or faxed to each client. MACS will then queue these events as they happen,
and once a day automatically compose an e-mail or fax message and send it to your
client.

Note that the MACS MAPI module provides only the interface to the native Windows
MAPI services. To use the MACS MAPI, you must install and configure on your
computer the native e-mail and fax services.

The Windows NT operating system imposes some severe technical restrictions
related to sending e-mail. For this reason we no longer support MACS MAPI under
the Windows NT.

When you use Windows XP, you must carefully select your default MAPI service to
allow other services to send e-mail. For example, Microsoft Outlook or Netscape will
not allow any other service to send e-mail. This is why we recommed using Microsoft
Outlook Express, which comes with the Windows XP operating system at no extra
cost.

To enable sending e-mail using the Outlook Express, you need to adjust its configu-
ration as follows: Open Outlook Express and click on the Tools menu item. Then
select Options item from the pull-down list.

14.The Messaging Application Programming Interface (MAPI) is a medium-independent messaging architecture
that enables multiple applications to interact with multiple systems across a variety of hardware platforms.

15.To send MAPI messages, MACS actually submits e-mail and fax messages to the Windows NT native MAPI
system. Thus, the MACS MAPI program provides only the interface to the Windows NT native MAPI service.
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In the Options dialog box, click on the Security tab:
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In the Security property page, make sure that the checkbox marked Warn me when
other applications try to send mail as me is not checked. Click on the Apply push
button and close all Outlook Express windows.

To process event reports and create e-mail or fax messages, your MAPI interface
must receive them from your event logger. To learn how to configure your event
logger to forward event reports to the MAPI, please refer to the Event Logger Configu-
ration description earlier in this manual.

To configure your MAPI interface, use the MAPI Configuration utility program
MapiCfg. Depending on the way your system is administered, this utility may or may
not be accessible from the MACS main GUI.1

To access the MAPI configuration utility from your workstation desktop, click on Start -
> All Programs -> MACS ->MapiCfg.

1. Some network administrators do not want to make configuration utilities accessible to all users. In such case,
these utilities are installed only on the workstations used by the system administrators. Others prefer to make
configuration programs accessible from the MACS main user interface. The choice is yours, and the way you
access configuration utilities is a field-configurable option.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI,1 you can also start the MAPI configuration utility by selecting config-
uration utilities from the Configuration -> Select Utility pull-down menu or by clicking
the Configuration button on the toolbar.
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The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select MAPI Configuration and click on the Open push button, or simply double click
on the MAPI Configuration name. The main MAPI Configuration dialog box will pop up
on the screen. The dialog box layout is depicted in the following picture.

1. How to add configuration utilities to the MACS main GUI is explained later in this document, in Access To Con-
figuration Utilities.
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The push buttons and their functions are:

Configure Server allows you to modify the configuration of an already configured
MAPI interface.

Add Server allows you to add a new MAPI interface to your system configura-
tion.

Delete Server allows you to delete an existing MAPI interface from your system
configuration.

MAPI Users allows you to configure your e-mail and fax message recipients.

Event Reporting allows you to specify computers and programs on your network,
which will receive event reports from the MAPI interface program
being configured.

View Server allows you to create a text report that contains your MAPI inter-
face present configuration.

MAPI Account allows you to specify which MAPI account and password to use to
send e-mail and fax messages.

Exit exits the MAPI Configuration utility.
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7.5.1 Add MAPI Interface

When you run the MAPI Configuration utility for the first time, the list of existing MAPI
interfaces will be empty, and you will have to add a new interface to your system
configuration.

To add a new MAPI interface, click on the Add Server button in the MAPI Configu-
ration main dialog box, and the New Server Configuration dialog box will appear:

The New Server Configuration dialog box has the following layout:

Server name edit box allows you to specify the name of your MAPI interface.
This name will appear in all event reports originated by the MAPI
interface.

The name you select must be the same as the name you speci-
fied while installing the MAPI interface program. The program
uses this name on startup, to query its configuration from the
database. If there is a mismatch in names, the program will not
find its configuration and will not start properly.
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Computer name edit box allows you to specify the name of the computer your
MAPI interface program will run on. This name is used, in con-
junction with the protocol port, by other computers and programs
on your network to establish a TCP/IP connection with your MAPI
interface.

Protocol port edit box allows you to specify the TCP/IP protocol port your MAPI
interface will listen to service requests from other computers and
programs on your TCP/IP network.

Text Event Log checkbox allows you to select whether your MAPI interface pro-
gram will maintain its own text event log. This box is normally
unchecked, which means that the program will not create and
maintain its own set of daily created event log text files. Usually,
the MAPI interface is configured to report its events to the event
logger.

Text log path edit box allows you to specify the fully qualified path to the folder
that will contain the MAPI interface event log text files. If you want
your MAPI interface to maintain its own event log, you must spec-
ify a folder that differs from the event log maintained by the event
logger.

Binary Event Log checkbox allows you to select whether your MAPI interface will
maintain its own binary event log. This box is normally
unchecked, which means that the MAPI interface will not create
and maintain its own set of daily created event log binary files.

Binary log path edit box allows you to specify the fully qualified path to the folder
that will contain the MAPI interface specific event log binary files.

For instructions on how to specify the path for the MAPI interface specific event log,
please refer to the chapter on Event Logger Configuration.

7.5.2 Modify MAPI Interface

To modify an existing MAPI interface configuration use the Modify Server Configu-
ration command. In the current MACS software release, MAPI interface configuration
changes take effect on the first subsequent MAPI interface program startup.
Therefore, after making changes in your MAPI configuration, make sure to restart the
corresponding MAPI interface program.

To change configuration of an existing MAPI interface, highlight the interface name in
the list, and click the Configure Server push button in the MAPI Configuration utility
main dialog box.
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The Modify Server Configuration dialog box has the same layout as the New Server
Configuration dialog box, described on the previous pages.

7.5.3 Delete MAPI Interface

To delete an existing MAPI interface configuration, highlight the name of the interface
you want to delete, and click on the Delete Server push button in the MAPI Configu-
ration utility main dialog box.

The following dialog box will pop up:

To delete the selected MAPI interface, click on the Yes push button. To exit the dialog
box without deleting the interface, click on the No push button.

7.5.4 View MAPI Interface

To view your MAPI interface configuration, select the interface name in the MAPI
Configuration utility main dialog box, and click on the View Server push button. The
system will create a configuration report and present it using the WordPad text editor.
From within the editor, you can save the report into a text file, print it, search for
keywords, cut and paste report contents, and perform other functions typical of
WordPad. The following picture illustrates a typical report layout.
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7.5.5 MAPI Event Reporting

During its operation your MAPI interface will generate a number of event reports,
informing you about e-mail and fax messages it sends and about problems encoun-
tered while trying to send MAPI messages. Typically, the interface is configured to
send its event reports to the event logger, which in turn forwards these reports to all
other recipients.

To configure your MAPI interface to send event reports to the event logger, highlight
the interface name in the MAPI Configuration utility main dialog box and click on the
Event Reporting push button.

The Event Reporting dialog box will pop up on the screen. The dialog box has the
following layout:

MACS Recipients is a list of all possible event reportrecipients known to your MAPI
interface. You can select your event report recipient from that list,
or you can enter it manually in the Computer Name and the Proto-
col Port fields. Typically, you will configure your MAPI interface to
send its event reports to your event logger.

Computer name edit box allows you to enter the destination computer name.
When you select your recipient from the MACS Recipients list, the
Computer Name field is filled in automatically.
177Micus Alarm and Control System



Configuration
Protocol Port edit box allows you to enter the destination TCP/IP protocol port.
When you select your recipient from the MACS Recipients list,
the Protocol Port field is filled in automatically.

Selected Recipients list contains all already configured recipients. These are the des-
tinations to which your MAPI interface will send event reports.
Typically, the list will contain only your event logger.

Add push button allows you to add a new event report recipient to the
Selected Recipients list. To add a new recipient, select it from the
MACS Recipients list, or enter the computer name and the proto-
col port manually. Then click on the Add push button.

Delete push button allows you to delete an entry from the Selected
Recipients list. To delete a recipient, highlight it in the Selected
Recipients list and click the Delete push button.

Exit push button closes the Event Reporting dialog box.

When you add a destination to the Selected Recipients list, make sure that the corre-
sponding service is actually running at the specified location on your network. If the
service is not running, your MAPI interface will attempt to connect to this service on
each event report, and time out after several seconds. This delay will severely impede
the overall MACS performance. If you decide not to use a particular event report
recipient for a period of time, make sure to take it off of the Selected Recipients list,
and to restart your MAPI interface program.

7.5.6 MAPI Message Recipients

Once you define your MAPI interfaces, you need to define a list of MAPI message
recipients for each MAPI interface. Typically, MACS uses only a single MAPI
interface. To add individual recipients to your MAPI interface configuration, you need
to:

• Add the recipient name and address

• Define a list of all event reports to be sent as pager messages1 to that recipient

To manage your MAPI interface recipients you will use the MAPI Users dialog box. To
open it, select the interface name in the MAPI Configuration utility main dialog box,
and click on the MAPI Users push button.

1. When configuring your MAPI interface, you have to define a list of all possible event reports that might be sent
to the user as pager messages. Any given message from the list will be sent to the user only if and when the cor-
responding event happens.
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The MAPI Users dialog box has the following layout:

MAPI Messages push button allows you to define a list of messages for a given
MAPI recipient. To define user messages, select user by high-
lighting his or her name in the list box, and click on the MAPI Mes-
sages push button.

Add User push button allows you to add new MAPI recipients to the list. To
add a new user, fill in the Name and MAPI Address fields and
then click on the Add User push button. Note that this dialog box
does not allow you to modify user name and address. You can
only delete a user and then add it again.

Name edit box allows you to specify a user name when adding a new
user to the MAPI interface configuration.

MAPI Address edit box allows you to specify an address when adding a new user
to the MAPI interface configuration. This address can take one of
the two forms: an e-mail address of the form name@provider, or
fax number, of the form FAX:5551234. Based on the submitted
address, the MAPI automatically selects an e-mail or fax service.

Delete User push button allows you to delete an existing user from the list. To
delete a user, select his or her name from the list and click on the
Delete User push button. The following dialog box will pop up:
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To delete the selected user, click on the Yes push button. To exit
without deleting the user, click on the No push button.

View User push button allows you to view a list of all possible MAPI mes-
sages assigned to the selected recipient. To view the list, select
the user name by highlighting it in the list box, and then click on
the View User push button. The system will create a report con-
taining all possible messages assigned to the selected user, and
present that report using the WordPad text editor. From within the
editor, you can view the report, print it or save it in a text file. You
can also search for keywords, cut and paste selected sections,
and perform other functions typical od WordPad.

A typical report layout is depicted in the following figure:
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7.5.6.1 MAPI Messages

After you define a list of your MAPI recipients, you have to specify a list of messages
for each recipient.

Your MACS will monitor a potentially large number of alarm, status and control points.
While configuring your equipment alarms, status and control points, you will define
point names and text to display for each alarm condition, change in status and other
states. For example, digital inputs can be active or inactive. Digital outputs can be
active, inactive or pulsed. Analog inputs can be within limits, above upper threshold or
below lower threshold. For each of these states you can specify a text message to be
displayed, but you can also specify whether to include this particular point state in
MAPI messages. This is done simply by checking a check box associated with the
desired point state. Note that in this software release the MAPI interface shares the
activation checkbox with the pager. The following picture illustrates a typical digital
input configuration.
181Micus Alarm and Control System



Configuration
In this example, the Page checkbox for the active point state is checked. This means
that if a Main Hydro alarm is detected, the system will include the MAIN HYDRO
FAILURE DETECTED event report into the e-mail or fax messages to those users
configured to receive this particular message. You can assign any given message to
any number of users. When the corresponding alarm or status condition occurs, the
system will include the respective event report into the e-mail or fax messages for all
users configured to receive that event report.

To specify which event reports to include in the e-mail or fax messages to a given
user, highlight the user name in the list box in the MAPI Users dialog box and click on
the MAPI Messages push button.

The MAPI Messages dialog box will pop up on the screen. The dialog box will indicate
the name of the selected user on the caption bar. The dialog box layout is depicted in
the following picture.
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This dialog box is divided into two sections. The bottom section, named All MAPI
events, contains a list of all events that can be assigned as MAPI messages. The top
section, designated as MAPI messages assigned to this user, contains a list of all
events already assigned as the selected user MAPI messages.

When you add a new user to your MAPI configuration, the list of MAPI messages
assigned to this user will be empty. To select which MAPI messages your new user
will receive, simply highlight one or more messages in the list of all MAPI events, and
then click on the Add push button. The selected MAPI messages will appear in the top
list.

Once you configure your user messages, you can always change the list by adding
new messages or deleting already assigned messages. To delete a message from the
selected user list, highlight the message in the MAPI messages assigned to this user
list and click on the Delete push button.

In each list, MAPI events are presented using the server, unit, slot and point name. If
you want to see the text messages assigned to a given event, highlight the corre-
sponding event in either top or bottom list, and click on the corresponding Details push
button. The MAPI Event Details dialog box will pop up on the screen. This dialog box
layout is presented on the following pages.

MAPI Messages Assigned to this User

scrollable list box contains allMAPI messages assigned to the
selected user.

All Pager Events scrollable list box contains allsystem-wide defined MAPI events.

Server column in the list contains the name of the Windows NT service
from which the message originates.

Unit column in the list contains the name of the equipment unit from
which the message originates.

Slot column in the list contains the name of the slot within the equip-
ment from which the message originates. Many communication
equipment devices have slots, which are used to install equip-
ment plug in modules. Equipment that does not have slots is con-
sidered single slot equipment, meaning that all components are
located within a single, monolithic unit.

Point column in the list contains the name of the point from which the
message originates.

Details push button allows you to display details on the selected MAPI
message. There are two Details push buttons in the dialog box,
one for each list. If you want to see the text messages assigned to
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a given event, highlight the event in either the top or bottom list,
and click on the corresponding Details push button. The MAPI
Event Details dialog box will pop up on the screen. This dialog
box layout is presented on the following pages.

Delete push button allows you to delete a MAPI message assigned to
the selected user. To delete a message, highlight it in the top list
box and click on the Delete button.

Add push button allows you to add new MAPI messages to the
selected user. To add a message, highlight it in the bottom list
box, and click on the Add push button. Note that the bottom list
box accepts multiple selections. By clicking on several lines at a
time, you can add all of them at once. The lines you select do not
have to be adjacent. To de-select a line, click on it again.

7.5.6.2 Event Details

The MAPI Messages dialog box, described on the previous pages, contains a list of
messages assigned to the selected user, and a list of all MAPI events. In both of
these lists, events that can be sent as MAPI messages are displayed using their
respective server, unit, slot and point names. To see the text assigned to each point
state, highlight the event in the list and click on the respective Details push button.
The MAPI Event Details dialog box will pop up. This read-only dialog box has the
layout depicted in the following picture.
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Point Identification group box contains point identifiers, which are the server, unit,
slot and point names.

Server name field contains the name of the Windows NT service from which the
message originates.

Unit name field contains the name of the equipment unit from which the mes-
sage originates.

Slot name field contains the name of the slot within the equipment from
which the message originates. Many communication equipment
devices have slots, which are used to install equipment plug in
modules. Equipment that does not have slots is considered a sin-
gle slot equipment, meaning that all components are located
within a single, monolithic unit.

Point name field contains the name of the point from which the message orig-
inates.

MAPI Messages group box contains a text field and a Send checkbox for each
point state. A Send checkbox indicates to the MACS whether or
not to include the text in the text field in an email and/or fax. If
checked, the text will be sent; if unchecked, the text will not be
sent. If the text field is empty for a given state, the system will not

report point transition to that state.1

Active/above limits text

field contains the text to include in the event report when a digital
point becomes active, or when an analog point value exceeds the
upper threshold. If the associated checkbox is checked, the same
text will be included in the e-mail and fax messages and sent to all
users configured to receive this message.

Inactive/within limits text

field contains the text to include in the event report when a digital
point becomes inactive, or when an analog point value returns to
a value within limits. If the associated checkbox is checked, the
same text will be included in the e-mail and fax messages and
sent to all users configured to receive this message.

Pulsed/below limits text

field contains the text to include in the event report when a digital
output is pulsed, or when an analog point value falls below the

1. If there is no text message assigned to a given point state, the system will not display a text message when the
point enters that state. However, the system will still update all graphical images representing that point.
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lower threshold. This state is not used for the digital inputs. If the
associated checkbox is checked, the same text will be included in
the e-mail and fax messages and sent to all users configured to
receive this message.

7.5.6.3 Delete User

To delete an existing user from your MAPI configuration, highlight the user name in
the MAPI Users dialog box, and click on the Delete push button. The following dialog
box will pop up:

To delete the user, click on the Yes push button. To exit without deleting the user,
click on the No push button.

7.5.7 MAPI Account

To use the native Windows MAPI services, you have to create one or more MAPI
profiles. Instructions on how to create MAPI profiles, please refer to the Windows
documentation. Each MAPI profile contains an account name and a password. Before
sending any MAPI messages, you have to login to MAPI using this account name and
password. Similarly, your MACS MAPI interface must login into the Windows MAPI to
submit its messages.

To enable your MAPI interface to submit messages to the native Windows MAPI
services, you have to specify which account name and password to use. To do so,
select the MAPI interface name in the MAPI Configuration utility main dialog box and
click on the MAPI Account push button.

The MAPI Account dialog box has the following layout:
186 Micus Alarm and Control System



Configuration
Account edit box allows you to specify the account name to use to log into
the Windows NT native MAPI service.

Password edit box allows you to specify the password to use to log into the
Windows NT native MAPI service.

Subject edit box allows you to specify the contents of the subject field of
your e-mail or fax messages.

To save you MAPI account configuration, click on the OK push button. To close the
dialog box without saving the contents, click on the Cancel push button.
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7.6 MACS IO Configuration

MACS servers come with built-in opto isolated inputs and output relays. You can use
inputs to monitor equipment contact closures, and environment and security sensors.
For example, you can use output relays to control heating and air conditioning, to
open external gates, and to acknowledge and silence audible alarms.

Depending on your exact requirements, you can order a MACS server with a combi-
nation of inputs and outputs that best suits best your needs. Up to four slots in the
MACS server chassis can be populated with MACS IO plug-in boards. There are
several different boards that you can order, which provide the following IO combina-
tions:

• 8 opto isolated inputs and 8 mechanical relays.

• 16 opto isolated inputs and 16 mechanical relays.

• 32 REED relays.

To use the MACS server internal IO boards, you have to configure the following:

• MACS IO service

• MACS IO slots

• Input and output points for each slot

While the MACS server comes with the pre installed hardware, you still need to adjust
your system configuration to your application requirements. To configure MACS IO,
use the MACS IO Configuration utility program IOCfg. Depending on the way your
system is administered, this utility may or may not be accessible from the MACS main
GUI.1

To access the MACS IO configuration utility from your workstation desktop, click on
Start -> All Programs -> MACS ->IOCfg.

1. Some network administrators do not want to make configuration utilities accessible to all users. In such case,
these utilities are installed only on the workstations used by the system administrators. Others prefer to make
configuration programs accessible from the MACS main user interface. The choice is yours, and the way you
access configuration utilities is a field-configurable option.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI,1 you can also start the MACS IO configuration utility by selecting
configuration utilities from the Configuration -> Select Utility pull-down menu or by
clicking the Configuration button on the toolbar.

1. How to add configuration utilities to the MACS main GUI is explained later in this document, in Access To Config-
uration Utilities.
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The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select MACS IO Configuration and click on the Open push button, or simply double-
click on the MACS IO Configuration name. The main MACS IO Configuration dialog
box will pop up on the screen.

MACS can be configured to use more than one MACS IO Windows XP service. For
example, if you have regional MACS servers, you will configure one MACS IO module
per each server. When you run the utility, the list box on the left hand side will show all
presently configured MACS IO modules. When you run the utility for the first time, the
list box will be empty, and you will have to add your first MACS IO module to the
system. Once your MACS IO is configured, the MACS IO Configuration utility will
allow you to view and to modify that configuration.

The MACS IO Configuration utility main dialog box is depicted in the following picture:
190 Micus Alarm and Control System



Configuration
The push buttons and their functions are:

Configure Service allows you to modify the configuration of an already configured
MACS IO service.

Add Service allows you to add a new MACS IO service to your system configu-
ration.

Delete Service allows you to delete an existing MACS IO service from your sys-
tem configuration.

Event Reporting allows you to specify computers and programs on your network
that will receive event reports from the MACS IO service being
configured.

Configure Slots allows you to configure MACS IO slots and points for the selected
MACS IO module.

View Service allows you to create a text report that contains your MACS IO
module present configuration.

Exit exits the MACS IO Configuration utility.
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7.6.1 Add Service

When you run the MACS IO Configuration utility for the first time, the list of existing
MACS IO modules1 will be empty, and you will have to add a new module to your
system configuration.

To add a new MACS IO module, click on the Add Service button in the MACS IO
Configuration main dialog box, and the New Server Configuration dialog box will
appear:

The dialog box has the following layout:

Service name edit box allows you to specify the name of your MACS IO service.
This name will appear in all event reports originated by the ser-
vice.

The name you select must be the same as the name you speci-
fied while installing the MACS IO Windows NT service. The
MACS IO Windows NT service uses this name when startup to
query its configuration from the database. If there is a mismatch
in names, the service will not find its configuration and will not
start properly.

1. In this section we refer to MACS IO services and MACS IO modules interchangeably. A MACS IO service is a
software component. It is a Windows XP service that runs on the MACS server. A MACS IO module encom-
passes both the service and the associated computer hardware.
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Computer name edit box allows you to specify the name of the computer in which
your MACS IO module is installed. This name is used, in conjunc-
tion with the protocol port, by other computers and programs on
your network to establish a TCP/IP connection with the MACS IO
module.

Protocol port edit box allows you to specify the TCP/IP protocol port your
MACS IO module will listen to service requests from other com-
puters and programs on your TCP/IP network.

Text Event Log checkbox allows you to select whether your MACS IO module will
maintain its own text event log. This box is normally unchecked,
which means that the module will not create and maintain its own
set of daily created event log text files. Usually, the module is con-
figured to report its events to the event logger.

Text log path edit box allows you to specify the fully qualified path to the folder
which will contain the pager event log text files. If you want your
pager to maintain its own event log, you must specify a folder that
differs from the event log maintained by the event logger.

Binary Event Log checkbox allows you to select whether your module will maintain
its own binary event log. This box is normally unchecked, which
means that the module will not create and maintain its own set of
daily created event log binary files.

Binary log path edit box allows you to specify the fully qualified path to the folder
which will contain the MACS IO module specific event log binary
files.

For discussion on how to specify the path for the MACS IO module specific event log,
please refer to the chapter on Event Logger Configuration.

7.6.2 Modify Service

The Configure Service command allows you to change an existing MACS IO service
configuration. In the current MACS software release, configuration changes take effect
on the first subsequent Windows NT service startup. Therefore, after making changes
in your MACS IO configuration, make sure to restart the corresponding Windows NT
service.

To change the configuration of an existing MACS IO service, highlight its name in the
list, and click the Configure Service push button in the MACS IO Configuration utility
main dialog box. The Modify Server Configuration dialog box has the same layout as
the New Server Configuration dialog box.
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7.6.3 Delete Service

To delete an existing MACS IO module configuration, highlight the name of the
module you want to delete, and click on the Delete Service push button in the MACS
IO Configuration utility main dialog box.

The following dialog box will pop up:

To delete the selected MACS IO module, click on the Yes push button. To exit dialog
box without deleting the module, click on the No push button.

7.6.4 View Service

To view your MACS IO module configuration, select the interface name in the MACS
IO Configuration utility main dialog box, and click on the View Service push button.
The system will create a configuration report and present it using the WordPad text
editor. From within the editor, you can save the report into a text file, print it, search for
keywords, cut and paste report contents, and perform other functions typical of
WordPad. The following picture illustrates a typical report layout.
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7.6.5 Event Reporting

During its operation, your MACS IO service will generate a number of event reports
informing you about changes in its input and output points status. Typically, the service
is configured to send its event reports to the MACS event logger, which in turn
forwards these reports to all other recipients.

To configure your service to send event reports to the event logger, highlight the
service name in the MACS IO Configuration utility main dialog box and click on the
Event Reporting push button.

The Event Reporting dialog box will pop up on the screen. The dialog box has the
following layout:

MACS Recipients list contains all possible event reportrecipients known to the
selected service. You can select your event report recipient from
that list, or you can enter it manually in the Computer Name and
the Protocol Port fields. Typically, you will configure the service to
send its event reports to your event logger.

Computer name edit box allows you to enter the destination computer name.
When you select your recipient from the MACS Recipients list, the
Computer Name field is filled in automatically.
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Protocol Port edit box allows you to enter the destination TCP/IP protocol port.
When you select your recipient from the MACS Recipients list,
the Protocol Port field is filled in automatically.

Selected Recipients list contains all already configured recipients. These are the des-
tinations to which the service will send event reports. Typically,
the list will contain only your event logger.

Add push button allows you to add a new event report recipient to the
Selected Recipients list. To add a new recipient, select it from the
MACS Recipients list, or enter the computer name and the proto-
col port manually. Then click on the Add push button.

Delete push button allows you to delete an entry from the Selected
Recipients list. To delete a recipient, highlight it in the Selected
Recipients list and click the Delete push button.

Exit push button closes the Event Reporting dialog box.

Please Note: When you add a destination to the Selected Recipients list, make sure
that the corresponding service is actually running at the specified location on your
network. If the service is not running, the MACS IO service will attempt to connect to
the destination service on each event report, and time out after several seconds. This
delay will severely impede the overall MACS performance. If you decide not to use a
particular event report recipient for a period of time, make sure to take it off of the
Selected Recipients list, and to restart your MACS IO windows NT service.

7.6.6 Slot Configuration

The MACS server is a rack mounted computer with four internal slots in which you
can install a variety of MACS IO plug-in boards. Each MACS IO board provides a
different input and output combination. For example, the PCI-DIO8 board has 8 digital
inputs and 8 electromechanical relays, the PCI-DIO32M board has 16 digital inputs
and 16 relays and the PCI-32REL board has 32 REED relays. While configuring your
MACS IO module, you have to inform the MACS software which slots are populated,
and with which MACS IO boards.

The following pages illustrate how to add and how to modify slots in the MACS IO
module configuration. Once you assign some plug-in boards to the slots in your
MACS IO module, you can always reassign them and delete them. You can also add
more slots to your MACS IO module at a later date. The most important consideration
is that the plug-in board/slot assignment in the configuration database must match the
actual hardware installed in the MACS server itself.
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Before you start monitoring and controlling a MACS IO module, you have to add at
least one slot to its configuration. You will manage your MACS IO slots using the Slot
Configuration dialog box. This dialog box allows you to add, modify, view or delete
slots from the selected MACS IO module.

To enter the Slot Configuration dialog box, select a MACS IO module in the main
MACS IO Configuration dialog box, and click on the Configure Slots push button. The
dialog box has the following layout:

The scrollable list box on the left hand side contains the names of all presently
configured MACS IO slots. The Slot Configuration dialog box contains the following
push buttons:

Configure Slot allows you to modify an existing slot configuration.

Add Slot allows you to add a new slot to the unit configuration in the data-
base.

Delete Slot allows you to delete an existing slot from the unit configuration in
the database.

Configure Points allows you to add a points configuration to the slot selected from
the list of slots.

Exit closes the Slot Configuration dialog box.
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7.6.6.1 Add Slot

When you add a new MACS IO module to the configuration database, all slots for that
module are marked as empty. You have to add at least one slot to a MACS IO module
to make it usable. You can also add new slots to an existing module at a later date, for
example to increase the number of alarm points that the module can monitor.

To add a slot to the selected module, open the Slot Configuration dialog box and click
on the Add Slot push button. The Add Slot dialog box has the following layout:

Name edit box allows you to enter a 15 character long name for the slot.

Module pull down list allows you to select the type of the MACS IO plug-in
board installed in the selected slot. Individual MACS IO boards
and their respective configuration are presented on the following
pages.

Slot number pull down list allows you to select a physical slot in the computer
chassis for the slot. The valid range is from 1 to 4. These num-
bers just refer to the board number one, board number two, and
so on. They don’t have to correspond to the PCI slot numbers on
the computer motherboard. The list contains only those numbers
within the range that are not already assigned.

Adapter number field contains a logical unit number of the plug-in board used by
the Windows device driver. Logical unit numbers are hardware
and device driver specific, and should be changed only by the

qualified personnel.1

1. Usually, MACS IO plug-in boards and their device drivers are installed by Micus Real Time Software Inc. per-
sonnel and should not be changed in the field.
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Save push button saves the slot configuration and closes the dialog
box.

Quit push button closes the dialog box without saving the configuration
changes.

7.6.6.2 Modify Slot

To change an existing slot configuration, use the Configure Slot dialog box. To select
the slot, highlight its name in the Slot Configuration dialog box and click on the
Configure Slot push button.

The layout and operation of the Configure Slot dialog box is the same as the Add Slot
dialog box, described on the previous pages.

7.6.6.3 Delete Slot

To delete a slot from the selected MACS IO module configuration, highlight the slot
name in the Slot Configuration dialog box and click on the Delete Slot push button.
The system will respond with the following query:

To delete the slot, click on the Yes push button. To exit without deleting the slot, click
on the No push button.
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7.6.6.4 View Slots

To view your MACS IO slots configuration, open the Slot Configuration utility main
dialog box and click on the View Slots push button. The system will create a configu-
ration report and present it using the WordPad text editor. From within the editor, you
can save the report into a text file, print it, search for keywords, cut and paste report
contents, and perform other functions typical of WordPad. The following picture illus-
trates a typical report layout.
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7.6.7 MACS IO Plug-in Boards

Once you assign slots to your MACS IO module, you have to configure the input,
output and analog points that you want to use. Various MACS IO plug-in boards
provide different combinations of inputs, outputs and relays. Each supported board is
presented in more detail on the following pages.

7.6.7.1 PCI-DIO8 Board Configuration

The PCI-DIO8 board consists of 8 digital inputs and 8 relays. When you select a PCI-
DIO8 slot in the Slot Configuration dialog box and click on the Configure Points push
button, the 8 Point Slot Configuration dialog box will pop up on the screen. This dialog
box has the following layout:
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At the top of the dialog box you will see the slot name and number, shown as read-
only boxes. To change the slot name or number, use the Configure Slot command.
The rest of the 8 Point Slot Configuration dialog box is divided into two groups. The
left hand group, designated as Inputs, allows you to add or to modify the input points
configuration. The right hand group, marked Outputs, allows you to configure output
relays.

To add an input or output point, or to modify an existing point configuration, click on
the push button associated with the point. Dialog boxes used to configure points are
described later in this document.

Name read-only box contains the slot name.

Address read-only box contains the slot number.

Inputs group of controls shows 8 digital inputs. Input points that are
actually used are indicated by their respective names. To add a
new input point, select an unused point and click on the adjacent
push button. To modify an existing point configuration, click on
the push button next to the point name.

Outputs group of controls shows 8 relays. Relays that are actually used
are indicated by their respective names. To add a new relay,
select an unused output point and click on the adjacent push but-
ton. To modify an existing output point configuration, click on the
push button next to the point name.

Exit push button closes the 8 Point Slot Configuration dialog box.
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7.6.7.2 PCI-DIO32-EM Board Configuration

The PCI-DIO32-EM board consists of 16 digital inputs and 16 relays. When you
select a PCI-DIO32-EM slot in the Slot Configuration dialog box and click on the
Configure Points push button, the 32 Output Point Slot Configuration dialog box will
pop up on the screen. This dialog box has the following layout:
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At the top of the dialog box you will see the slot name and number, shown as read-
only boxes. To change the slot name or address, use the Configure Slot command.
The rest of the 32 Output Point Slot Configuration dialog box contains a list of output
relays, that allows you to add or to modify the output points configuration.

To add an output point, or to modify an existing point configuration, click on the push
button associated with the point. Dialog boxes used to configure points are described
later in this document.

The dialog box consists of the following elements:

Name read-only box contains the slot name.

Address read-only box contains the slot number.

Outputs group of controls shows 32 relays. Relays that are actually used
are indicated by their respective names. To add a new relay,
select an unused output point and click on the adjacent push but-
ton. To modify an existing output point configuration, click on the
push button next to the point name.

Exit push button closes the 32 Output Point Slot Configuration dialog
box.
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7.6.7.3 PCI-32REL Board Configuration

The PCI-32REL board consists of 32 relays. When you select a PCI-32REL slot in the
Slot Configuration dialog box and click on the Configure Points push button, the 8
Point Slot Configuration dialog box will pop up on the screen. This dialog box has the
following layout:
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At the top of the dialog box you will see the slot name and number, shown as read-
only boxes. To change the slot name or address, use the Configure Slot command.
The rest of the 16 Point Slot Configuration dialog box is divided into two groups. The
left hand group, designated as Inputs, allows you to add or to modify the input points
configuration. The right hand group, marked Outputs, allows you to configure output
relays.

To add an input or output point, or to modify an existing point configuration, click on
the push button associated with the point. Dialog boxes used to configure points are
described later in this document.

The dialog box consists of the following elements:

Name read-only box contains the slot name.

Address read-only box contains the slot number.

Inputs group of controls shows 16 digital inputs. Input points that are
actually used are indicated by their respective names. To add a
new input point, select an unused point and click on the adjacent
push button. To modify an existing point configuration, click on
the push button next to the point name.

Outputs group of controls shows 16 relays. Relays that are actually used
are indicated by their respective names. To add a new relay,
select an unused output point and click on the adjacent push but-
ton. To modify an existing output point configuration, click on the
push button next to the point name.

Exit push button closes the 16 Point Slot Configuration dialog box.
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7.6.8 Status and Control Points Definition

As you add your MACS IO module to the MACS server configuration, you will install
and configure plug-in boards to one or more slots in the MACS server chassis. The
plug-in boards provide several combinations of digital input and output points.

Although similar, definitions for the digital input points and digital output points differ
slightly. Dialog boxes used to configure each of these categories are presented on the
following pages.

7.6.8.1 Digital Input Point Definition

Digital input points are typically used to monitor contact closures on the equipment or
external sensors attached to the MACS server. These points have two states, active
and inactive. Each time MACS IO module detects an input point state transition, it
reports it to the MACS server. To present point state transition to the operators, MACS
displays a text message in all active GUIs, and updates all active windows that contain
that point.

MACS IO Digital Input Point Definition dialog box has the following layout:
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This dialog box allows you to define the event report text, color combination and
severity to use when reporting that the point has changed its state. You can also
define whether to send a pager message when a state transition is detected.

The dialog box consists of the following elements:

Name contains the input point name. You can use up to 15 character
long names, which can include spaces.

Active group of controls allows you to define the text, color combination,
severity and paging to use when the point becomes active.

Active Text edit box allows you to enter the text to include in the event report
issued when the point becomes active. If you leave this field
blank, no event report will be displayed in the MACS user inter-
face, but the system will still update all graphical status and con-
trol windows.

Active Color pull-down list allows you to select the foreground and background
color combination to use in the event report issued when the
point becomes active.

Active Severity pull-down list allows you to select the severity level to use in the
event report issued when the point becomes active.

Page checkbox allows you to specify whether to send a pager mes-
sage when the point becomes active.

Inactive group of controls allows you to define the text, color combination,
severity and paging to use when the point becomes inactive.

Inactive Text edit box allows you to enter the text to include in the event report
issued when the point becomes inactive. If you leave this field
blank, no event report will be displayed in the MACS user inter-
face, but the system will still update all graphical status and con-
trol windows.

Inactive Color pull-down list allows you to select the foreground and background
color combination to use in the event report issued when the
point becomes inactive.

Inactive Severity pull-down list allows you to select the severity level to use in the
event report issued when the point becomes inactive.

Page checkbox allows you to specify whether to send a pager mes-
sage when the point becomes inactive.

OK push button makes the changes in the point configuration and
closes the dialog box.
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Delete push button is used to delete point configuration from the data-
base.

Quit push button closes the dialog box without making any changes in
the point configuration.

7.6.8.2 Digital Output Point Definition

Digital output points are used to control the equipment or external relays attached to
the MACS server. These points have two states, active and inactive. In addition,
output points can be pulsed. Each time it detects an output point state transition, the
MACS IO module reports it to the MACS server. To present point state transition to the
operators, MACS displays a text message in all active GUIs and updates all active
windows that contain that point. In addition, MACS will display a text message each
time an output relay is pulsed.

The MACS IO Digital Output Point Definition dialog box has the following layout:
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This dialog box allows you to define the event report text, color combination and
severity to use when reporting that the point has changed its state or that the point
was pulsed. You can also define whether to send a pager message when a state
transition or pulse is detected.

The dialog box consists of the following elements:

Name field contains the output point name. You can use up to 15 char-
acter long names, which can include spaces.

Active group of controls allows you to define the text, color combination,
severity and paging to use when the point becomes active.

Active Text edit box allows you to enter the text to include in the event report
issued when the point becomes active. If you leave this field
blank, no event report will be displayed in the MACS user inter-
face, but the system will still update all graphical status and con-
trol windows.

Active Color pull-down list allows you to select the foreground and background
color combination to use in the event report issued when the
point becomes active.

Active Severity pull-down list allows you to select the severity level to use in the
event report issued when the point becomes active.

Page checkbox allows you to specify whether to send a pager mes-
sage when the point becomes active.

Inactive group of controls allows you to define the text, color combination,
severity and paging to use when the point becomes inactive.

Inactive Text edit box allows you to enter the text to include in the event report
issued when the point becomes inactive. If you leave this field
blank, no event report will be displayed in the MACS user inter-
face, but the system will still update all graphical status and con-
trol windows.

Inactive Color pull-down list allows you to select the foreground and background
color combination to use in the event report issued when the
point becomes inactive.

Inactive Severity pull-down list allows you to select the severity level to use in the
event report issued when the point becomes inactive.

Page checkbox allows you to specify whether to send a pager mes-
sage when the point becomes inactive.

Pulsed group of controls allows you to define the text, color combination,
severity and paging to use when the point is pulsed.
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Pulsed Text edit box allows you to enter the text to include in the event report
issued when the point is pulsed. If you leave this field blank, no
event report will be displayed in the MACS user interface, but the
system will still update all graphical status and control windows.

Pulsed Color pull-down list allows you to select the foreground and background
color combination to use in the event report issued when the point
is pulsed.

Pulsed Severity pull-down list allows you to select the severity level to use in the
event report issued when the point is pulsed.

Page checkbox allows you to specify whether to send a pager message
when the point is pulsed.

OK push button makes the specified changes in the point configura-
tion and closes the dialog box.

Delete push button is used to delete the point configuration from the
database.

Quit push button closes the dialog box without making any changes in
the point configuration.
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7.7 Access To Configuration Utilities

As mentioned earlier in this document, you can customize access to MACS configu-
ration utilities based on the way you want to manage your system configuration. Some
MACS users allow full access to all MACS programs from all workstations on their
network. Others restrict access to the configuration utilities only to those workstations
used by system administrators.

Your first option is to install MACS configuration utilities only on a single system
administrator’s workstation. This prevents other MACS users from making arbitrary
and incoherent changes in the MACS configuration.

Your second option is to install configuration utilities on more than one workstation,
but not to provide access to these utilities directly from the MACS GUI. This approach
will give a group of authorized individuals access to MACS, while preventing casual
MACS users from making configuration changes.

You could also allow all MACS users access to some utilities, such as the Display
Editor, while restricting access to the utilities used to define alarm, status and control
points.

Finally, you could allow full access to all MACS configuration utilities by providing
access to configuration programs through the MACS main GUI. The following pages
illustrate how to do this option.

As shown throughout this manual, there are two methods to start MACS configuration
utilities:

• From the Windows Start menu, by clicking on Start -> Programs -> MACS ->...

• From the MACS main GUI, by clicking on the configuration icon or by selecting
configuration from the menu bar.

7.7.1 Adding Configuration Utilities to Windows Start Menu

The setup programs used to install MACS configuration utilities automatically create a
MACS program group and add it to the Windows Start menu. Therefore, if you install
configuration utilities on your local workstation, they will automatically show up in your
Start menu.
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If you install MACS configuration utilities on a server, and you want to include them
into the Start menu on other workstations, you will have to manually create a MACS
program group on each workstation.

For details on creating Windows Start menu program groups, please refer to the
Windows documentation.

7.7.2 Adding Configuration Utilities to MACS GUI

When you add a MACS configuration utility to the MACS main GUI, the utility will
appear in the Configuration Utilities dialog box, depicted in the following picture. To run
the utility highlight its name on the list and click on the Open push button, or simply
double click on the utility name.

To add MACS configuration utilities to the list of utilities accessible through the Config-
uration Utilities dialog box, use the MACS Configuration Utilities program MacsUtl.
Start MacsUtl program by clicking on Start -> All Programs -> MACS -> MacsUtl.
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The main Configuration Utilities dialog box will pop up on the screen. The dialog box
has the layout depicted in the following picture.
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The list box contains the names of the utilities presently accessible from the MACS
GUI. When you run this program for the first time, this list will be empty. The push
buttons in the dialog box are used as follows:

Add allows you to add a new configuration utility to the list.

Modify allows you to modify an existing configuration utility program path.

Delete allows you to remove an already configured utility from the list.

Open allows you to run the selected configuration utility, by highlighting
the utility name and then clicking on the Open push button.

View allows you to create a report that contains a list of all configuration
utility names and paths.

Exit exits the MacsUtl program.
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7.7.3 Add Configuration Utility

To add a new configuration utility to the list, click on the Add push button. The Add
Utility dialog box will pop up on the screen. The dialog box has the following layout:

Utility Name edit box allows you to specify the utility name that will appear in
the Configuration Utilities dialog box in the MACS main GUI.

Program Path edit box allows you to specify a fully qualified path to the program
to execute. The format you enter will depend on whether you
want to allow access from the local workstation only, or across
the network. An example for the local path is

C:\MACS\Programs\MacsUtl.exe

To allow access across the network, use a path of the following
form:

\\ICIUS\MACS\Programs\MacsUtl.exe

where ICIUS represents your server name, and MACS must be a
shared disk or folder.

To add a new utility program to the list of configuration utilities, click on the Add push
button. To exit without adding a new utility, click on the Cancel push button.
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7.7.4 Modify Utility Configuration

The Modify Utility dialog box allows you to change the path to the program to run when
you select the utility in the Configuration Utilities list in the MACS main GUI.

To modify an already configured utility setup, select the name of the utility and click on
the Modify push button. The dialog box has the same layout as the Add Utility dialog
box:

This dialog box will allow you only to modify the path to the utility program. To modify
the path, click on the Modify push button. To exit without modifying the path, click on
the Cancel push button.

7.7.5 Delete Configuration Utility

To delete a configuration utility from the Configuration Utilities list in the MACS main
GUI, highlight the name of the utility and click on the Delete push button. The following
message box will pop up:

To delete the utility from the list, click on the Yes push button. To exit without deleting
the utility, click on the No push button.
217Micus Alarm and Control System



Configuration
7.7.6 View Configuration Utilities

To create a report that contains a list of all MACS configuration utility names and
program paths, click on the View push button. The system will create a report and
present it on the screen using the WordPad text editor. From within the editor, you can
save the report into a text file, print it, search for keywords, cut and paste, and perform
other functions typical of WordPad. A typical report layout is depicted in the following
figure.
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7.8 Local User Interface Options

There are some configuration options that you can select locally to set up the MACS
user interface on your own workstation. These options include:

• Access to the on-line copy of the MACS User’s Manual, which is this book

• Selecting sounds to play when alarm messages are received.

Unlike other configuration parameters, which are stored in the system configuration
database, these options are saved in the client workstation Registry. Therefore,
operators can safely change them at any time, without altering the contents of the
system database. Changing the local user interface settings will not affect the
operation of the GUI on other workstations.

Local GUI settings are accessible directly from the MACS main GUI. They do not
require access to MACS configuration utilities. To set up the options, select Configu-
ration -> Options from the main menu:

The User Interface Options dialog box will pop up:
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This dialog box consists of the following:

Critical alarm sound edit box allows you to enter a fully qualified path to the wave file
that you want to play when a critical alarm is reported to your
GUI.

Major alarm sound edit box allows you to enter a fully qualified path to the wave file
that you want to play when a major alarm is reported to your GUI.

Minor alarm sound edit box allows you to enter a fully qualified path to the wave file
that you want to play when a minor alarm is reported to your GUI.

Warning sound edit box allows you to enter a fully qualified path to the wave file
that you want to play when a warning is reported to your GUI.

On-line User’s Manual

edit box allows you to enter a command line to execute to open
the on-line user’s manual. Usually, this is done using the Adobe
Acrobat Reader. Note that the file names that include spaces
must be enclosed in double quotes, as shown in the figure above.

OK push button saves your options settings into the machine Regis-
try and closes the dialog box.

Cancel push button closes the dialog box without saving the options set-
tings.

Note that you do not have to specify sounds for all severity levels. For example, if you
leave the warning sound field blank, no sound will be played when your GUI receives
warning messages.
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8 Creating Custom Screens

This section describes how to create MACS custom screens using the Display Editor.
The Display Editor is an optional MACS component, used by the system integrators
and end users to add application-specific screens to the MACS configuration.

MACS detects status changes and alarm conditions in two ways: by passively monitor-
ing the equipment, or by actively polling the equipment status. Unsolicited messages
from the equipment or responses to the polls are then translated into the user-defined
status and alarm messages. In addition to the text messages displayed in the scrolla-
ble window, changes in the equipment status and alarms are also shown in graphical
monitor and control windows. Each time a given point changes its status, the point rep-
resentation in a graphical window can change its color, orientation on the screen, size
or displayed numerical value.

To monitor and control the equipment, you can create any number of monitor and con-
trol windows. Typically, these windows contain geographical maps, building layouts,
equipment racks, equipment diagrams, equipment front panels and electrical schemat-
ics. A single window may combine points from various pieces of equipment. While the
status and alarm points only reflect equipment status, the control points have push but-
tons that allow you to set, reset, toggle or pulse the point. The points can be displayed
on the screen using variety of styles, such as LEDs, switches, lines, gauges, histo-
grams and rectangles.

The monitor and control windows are non-modal. This means that you can display
more than one window on the workstation screen, and freely switch from one window
to another. As the system detects status changes, all windows on the screen are
updated accordingly.

The system allows you to nest any number of windows you create into a logical chain.
For example, the top-level window may contain a geographical map with the regional
centers. By clicking on the regional center, you open the next window with the regional
map, which contains sites. Clicking on a given site opens a building layout window with
the equipment racks, secured doors, environment and power alarms. Finally, by click-
ing on a particular rack, you display the equipment block diagram or a front panel.
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8.1 Custom Screen Components

Each monitor and control window consists of two components:

• A background graphical image

• A list of status and control points

A background image can be created using any graphic editor, such as MS Windows
Paint or CorelDraw. When displaying the window, the system determines the size of
the image and adjusts the window size accordingly.

The list of points to display in the window is kept in the system configuration database.
To superimpose your status and control points on the background image, you will use
the MACS Display Editor.

8.2 Elements Of A Custom Screen

The layout of a custom screen created using the Display Editor depends on the
contents of the window. In general, your custom screen will fall into one of the
following categories:

• Summary screens

• Status screens

• Control screens

8.2.1 Summary Screens

Summary Screens are custom screens that contain only the summary points.
Summary screens are typically used to display regional maps or building layouts. In
these screens, summary points indicate any alarm condition existing within a given
site, or in a given piece of equipment.

Typically, summary points have push buttons. Each push button is linked to the next
screen. Clicking on a summary point push button displays the next screen, which
usually presents the site or the equipment in more detail.

When a summary screen is displayed, its summary points are initialized to the last
status known to the system. After that, the presentation of the summary points on the
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screen will change as the changes in status are detected in the associated site or
equipment.

Refreshing the equipment status can be a very time consuming process, especially
when monitoring remote sites over dial-up lines. For example, if your custom screen
contains a map with one hundred remote sites, it will take one hundred telephone calls
to refresh the entire status. This is why the summary screens initially use only the
status already known to the system, and do not provide any means for a dynamic
refresh.

A typical summary screen is depicted in the following picture.
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8.2.2 Status Screens

Status Screens are custom screens that may contain one or more summary points,
but must contain at least one input point or read-only output point. Status screens are
typically used to display the status of the selected equipment, without providing any
means to operate the equipment. In these screens, summary points can be used to
open the next screen, while the input points and read-only output points are used to
present the equipment status.

You can use a summary point to show the overall equipment status. You can also
display a summary point with a push button and link that button to the next screen. In
such a case, clicking on a summary point push button displays the next screen, which
usually presents the equipment in more detail.

In a single custom screen, you can include input points and read-only output points
from any piece of equipment attached to the MACS. In other words, you are not
restricted to one equipment unit per screen. You can combine several pieces of
equipment into a logical chain, and show them all within a single screen.

When a status screen is displayed, the points are initialized to the last status known to
the system. After that, the presentation of the points on the screen will change as the
changes in status are detected in the associated equipment.

When monitoring a remote site over a dial-up line, refreshing the equipment status
can be a time consuming process. For this reason, the status screens initially use only
the status already known to the system.

Unlike summary screens, the status screens do provide means for a dynamic refresh.
When the system determines that a given screen contains at least one input point or
read-only output point, it automatically displays at the bottom of the screen a toolbar
that contains a Refresh push button.

Some typical status screens are depicted in the following picture.
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8.2.3 Control Screens

Control Screens are custom screens that may contain one or more summary points
and input points, but must contain at least one output point. Control screens are
typically used to display the status of the selected equipment and to provide a means
to operate the equipment. In these screens, summary and input points are used to
present the equipment status, while output points are used to control the equipment.

You can use a summary point to show the overall equipment status. You can also
display a summary point with a push button and link that button to the next screen. In
such a case, clicking on a summary point push button displays the next screen, which
usually presents the equipment in more detail.

In a single custom screen, you can include input and output points from any piece of
equipment attached to the MACS. In other words, you are not restricted to one
equipment unit per screen. You can combine several pieces of equipment into a
logical chain, and show them all within a single screen.

When a control screen is displayed, the points are initialized to the last status known
to the system. After that, points presentation on the screen will change as the
changes in status are detected in the associated equipment.

When monitoring a remote site over a dial-up line, refreshing the equipment status
can be a time consuming process. For this reason the control screens initially use only
the status already known to the system.

The control screens provide means for a dynamic refresh and means to operate
output points. When the system determines that a given screen contains at least one
output point, it automatically displays at the bottom of the screen a toolbar that
contains Set, Reset, Pulse, Toggle and Refresh push buttons.

A typical control screen is depicted in the following picture.
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8.3 Steps To Create A Custom Screen

To create your own custom screen and add it to the MACS configuration, you need to
do the following:

• Create your graphical image background, using a graphic editor of your choice.
The simplest way to create a background image is to use Microsoft Paint, which
comes with the operating system at no cost. You could also use other graphic
editors, such as CorelDraw or Adobe PhotoShop. You can invoke your graphic
editor from within the Display Editor, which gives you a fully integrated design
environment.

• Using the Display Editor, add a custom screen, link it with the graphical image
background, and assign a name to your screen.

• Using the Display Editor, add status and control points to your screen and select
the style, color and position to use when displaying each point.
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8.4 Selecting Graphic Editor

To invoke your graphic editor from the MACS Display Editor toolbar, you need to con-
figure your graphic editor as one of the MACS configuration utilities. Specifically, you
have to name this utility Graphic Editor. This can be done using the Configuration Util-
ities program MacsUtl, which is described earlier in this manual in Access To Configu-
ration Utilities.

For example, to select Microsoft Paint as your default graphic editor and make it
accessible from the Display Editor toolbar, you will have to configure the Graphic Edi-
tor utility as follows:

Note that from some other graphic editors, such as Adobe PhotoShop, you may be
required to specify a fully qualified path to the program. A fully qualified path for the
local access on your workstation will be similar to the following example:

C:\Program Files\Adobe\PhotoShop 5.0 LE\photosle.exe

8.5 Starting Display Editor

You can invoke your Display Editor either from the Windows Start menu or, if so
configured, from the MACS main GUI. To start it from the Windows Start menu, click
on Start -> All Programs -> MACS -> MacsEditor, as depicted in the following picture.
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If your system is configured to provide access to the configuration utilities from the
MACS main GUI,1 you can also start the Display Editor by selecting configuration
utilities from the Configuration -> Select Utility pull-down menu or by clicking the
Configuration button on the toolbar.

1. How to add configuration utilities to the MACS main GUI is explained earlier in this document.
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The Configuration Utilities dialog box will pop up, and present you with a list of all
configuration utilities accessible from your GUI.

Select Display Editor and click on the Open push button, or simply double click on the
Display Editor name. The main Display Editor dialog box will pop up on the screen.
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The Display Editor main dialog box has the following layout:

Menu bar provides access to the editing commands from the pull-down
menus containing editing commands.

Toolbar provides access to the frequently used editing commands by
clicking on the toolbar push buttons.

Point selection group of four combo boxes allows you to select the server, unit,
slot and point ID for the point that you want to add to your custom
screen.

Colors group box contains a group of four combo boxes that allow you to
select the color to use when displaying point status. In addition, it
also allows you to select which point state to display while design-
ing your screen.

Display styles group box shows all display styles that can be used when drawing
the currently selected point in your custom screen. As you change
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your point selection from digital inputs to digital outputs or analog
inputs, the contents of this box will change to present styles appli-
cable to the selected point type.

Point attributes group box allows you to specify or manually adjust point coordi-
nates and size, orientation on screen, thickness of lines, action to
take when point is clicked, and other attributes. The exact func-
tions of the fields in this group will change depending on the
selected point type and display style.

Add push button allows you to add a new point to your custom screen.

Delete push button allows you to delete an existing point from your cus-
tom screen.

Modify push button allows you to modify the attributes of a point already
included in your custom screen.

Save push button allows you to save your custom screen configuration
into the database.

8.6 Creating Custom Screen

To create a new screen, you have to:

• Create a background image

• Add your screen to the list of custom screens

Once these initial steps are completed, you can proceed by adding points to your
screen. After you create your screen, you can always open it to modify the screen
contents and layout.

8.6.1 New Background Image

You can create your background image directly from your graphic editor before
invoking the Display Editor, or you can run your graphic editor within the Display
Editor and then create your background image. By convention, background images
are stored in the MACS Config folder, but you can keep your background images in
any other folder on your network, as long as MACS programs have proper access to
the bitmap files.

To run your graphic editor from the Display Editor, select File -> New from the main
menu, or click on the Graphic Editor toolbar icon:
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The program will open your graphic editor. Create and save your background image
file. Note that this file must be saved as a bitmap file.

While editing the points in your custom screen, you can invoke your graphic editor at
any time to make changes in your background image. To load or to reload your
background image, click on the Load Background toolbar icon:

8.6.2 Managing Custom Screens

To add a custom screen to the list of your custom monitor and control windows, you
have to specify your screen name and link it with the background image. To do so, you
will use the Monitor Configuration dialog box. You will use the same dialog box to open
existing custom screens for editing, or to delete screens you no longer need. You can
open this dialog box from the File pull-down menu, as shown in the picture below:

You can also open the Monitor Configuration dialog box by clicking on the Open
toolbar icon:
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In either case, the Monitor Configuration dialog box will pop up on the screen. The
dialog box has the following layout:

Monitor list contains a list of all presently configured custom monitor and con-
trol screens. Custom screens are presented using their names
and fully qualified paths to their respective background image bit-
map files.

Open push button allows you to open the selected custom screen for
editing. To open an existing custom screen, highlight it in the list
and click on the Open push button, or simply double click on the
custom screen name.

Delete push button allows you to delete the selected custom screen from
the database. This operation does not delete your background
image file.

Add push button allows you to add a new custom screen to your data-
base.

Modify push button allows you to modify an existing custom screen
name or path to the associated bitmap file.

View push button allows you to create a report that contains a list of all
of your custom monitor and control screens.

Exit push button closes the dialog box.
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8.6.2.1 Add Custom Screen

To add a new custom screen to the list of your monitor and control windows, click on
the Add push button. The Add Custom Screen dialog box will pop up on the screen.
This dialog box has the following layout:

Screen name edit box allows you to enter your custom screen name. This name
will appear in the list of custom status and control windows in the
MACS main GUI.

Database ID read-only box shows the database ID associated with the screen.

Bitmap file edit box allows you to specify the path to the bitmap file associ-
ated with the custom screen.

Save push button adds the custom screen to the database.

Cancel push button closes the dialog box without adding the custom
screen to the database.

8.6.2.2 Modify Custom Screen

To modify the data of an existing custom screen, highlight it in the list and click on the
Modify push button. The Modify Custom Screen dialog box will pop up on the screen.
This dialog box has the same layout and as the Add Custom Screen, described above.

8.6.2.3 Delete Custom Screen

To delete an existing custom screen, highlight its name in the Monitor Configuration
dialog box list and click on the Delete push button.

The following dialog box will pop up:
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To delete the selected custom screen, click on the Yes push button. To exit the dialog
box without deleting the screen, click on the No push button.

8.6.3 View Custom Screens

To create a report that contains a list of all of your custom monitor and control
screens, click on the View push button. The system will create a text file that contains
a list of all your custom screens, and present it using the WordPad text editor. From
within the editor, you can save the report into a file, print it, search for the specific
names, cut and paste, and perform other functions typical of WordPad.

The following picture illustrates a typical report layout:
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8.7 Adding Status and Control Points

After you add your custom screen name and background bitmap file to the configu-
ration database, you are ready to add status and control points. To open your screen
for editing, select it in the Monitor Configuration dialog box list and click on the Open
push button. The Display Editor will load your background image into its working area.

Your next step is to add status and control points to your custom screen.

To superimpose a point against your background image you have to:

• Select the point you want to add

• Select the style to use when drawing the point

• Specify point coordinates

• Select point orientation
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• If applicable, specify point size

• If applicable, select other point attributes, such as line thickness or action to take
when a point is clicked on.

8.7.1 Selecting Points

As explained earlier in this document, MACS identifies all status and control points by
their server, unit, slot and point IDs. Each server, unit, slot and point also has a name,
and the Display Editor uses these names to allow you to select points to display.

In addition to the individual status and control points, the Display Editor also allows
you to use summary points. Summary points are containers that change status if any
individual point within that container changes its status. For example, the unit
summary point will change status if any individual point within that unit changes
status. The server summary point will change status if any unit within that server
changes status.

Finally, the Display Editor also allows you to use static points, as a convenient way to
display location names, equipment names and similar items. Such items do not
change status but differ from one site to the other. For example, this feature will allow
you to use the same block diagram as a background image for several different sites,
while using static points to display site and equipment names.

The section of the Display Editor window that allows you to select points is depicted in
the following picture:

Source pull-down list allows you to select what kind of point you want to
include in your screen:

IO POINTS are most commonly used. This selection allows you
to select individual equipment status and control points and add
them to your screen.

UNIT POINTS allow you to select status and control points which
apply to the entire unit. Typical examples are the communication
alarm, which is triggered when communication with the entire unit
is lost, or the unit summary point, which indicates any change in
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the unit status.

SERVER POINTS allow you to select status and control points
which apply to the entire server. A typical example is the server
summary point, which indicates any change in the server status.

STATIC POINTS selection allows you to define any static points
you wish to use within your custom screen.

Server pull down list contains the names of all MACS equipment modules
found in your configuration database. The associated read-only
field shows the selected service database ID.

Unit pull down list contains the names of all equipment units that are
monitored and controlled by the selected equipment module. The
associated read-only field shows the selected unit database ID.

Point pull down list contains the names of all points within the selected
unit. The associated read-only field shows the selected point
database ID.

Type read-only field shows you the type of point you selected. For
example, the selected point could be a digital input, digital output,
or analog input.

8.7.2 Selecting Colors

Upon selecting the point you want to display, you need to select which colors to use
for each point state. Note that this color selection is independent from the colors you
specify for your event reports, shown in the MACS main GUI in text format. Using the
MACS ColorCfg configuration utility, you can define as many colors as you want for
your graphical images. Once the colors are defined in the database, you can pick the
colors you want to use for the selected point from the pull down lists depicted in the
following picture:

Active/Above pull-down list allows you to select the color to use when displaying
the digital inputs or outputs in the active state, or when displaying
the analog points with the their value above the upper threshold.
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Inactive/Within pull-down list allows you to select the color to use when display-
ing the digital inputs or outputs in inactive state, or when display-
ing the analog points with their value within limits.

Pulsed/Below pull-down list allows you to select the color to use when display-
ing the pulsed digital outputs, or when displaying the analog
points with their value below the lower threshold.

Show State pull-down list allows you to select which state to display for the
points shown in the working area of the Display Editor window.
By changing the current state, you can check the appearance of
the displayed points.

For the digital points, you can select the ACTIVE or INACTIVE

state2. For the analog points, you can select the ABOVE, WITHIN
or BELOW state.

When you change the state selection, all points included in your
custom screen will change state accordingly.

8.7.3 Selecting Display Styles

When you select a point to include in your custom screen, the Display Editor will
present you with the display styles applicable to the type of the selected point. To
select a style, you click on the drawing that you want to use. A red triangle will show
up, pointing to the currently selected display style.

In addition to selecting drawing styles, you can also make your output points read
only, by clicking on the Read Only checkbox. This is used when you want to present
the status of an output point on your screen, but you want to prevent operators from
operating that point.

For the analog points, you can select whether to display analog values as decimal
numbers, or using the scientific, or ‘E’ notation.

2. The pulsed state for the digital outputs is a transient state. Therefore it is not included as one of the possible per-
manent states for the digital outputs.
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The following table briefly introduces various display styles you can use to draw your
points. The list of styles available for the digital inputs, digital outputs and analog
inputs is given on the following pages.
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LED style point is displayed as a small circle or square
that changes color as the associated point changes its
state. The point name is not displayed. This style is typi-
cally used to draw the equipment front panels.

Points can be displayed using either full width, half width
or proportional width rectangles. A rectangle contains
the point name and changes its color as the point
changes status. Full and half size rectangles are used to
align points displayed in the window. Proportional width
rectangles are used to make their size proportional to the
point name length.

Points can be displayed using either solid or transparent
rectangles. Solid rectangles change both foreground and
background color when the associated point changes
state. Transparent rectangles change only the outline
and the text color, while the background remains visible
through the rectangle.

Output points can be displayed with the push button,
used to select and operate the point. Output points can
be also displayed as read-only points, in which case they
can be monitored but not operated from a given window.

Points can be displayed as animated switches. The
same point can be mapped onto more than one switch.
Switches can be drawn using any size and orientation,
and can be displayed in different colors in active and
inactive states.
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Points can be mapped onto one or more lines, which
change color depending on the point state. This style is
typically used to depict communication links or electrical
circuits.

Points can be presented as open or closed doors in an
architectural drawing, depicting a building layout. This
style is typically used for the security applications.

Point states can be presented using two bitmap draw-
ings, one for each state. In this example the active point
state is mapped into a drawing of an open fridge, while
the inactive point state is mapped into a drawing of a
closed fridge.

Analog points can also be displayed as gauges, with the
handle optionally changing color when exceeding the
upper or lower threshold.
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Analog points can be displayed as vertical or horizontal
histograms that optionally change color when their
respective analog values exceed the upper or lower
threshold.

The numerical reading from analog points can be dis-
played using an integer, decimal or scientific notation.

The numerical values for the output points can be set
from an edit box.

Some analog points can have a fixed set of values that
can be mapped into a list of names. For example, TV
channel numbers can be mapped into the corresponding
TV channel names. In such a case, instead of displaying
numerical values, the screens will contain the associated
names. Each name can be displayed in a different color.

Some analog output points can be set to a fixed set of
values. These values can be mapped into a list of
names. For example, TV channel numbers can be
mapped into the corresponding TV channel names. In
such a case, instead of entering numbers, the values
can be selected from a drop-down list of the associated
names.
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To monitor analog values over time, points may be pre-
sented using scrolling graphs. Each time a new analog
value is sampled, it gets added to the right end of the
graph. Once the end of the working rectangle is reached,
the graph starts scrolling to the left.

Analog values below lower threshold, within limits and
above upper threshold may be represented using differ-
ent colors.

Two scrolling graph styles are available: a transparent
graph style and a solid graph style.

You can define the length and width of the graph in pix-
els. One vertical line is added to the graph each time a
new value is received. Thus, the scrolling speed of the
graph depends on its width in pixels, and the polling
interval used to sample the value.
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8.7.4 Analog Input Point Styles

When you select an analog point, the Display Editor will present a choice of display
styles depicted in the following picture.

Styles available to draw analog inputs are:

• Solid rectangle proportional to the point name length

• Transparent rectangle proportional to the point name length

• Solid custom size rectangle

• Transparent custom size rectangle

• Solid half-width rectangle

• Transparent half-width rectangle

• Solid full-width rectangle

• Transparent full-width rectangle

• Right justified integer value
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• Left justified integer value

• Right justified decimal value

• Left justified decimal value

• Right justified ‘E’ notation value

• Left justified ‘E’ notation value

• Round LED

• Square LED

• Horizontal histogram

• Vertical histogram

• Gauge

• Bitmap

• Solid scrolling graph

• Transparent scrolling graph

• Enumerated integer value
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8.7.5 Digital Input Display Styles

When you select a digital input point, the Display Editor will present a choice of
display styles depicted in the following picture.

Styles available to draw digital inputs are:

• Solid rectangle proportional to the point name length

• Transparent rectangle proportional to the point name length

• Solid custom size rectangle

• Transparent custom size rectangle

• Solid half-width rectangle

• Transparent half-width rectangle

• Solid full-width rectangle

• Transparent full-width rectangle

• Line
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• Round LED

• Square LED

• Switch

• Baseball switch

• Door

• Bitmap

8.7.6 Digital Output Display Styles

When you select a digital output point, the Display Editor will present a choice of
display styles depicted in the following picture.

Styles available to draw digital outputs are:

• Solid rectangle proportional to the point name length

• Transparent rectangle proportional to the point name length

• Solid custom size rectangle

• Transparent custom size rectangle
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• Solid half-width rectangle

• Transparent half-width rectangle

• Solid full-width rectangle

• Transparent full-width rectangle

• Line

• Round LED

• Square LED

• Push button

• Switch

• Baseball switch

• Door

• Read only points

• Bitmap

8.7.7 Summary Display Styles

When you select a summary point, the Display Editor will present a choice of display
styles depicted in the following picture.
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Styles available to draw summary points are:

• Solid rectangle proportional to the point name length

• Transparent rectangle proportional to the point name length

• Solid custom size rectangle

• Transparent custom size rectangle

• Solid half-width rectangle

• Transparent half-width rectangle

• Solid full-width rectangle

• Transparent full-width rectangle

• Round LED

• Square LED

• Push button

8.7.8 Specifying Point Attributes

Depending on the type of the point being displayed, there are a number of attributes
that you can adjust, specify or select. Point attributes are set using the fields depicted
in the following picture.

X, Y Coordinates edit boxes X and Y are used to specify the point position within
the window. Coordinates are calculated in pixels, relative to the
top left corner of the custom screen window.

When adding your point, you can enter the coordinates manually
into the X and Y fields. You can also position the mouse on the
screen where you want to add your point and click the right
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mouse button. The editor will read the screen coordinates and fill
the X and Y fields automatically.

Height edit box allows you to specify the height of the point, if applicable
for the selected style. Instead of entering the height manually,
you can also hold down the right mouse button and drag the
mouse. The editor will draw a rectangle on the screen and fill in
the coordinates, height and width field automatically.

Width edit box allows you to specify the width of the point, if applicable
for the selected style. Instead of entering the width manually, you
can also press the right mouse button and drag the mouse. The
editor will draw a rectangle on the screen and fill in the coordi-
nates, height and width field automatically.

Options Some display styles offer you a list of options to select from.

For the Line display style, you can select the thickness of the pen
used to draw the line. The options are: THIN LINE, MEDIUM
LINE and THICK LINE.

For the Switch style, you can select the orientation of the switch.
These options specify the moving end of the switch orientation
and active position of the switch. Available options are: BOTTOM
ACTIVE LEFT, BOTTOM ACTIVE RIGHT, LEFT ACTIVE BOT-
TOM, LEFT ACTIVE TOP, RIGHT ACTIVE BOTTOM, RIGHT
ACTIVE TOP, TOP ACTIVE LEFT, and TOP ACTIVE RIGHT.

For the Baseball Switch, you can select the active orientation of
the baseball switch, between TOP ACTIVE RIGHT and TOP
ACTIVE LEFT.

For the Door style, you can select the door position and orienta-
tion of the open door. The available options are: DOWN OPEN
LEFT, DOWN OPEN RIGHT, LEFT OPEN DOWN, LEFT OPEN
UP, RIGHT OPEN DOWN, RIGHT OPEN UP, UP OPEN LEFT
and UP OPEN RIGHT.

When you select a summary point, the Options list allows you to
select the action to take when the summary point becomes
active. The action is usually to display the next screen, which
shows in more details the individual points included in the sum-
mary point. The next screen is either DEFAULT MONITOR, or
NEXT MONITOR. The DEFAULT MONITOR displays the stan-
dard equipment-specific screen for the selected equipment. The
NEXT MONITOR invokes the next custom screen that you design
yourself. To specify which custom screen to display, use the
Monitor field.
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Max edit box allows you to specify the maximum analog value for the
analog points. This field is ignored when digital input or output is
selected.

Min edit box allows you to specify the minimum analog value for the
analog points. This field is ignored when digital input or output is
selected.

Name pull down list allows you to link your current custom screen with
the next custom screen. When you create a summary point, you
can draw it using a display style with a push button. Then, you can
configure that push button to open the next custom screen.

When you configure your summary point, use the Options field to
select the NEXT MONITOR option. Then, use the Name field to
select the next screen to open. Custom screens are selected by
name.

Add push button allows you to add a new point to your current custom
screen, displayed in the Display Editor working area.

To permanently add a point to your database, you must click on
the Save push button.

Delete push button allows you to delete the selected point from your cur-
rent custom screen. To select a point, just click the left mouse but-
ton on the drawing in the Display Editor working area.

To permanently delete a point from your database, you must click
on the Save push button.

Modify push button allows you to modify the selected point display style,
coordinates, size and colors. To select a point, just click the left
mouse button on the drawing in the Display Editor working area.
After you change the selected point appearance and attributes,
click on the Modify push button.

To permanently modify the selected point attributes in the data-
base, you must click on the Save push button.

Save push button saves your current custom screen in the database.
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8.8 Using Bitmaps

The Display Editor allows you to redraw the entire section of the screen based on the
current state of any given point. Point states can be presented using two or three
bitmap drawings, one for each state. When the point changes its state, the specified
section of the screen is redrawn using the bitmap that is associated with the new point
state.

In the following example, the below limit, within limits and above limit states of an
analog point are mapped into the images of a street lights shown below:

The bitmaps you design may be of arbitrary size and complexity. However, the
bitmaps that you assign to the same point will overlap each other within the same
area on the screen. Thus, the bitmaps assigned to the same point must be of equal
size.

To add bitmaps to your custom screens, you have to:

• Create your bitmaps using your favorite graphic editor.

• Add the bitmaps to the list of bitmaps used by the system.

• Link the bitmaps with a status or a control point.

• Position the bitmaps in your custom screen.

8.8.1 Creating Bitmaps

Graphical images that you use for your custom screens can be created using any
graphical tools. The only limitation is that they must be saved as bitmap files (.bmp)
which is the format used internally by Windows. The simplest way to create bitmaps is
to use Microsoft Paint, which comes with the Windows operating system. You can
also use digital scanners or cameras, and variety of software packages to create or
modify your images.
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We suggest that you keep all of your graphical images in a dedicated folder. By
convention, MACS database and bitmap files are kept in the MACS\Config folder.

8.8.2 Managing Bitmaps

Once you create bitmap files, you need to add them to the list of files known to the
system. You can always add files, modify their names and locations, and delete them
from the list.

You will manage bitmap files from the Display Editor, using the Manage Bitmaps
dialog box. To open it, click on the Bitmaps -> Manage Bitmaps in the editor main
menu:

The Manage Bitmaps dialog box will pop up on the screen. The dialog box has the
following layout:
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On the left hand side, the dialog box shows a scrollable list of all presently configured
bitmap images. Note that the list contains symbolic names assigned to your images,
rather than the exact file names. You will associate image names with the file names
through the configuration process. The rest of the dialog box consists of the following
push buttons:

Configure Bitmap push button allows you to modify an existing image name and file
location.

Add Bitmap allows you to add a new bitmap image to your system configura-
tion.

Delete Bitmap allows you to delete an existing bitmap image from your system
configuration.

View Bitmaps allows you to create and view a text report that contains a list of
all configured bitmap images.

Exit closes the Manage Bitmaps dialog box.

8.8.2.1 Add Bitmap

To add a new bitmap image to your system configuration, open the Manage Bitmaps
dialog box and click on the Add Bitmap push button. The Edit Bitmap dialog box will
pop up on the screen:

The Edit Bitmap dialog box consists of the following:

ID read-only field contains the bitmap image database identifier.

Name edit box allows you to specify the name for the image. The name
can be up to 15 characters long, and does not have to be the
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same as the file name. Typically, you will use a descriptive name
that indicates the condition the image illustrates (e.g. Hydro Fail-
ure).

File edit box allows you to enter a fully qualified path of the file that
contains the image. You have to specify drive letter and folder
names (e.g. C:\MACS\Config\HydroActive.bmp) or fully qualified
network path, if the file resides on another computer (e.g. \\TOR-
ONTO\MACS\Config\HydroActive.bmp).

Save push button saves the bitmap image configuration and closes the
dialog box.

Cancel push button closes the dialog box without saving the bitmap
image configuration.

8.8.2.2 Configure Bitmap

Once you add a bitmap image to your system configuration, you can rename it, or you
can change the file name and location using the Configure Bitmap command. To
modify an existing image configuration, open the Manage Bitmaps dialog box and click
on the Configure Bitmap push button. The Edit Bitmap dialog box will pop up on the
screen. The layout and operation of this dialog box is the same as described in the
Add Bitmap section.

8.8.2.3 Delete Bitmap

To delete an existing bitmap image from your system configuration, open the Manage
Bitmaps dialog box, highlight the name of the bitmap that you want to delete, and click
on the Delete Bitmap push button. The following message box will pop up on the
screen:

To delete the selected bitmap click on the Yes push button. To close the message box
without deleting the bitmap click on the No push button.
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8.8.2.4 View Bitmaps

To create a report that contains a list of all configured bitmap image names and file
paths, open the Manage Bitmaps dialog box and click on the View Bitmaps push
button. The system will create a report and present it on the screen using the
WordPad text editor. From within the editor, you can save the report into a text file,
print it, search for keywords, cut and paste, and perform other functions typical of the
WordPad. A typical report layout is depicted in the following figure.
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8.8.3 Selecting Bitmaps

To present a digital input or digital output point using bitmap images, you have to
select which bitmap to use for the active point state and which one to use for the
inactive point state. Similarly, for an analog input or output, you have to select which
bitmap to use for the analog value within limits, which one to use for the value above
the upper threshold, and which one to use for the value below the lower threshold. To
make your selection, you will use the Select Bitmaps command.

Adding bitmap images to your custom screen is a two step process. First, you select
the current bitmaps. For digital points you select the current active state bitmap, and
the current inactive state bitmap. For the analog points you select the current bitmaps
for the values within limits, below lower threshold and above upper threshold. Next,
you add a point to your custom screen and select the bitmap display style. The editor
will use the selected bitmaps to draw the point.

To select current bitmaps, click on the Bitmaps -> Select Bitmaps in the main menu, or
on the Bitmaps icon:

or

The Select Current Bitmaps dialog box will pop up on the screen:
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This dialog box allows you to select the current bitmaps for each point state. As you
select the bitmaps from the pull-down lists, you will see their previews in the adjacent
boxes, and the associated fully qualified file names in the read-only boxes below the
pull-down lists.

The Select Current Bitmaps dialog box has the following layout:

Active/Above Bitmap

pull-down list allows you to select a bitmap image to represent
the active state for a digital point, or a value above the upper
threshold for an analog point.

Inactive/Within Bitmap

pull-down list allows you to select a bitmap image to represent
the inactive state for a digital point, or a value within limits for an
analog point.
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Pulsed/Below Bitmap

pull-down list allows you to select a bitmap image to represent a
value below the lower threshold for an analog point. The digital
output pulsed state is a transient state and as such it is not shown
in the graphical screens. Selecting a bitmap for a pulsed state has
no effect on the custom screen display.

OK push button makes the selected bitmaps current, and closes the
dialog box.

Cancel push button closes the dialog box without selecting the bitmaps.

8.9 Using Enumerated Points

In many cases, analog input and output points values belong to a known set of
discrete values, and each value represent a distinct point state. For example, if a point
represents a TV channel, its value will be one of the channel numbers. If a point repre-
sents a serial port data rate, its value will be one of the valid data rates.

When a set of discrete analog values is known, it is sometime more convenient to use
description instead of numerical values. For example, the following list shows several
TV channels:

If you assign a description to each valid numerical value, the point values are
enumerated. If you use an enumerated point style in your custom screens, the system
will display descriptions rather than numbers. In the above example, it will display TV
channel names instead of numbers.

To add enumerated points to your custom screens, you have to:

• Create a set of enumerated values.

• Link the set with an analog point.

• Add the enumerated point to your custom screen.

3 Global

6 CBC

40 Bravo

50 Space
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8.9.1 Enumerated Sets

To use enumerated points in your custom screens, you have to link them with a set of
enumerated values. Note that the same enumerated set may apply to more than one
point, and more than one custom screen. For example, your TV channel listings may
apply to all receivers that you want to include in several of your custom screens. This
is why you define enumerated sets first, and then you use them when you draw
enumerated points in your custom screens.

To manage your enumerated sets, you will use the Create Set command. To open it,
click on the Enumerated Sets -> Create Set item in the main menu:

The Select Enumerated Set dialog box will pop up on the screen. For this dialog box
you can add, modify, delete and view currently defined enumerated sets. The Select
Enumerated Set dialog box has the following layout:
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The scrollable list on the left hand side of the dialog box contains a list of all presently
defined enumerated sets. Creating an enumerated set is a two step process. First, you
create the set itself, by assigning a name to it. Next, you add a set of value and
description pairs to the set.

The Select Enumerated Set dialog box consists of the following push buttons:

Configure Set allows you to rename an existing enumerated set.

Add Set allows you to create a new enumerated set and to name it.

Delete Set allows you to delete an existing enumerated set.

Define Values allows you to add enumerated values to the set, modify these val-
ues, delete them, and to view a list of values assigned to the
selected set.

View Sets allows you to create and view a text report that contains a list of all
configured enumerated sets.

Exit closes the Select Enumerated Set dialog box.

8.9.1.1 Add Enumerated Set

To add a new enumerated set to your system configuration, open the Select
Enumerated Set dialog box and click on the Add Set push button. The Add
Enumerated Set dialog box will pop up on the screen:

This dialog box consists of the following:

Set ID read-only field shows the enumerated set database identifier.

Name edit box allows you to enter the enumerated set name.
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OK push button creates a new enumerated set and closes the dialog
box.

Cancel push button closes the dialog box without creating a new enu-
merated set.

8.9.1.2 Configure Enumerated Set

To rename an existing enumerated set, open the Select Enumerated Set dialog box
and click on the Configure Set push button. The Configure Enumerated Set dialog box
will pop up on the screen. This dialog box layout and operation is the same as the Add
Enumerated Set dialog box, described above.

8.9.1.3 Delete Enumerated Set

To delete an existing enumerated set from your system configuration, open the Select
Enumerated Set dialog box, highlight the set that you want to delete and click on the
Delete Set push button. The following message box will pop up on the screen:

To delete the selected enumerated set, click on the Yes push button. To close the
message box without deleting the set, click on the No push button.

8.9.1.4 View Enumerated Sets

To create a report that contains a list of all enumerated sets, open the Select
Enumerated Sets dialog box and click on the View Sets push button. The system will
create a report and present it on the screen using the WordPad text editor. From
within the editor, you can save the report into a text file, print it, search for keywords,
cut and paste, and perform other functions typical of WordPad. A typical report layout
is depicted in the following figure.
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8.9.2 Enumerated Set Values

Once you create an enumerated set, you have to add enumerated values to it.
Enumerated values are pairs of numerical values and associated descriptions. To add
values to an enumerated set, open the Select Enumerated Set dialog box, highlight
the set you want to add values to, and click on the Define Values push button. The
Select Enumerated Value dialog box will pop up on the screen:

The scrollable list on the left hand side of the dialog box contains a list of all presently
defined enumerated values for the selected enumerated set. The rest of the dialog
box consists of the following push buttons:

Configure Value allows you to modify an existing enumerated value.

Add Value allows you to add a new enumerated value to the set.

Delete Value allows you to delete an existing enumerated value from the set.

View Values allows you to create and view a text report that contains a list of
all configured enumerated values for the selected enumerated
set.

Exit closes the Select Enumerated Value dialog box.
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8.9.2.1 Add Enumerated Value

To add a new enumerated value to the selected enumerated set, open the Select
Enumerated Value dialog box and click on the Add Value push button. The Add
Enumerated Value dialog box will pop up on the screen:

This dialog box consists of the following:

Value ID read-only field shows the enumerated value database identifier.

Set ID read-only field shows the parent enumerated set database identi-
fier.

Value edit box allows you to enter the associated integer value.

Color pull down list allows you to select a color combination to use when
displaying the enumerated value.

Short Description edit box allows you to enter the description used when displaying
the enumerated value. The short description is limited to 15 char-
acters.

Long Description edit box allows you to enter a more verbose description of the
enumerated value. This description is limited to 64 characters. If
supported by the associated MACS equipment module, this text is
included in an event report issued by the equipment module when
the point takes the associated numerical value.

OK push button adds a new enumerated value to the selected enu-
merated set and closes the dialog box.

Cancel push button closes the dialog box without adding a new enumer-
ated value.
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8.9.2.2 Configure Enumerated Value

To modify an existing enumerated value, open the Select Enumerated Value dialog
box, highlight the value you are interested in and click on the Configure Value push
button. The Configure Enumerated Value dialog box will pop up on the screen. This
dialog box layout and operation is the same as the Add Enumerated Value dialog box,
described in the last section.

8.9.2.3 Delete Enumerated Value

To delete an existing enumerated value from the selected enumerated set, open the
Select Enumerated Value dialog box, highlight the value that you want to delete and
click on the Delete Value push button. The following message box will pop up on the
screen:

To delete the selected enumerated value, click on the Yes push button. To close the
message box without deleting the value, click on the No push button.

8.9.2.4 View Enumerated Values

To create a report that contains a list of all enumerated values for a given set, open
the Select Enumerated Values dialog box and click on the View Values push button.
The system will create a report and present it on the screen using the WordPad text
editor. From within the editor, you can save the report into a text file, print it, search for
keywords, cut and paste, and perform other functions typical of WordPad. A typical
report layout is depicted in the following figure.
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8.9.3 Selecting Enumerated Sets

To present an analog input or analog output point using enumerated sets, you have to
select which enumerated set to use for the selected point.

When adding an analog input or output point to your custom screen, select one of the
enumerated point styles, shown in Selecting Display Styles, earlier in this manual.

In the example above, the red triangle shows the currently selected display style,
which is a box that displays enumerated point descriptions. When you click on that
display style, the Options field in the Point Attributes will show ENUMERATED SET.
Next, select the enumerated set you want to apply to the selected point and click on
the Add push button.
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8.10 Using Actions

The MACS GUI allows you to start other programs from your custom screens, by
clicking on the action push buttons. You can insert action push buttons into your
custom screens, and link them to third party programs, such as FTP or Telnet. You
can also run programs such as Acrobat Reader or Microsoft Word to view on-line
documentation. You can execute equipment-specific programs and tools supplied by
the hardware vendors.

To add action push buttons to your custom screens, you have to:

• Create a list of actions used by the system.

• Link the actions with the points.

• Position the actions in your custom screen.

8.10.1 Managing Actions

Adding actions in your custom screens is a two step process. First, you need to add
them to the list of actions known to the system. You can always add actions, modify
their names and associated commands, and delete them from the list. Next, you
include them into your custom screens.

You will manage actions from the Display Editor, using the Manage Actions dialog box.
To open it, click on the Bitmaps -> Manage Actions in the editor main menu:

The Manage Actions dialog box will pop up on the screen. The dialog box has the
following layout:
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On the left hand side, the dialog box shows a scrollable list of all presently configured
actions. Note that the list contains symbolic names assigned to your actions, rather
than the exact commands. You will associate action names with the commands
through the configuration process. The rest of the dialog box consists of: the following
push buttons

Configure Action allows you to modify an existing action name and the associated
command.

Add Action allows you to add a new action to your system configuration.

Delete Action allows you to delete an existing action from your system configu-
ration.

View Actions allows you to create and view a text report that contains a list of
all configured actions.

Exit closes the Manage Actions dialog box.
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8.10.1.1 Add Action

To add a new action to your system configuration, open the Manage Actions dialog
box and click on the Add Action push button. The Edit Action dialog box will pop up on
the screen:

The Edit Action dialog box consists of the following:

ID read-only field contains the action database identifier.

Name edit box allows you to specify the name for the action. The name
can be up to 15 characters long, and does not have to be the
same as the command name. Typically, you will use a descriptive
name that indicates the target of an action, rather than the tools
used to accomplish it (e.g. User’s Manual rather than Acrobat
Reader).

Command edit box allows you to enter the complete command to execute.
You may need to include drive letter and folder names or fully
qualified network path for the programs that you want to invoke,
and fully qualified paths for the files included in the command
argument list. If file names include spaces, enclose the entire file
name in double quotes. We suggest that you try your commands
from the Windows Command Prompt first, and then use the same
command line for your action.

Save push button saves the action into the database and closes the
dialog box.

Cancel push button closes the dialog box without saving the action.
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8.10.1.2 Configure Action

Once you add an action to your system configuration, you can rename it, or you can
change the command line using the Configure Action command. To modify the
existing action configuration, open the Manage Actions dialog box and click on
Configure Action push button. The Edit Action dialog box will pop up on the screen.
The layout and operation of this dialog box is the same as for the Add Action
command.

8.10.1.3 Delete Action

To delete an existing action from your system configuration, open the Manage Actions
dialog box, highlight the name of the action that you want to delete, and click on the
Delete Action push button. The following message box will pop up on the screen:

To delete the selected action click on the Yes push button. To close the message box
without deleting the action click on the No push button.

8.10.1.4 View Actions

To create a report that contains a list of all configured action names and command
lines, open the Manage Actions dialog box and click on the View Actions push button.
The system will create a report and present it on the screen using the WordPad text
editor. From within the editor, you can save the report into a text file, print it, search for
keywords, cut and paste, and perform other functions typical of WordPad. A typical
report layout is depicted in the following figure.
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8.10.2 Selecting Actions

To include an action push button into your custom screen, select ACTION POINTS in
the Source field

Next, specify the name for the point:

From the Display Styles pane select the style for the action point:
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In the Options field in the Point Attributes, select EXECUTE PROGRAM:

Finally, from the Name field in the Point Attributes, select the action itself from the
pull-down list:

The action point is now ready to be included into your custom screen. To include it
specify the size and the position of the point and click on the Add push button.
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8.11 Using Display Styles

The following pages illustrate how to use the display styles, and how to include various
status and control points into your custom screens. Note that these examples do no
include all point styles and associated options. They are selected as typical tasks
required to create a custom screen.

8.11.1 Digital Input

To add a digital input point to your custom screen, do the following:

• From the Source pull-down list, select IO POINTS.

• From the Server pull-down list, select the equipment module that contains the point
you are interested in.

• From the Unit pull-down list, select the unit that contains the point you are inter-
ested in.

• From the Point pull-down list, select the point you are interested in. In this example,
make sure to select a digital input.

At this point, the editor will indicate in the read-only field Type whether you selected a
digital input, digital output, analog input or analog output point. At the same time, it will
present the display styles applicable to the selected point type.

First, select the colors that you want to use for the active and for the inactive point
state. Note that the pulsed point state is ignored:
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Next, select the point style. In this example, you will select a variable size rectangle
with the solid background:

Next, you need to add your point to your custom screen. Place the mouse pointer to
the location in the custom screen where you want to position the top left corner of your
point. Press the right button and drag the mouse to create a rectangle which repre-
sents your point location and size. As you drag the mouse, the coordinates and size of
your point rectangle will show up in the Point Attributes:
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You can adjust the rectangle size and location by manually changing the X and Y
coordinates and point width W and height H. To add your point, click on the Add push
button. To save your point in the database, click on the Save push button.

Your newly added point will look somewhat like this:

8.11.2 Digital Output

To add a digital output point to you custom screen, do the following:

• From the Source pull-down list, select IO POINTS.

• From the Server pull-down list, select the equipment module that contains the point
you are interested in.

• From the Unit pull-down list, select the unit that contains the point you are inter-
ested in.

• From the Point pull-down list, select the point you are interested in. In this example,
make sure to select a digital output.

At this point, the editor will indicate in the read-only field Type whether you selected a
digital input, digital output, analog input or analog output point. At the same time, it will
present the display styles applicable to the selected point type.

First, select the colors that you want to use for the active and for the inactive point
state. Note that the pulsed point state is ignored:
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Next, select the point style. In this example, you will select a half-size rectangle with
the solid background:

Next, you need to add your point to your custom screen. Place the mouse pointer to
the location in the custom screen where you want to position the top left corner of your
point. Press the right button and drag the mouse to create a rectangle which repre-
sents your point location. As you drag the mouse, the coordinates and size of your
point rectangle will show up in the Point Attributes. In this case, the rectangle size is
predetermined by the selected display style, and the system will accept only the X and
Y coordinates, while the width and length will be ignored:
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You can adjust the location by manually changing the X and Y coordinates. To add
your point, click on the Add push button. To save your point in the database, click on
the Save push button.

Your newly added point will look somewhat like this:

8.11.3 Baseball Switch

In this example you will map a digital output to a baseball switch, which is a graphical
symbol frequently used in satellite communications.

To add a digital output point to you custom screen, do the following:

• From the Source pull-down list, select IO POINTS.

• From the Server pull-down list, select the equipment module that contains the point
you are interested in.

• From the Unit pull-down list, select the unit that contains the point you are inter-
ested in.

• From the Point pull-down list, select the point you are interested in. In this example,
make sure to select a digital output.
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At this point, the editor will indicate in the read-only field Type whether you selected a
digital input, digital output, analog input or analog output point. At the same time, it will
present the display styles applicable to the selected point type.

First, select the colors that you want to use for the active and for the inactive point
state. Note that the pulsed point state is ignored. In this example, you will select the
same color for all point states:

Next, select the point style. In this example, you will select the baseball switch:

Next, you need to add your point to your custom screen. Place the mouse pointer to
the location in the custom screen where you want to position the top left corner of your
point. Press the right button and drag the mouse to create a square which represents
your point location. As you drag the mouse, the coordinates and size of your point
rectangle will show up in the Point Attributes. In the case of a baseball switch display
style, the width and the height must be the same. Typically, you will draw an approx-
imate square on the screen, and then manually adjust its coordinates and size:
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Next, you need to define the active and inactive position and rotation of your baseball
switch. To do so, click on the Options pull-down list and select the appropriate option:

To add your baseball switch to your custom screen, click on the Add push button. To
save it in the database, click on the Save push button.

Assume that the background of your custom screen contained a schematic like this:

With the careful positioning on the screen, your newly added baseball switch will look
somewhat like this:
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8.11.4 Analog Point Vertical Histogram

In this example, you will present an analog point value using a vertical histogram.

To add an analog input point to you custom screen, do the following:

• From the Source pull-down list, select IO POINTS.

• From the Server pull-down list, select the equipment module that contains the
point you are interested in.

• From the Unit pull-down list, select the unit that contains the point you are inter-
ested in.

• From the Point pull-down list, select the point you are interested in. In this
example, make sure to select an analog input.

At this point, the editor will indicate in the read-only field Type whether you selected a
digital input, digital output, analog input or analog output point. At the same time, it will
present the display styles applicable to the selected point type.

First, select the colors that you want to use for the value within limits, above the upper
threshold and below the lower threshold. As always, you can select different colors, or
you can select the same colors for all three values:

Next, select the point style. In this example, you will select the vertical histogram bar:
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Next, you need to add your point to your custom screen. Place the mouse pointer to
the location in the custom screen where you want to position the top left corner of your
point. Press the right button and drag the mouse to create a rectangle which repre-
sents your point location. As you drag the mouse, the coordinates and size of your
point rectangle will show up in the Point Attributes. Typically, you will draw an approx-
imate square on the screen, and then manually adjust its coordinates and size:

Next, you need to define the maximum and minimum values for the histogram. To do
so, use the Max and Min edit boxes. Note that the values that you enter will depend on
the nature of the point being monitored.

To add your baseball switch to your custom screen, click on the Add push button. To
save it in the database, click on the Save push button.

You can add ticks and numbers to you background image to enhance the appearance
and readability of the histogram. Assume that the background of your custom screen
contained a drawing like this:
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With the careful positioning on the screen, your newly added histogram will look
somewhat like this:

8.11.5 Modifying Points

You can modify any point in your custom screen at any time. First, select it in your
custom screen by clicking anywhere on the point rectangle. Make changes by
selecting another display style, or modifying coordinates and size, and then click on
the Modify push button. To save your changes in the database, click on the Save
push button.

8.11.6 Deleting Points

You can always delete a point from your custom screen. First select it by clicking
anywhere on the point rectangle and then click on the Delete push button.
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8.11.7 Nested Custom Screens

In this example, you will link two custom screens together, and use a summary in the
top level screen to open the lower level nested screen. You will use a regional map to
display a summary alarm point that opens a site diagram.

Let us assume that your regional map looks somewhat like this:

Let us further assume that you have a piece of equipment that monitors your Toronto
site. If any alarm is received from the Toronto site, you want the summary alarm on
your map to become active. When you click on it, you want to open the Toronto site
block diagram.

First, you need to add a summary point for the Toronto site to your regional map. To
do so, select the summary point:

• From the Source pull-down list, select UNIT POINTS.

• From the Server pull-down list, select the equipment module, such as SENTRY.

• From the Unit pull-down list, select the name of the unit responsible for monitoring
alarms at the Toronto location, such as TORONTO SS2 in this example.
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• From the Points pull-down list, select the Summary status point.

Once you select the point, you can rename it. In this case, you will change the name
of the point from Summary to Toronto:

Next, select the colors that you want to use for the point active and inactive state:

Next, select the display style to use for the summary point. In this example you will
use a see through rectangle, with the width proportional to the point name:
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Next, you need to add your point to your custom screen. Place the mouse pointer to
the location in the custom screen where you want to position the top left corner of your
point. Press the right button and drag the mouse to create a rectangle which repre-
sents your point location. As you drag the mouse, the coordinates and size of your
point rectangle will show up in the Point Attributes. In this case, the rectangle size is
predetermined by the selected display style, and the system will accept only the X and
Y coordinates, while the width and length will be ignored:

Note that the Point Attributes box initially shows the DEFAULT SCREEN in the
Options field. The DEFAULT SCREEN option links the summary point with the screen
that depicts the selected equipment itself. This, for example, may be the equipment
front panel or an equipment-specific block diagram. In this example, you will select the
NEXT SCREEN option from the pull-down list:
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Next, pull down the list of names with the NEXT SCREEN option selected. You will
get the list of all presently defined custom screens:

If you select the custom screen called Building Layout, when you click on the
summary point in your regional map, the system will open Building Layout as the
nested screen. Note that there is no limitation in the number of nested screens. You
can cascade as many of them as you want.

The following example shows your regional map as the main screen, and the building
layout opened by clicking on the Toronto summary point:
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8.12 Invoking Custom Screens

Once you save your custom screen configuration in the database. you can invoke that
screen from the MACS main GUI. You can invoke your custom screen from the
Monitor pull-down menu, as show in the picture below:

You can also open your custom screen by clicking on the Monitor toolbar icon:
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In either case, the Monitors dialog box will pop up on the screen. The dialog box has
the following layout:

To open your custom screen, highlight its name and click on the Open push button, or
simply double click on the screen name.

8.12.1 Dynamic Testing

Once you save your custom screen into the database, the screen becomes immedi-
ately available to the GUI. As soon as you click on the Save button in the Display
Editor, you can open the Monitors dialog box in the MACS main GUI, select the
screen you are working on, and open it. All points on the screen are immediately
operational. This means that you can keep both the Display Editor and the MACS GUI
running together on your workstation, and immediately test additions and changes in
your custom screens.
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First, you make an addition or modification using the Display Editor. Then you save the
screen by clicking on the Save push button. After that, you open the screen from the
Monitors dialog box in the MACS GUI, to test it in live action.

Subsequent changes in your custom screen will take effect in the MACS GUI the next
time you open the screen from the Monitors dialog box. Therefore, to test your subse-
quent changes, you have to close your screen in the MACS GUI and reopen it from
the Monitors dialog box.
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